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Prologue

Welcome

Welcome to Geing Started with Ubuntu, an introductory guide wrien to
help new users get started with Ubuntu.

Our goal is to cover the basics of Ubuntu (su as installation and working
with the desktop) as well as guide you through some of the most popular
applications. We designed this guide to be simple to follow, with step-by-step
instructions and plenty of screenshots, allowing you to discover the potential
of your new Ubuntu system even if you are a novice computer user or are
migrating from another operating system for the first time.

Please bear in mind that this guide is still very mu a work in progress
and always will be. It is wrien specifically for Ubuntu . , and al-
though we have aimed to not limit our instructions to this version, it is un-
avoidable that some things will ange over the life of Ubuntu. Whenever a
new version of Ubuntu is released, we will incorporate any anges into our
guide, and make a new version available at http://www.ubuntu-manual.org.

Geing Started with Ubuntu . is not intended to be a comprehensive
Ubuntu instruction manual. It is more like a qui-start guide that will get
you doing the things you need to do with your computer quily and easily,
without geing bogged down with tenical details.

If you are aer more detail, there are excellent resources available at http://
help.ubuntu.com. Ubuntu’s built-in system documentation is also very useful
for accessing help on specific topics, and can be found by cliing System ‣
Help and Support in Ubuntu. If something isn’t covered here, ances are More information about Ubuntu’s online

and system documentation can be found in
Chapter : Learning more.

you will find the information you are looking for in one of those locations.
We will try our best to include links to more detailed help wherever we can.

Ubuntu philosophy

e term “Ubuntu” is a traditional African concept that originated from the
Bantu languages of southern Africa. It can be described as a way of connect-
ing with others—living in a global community where your actions affect all of
humanity. Ubuntu is more than just an operating system: it is a community
of people that come together voluntarily to collaborate on an international
soware project that aims to deliver the best possible user experience.

The Ubuntu promise

‣ Ubuntu will always be free of arge, along with its regular enterprise
releases and security updates.

http://www.ubuntu-manual.org
http://help.ubuntu.com
http://help.ubuntu.com
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‣ Ubuntu comes with full commercial support from Canonical and hundreds
of companies from across the world.

‣ Ubuntu provides the best translations and accessibility features that the
free soware community has to offer.

‣ Ubuntu’s core applications are all free and open source. We want you to
use free and open source soware, improve it, and pass it on.

A brief history of Ubuntu

Ubuntu was conceived in  by Mark Shuleworth, a successful South
African entrepreneur, and his company Canonical. Shuleworth recognized Canonical is the company that provides

financial and technical support for Ubuntu.
It has employees based around the world
who work on developing and improving
the operating system, as well as reviewing
work submied by volunteer contributors.
To learn more about Canonical, go to
http://www.canonical.com.

the power of Linux and open source, but was also aware of weaknesses that
prevented mainstream use.

Shuleworth set out with clear intentions to address these weaknesses
and create a system that was easy to use, completely free (see Chapter :
Learning more for the complete definition of “free”), and could compete with
other mainstream operating systems. With the Debian system as a base,
Shuleworth began to build Ubuntu. Using his own funds at first, installation
s were pressed and shipped worldwide at no cost to the end user. Ubuntu
spread quily, the size of the community rapidly increased, and it soon
became the most popular Linux distribution available.

With more people working on the project than ever before, Ubuntu con-
tinues to see improvement to its core features and hardware support, and has
gained the aention of large organizations worldwide. For example, in ,
Dell began a collaboration with Canonical to sell computers with Ubuntu
preinstalled. Additionally, in , the Fren Police began to transition their
entire computer infrastructure to a variant of Ubuntu—a process whi has
reportedly saved them “millions of euros” in licensing fees for Microso
Windows. By the year , the Fren Police anticipates that all of their com-
puters will be running Ubuntu. Canonical profits from this arrangement by
providing tenical support and custom-built soware.

While large organizations oen find it useful to pay for support services, For information on Ubuntu Server Edition,
and how you can use it in your company,
visit http://www.ubuntu.com/server/
features.

Shuleworth has promised that the Ubuntu desktop system will always be
free. As of , Ubuntu is installed on nearly % of the world’s computers.
is equates to millions of users worldwide, and is growing ea year.

What is Linux?

Ubuntu is built on the foundation of Linux, whi is a member of the Unix
family. Unix is one of the oldest types of operating systems and has provided
reliability and security in professional applications for almost half a century.
Many servers around the world that store data for popular websites (su as
YouTube and Google) run some variant of a Unix system. e Linux kernel is
best described as the core, or almost the brain, of the operating system.

http://www.canonical.com
http://www.ubuntu.com/server/features
http://www.ubuntu.com/server/features


 

e Linux kernel is the shi manager of the operating system; it is respon-
sible for allocating memory and processor time. It can also be thought of as
the program whi mangages any and all programs on the computer itself.

Linux was designed from the ground up with security and hardware com- While modern graphical desktop envi-
ronments have generally replaced early
command-line interfaces, the command
line can still be a quick and efficient way
of performing many tasks. See Chapter :
The Command Line for more information,
and Chapter : The Ubuntu Desktop to
learn more about  and other desktop
environments.

patibility in mind, and is currently one of the most popular -based operat-
ing systems. One of the benefits of Linux is that it is incredibly flexible and
can be configured to run on almost any device—from the smallest micro-
computers and cellphones to larger super-computers. Unix was entirely com-
mand line–based until graphical user interfaces (s) began to emerge in the
early s.

ese early s were difficult to configure and clunky at best, and gen- A desktop environment is a sophisticated
and integrated user interface that provides
the basis for humans to interact with a
computer using a monitor, keyboard and a
mouse.

erally only used by seasoned computer programmers. In the past decade,
however, graphical user interfaces have come a long way in terms of usability,
reliability, and appearance. Ubuntu is just one of many different Linux dis-
tributions, and uses one of the more popular graphical desktop environments To learn more about Linux distributions, see

Chapter : Learning more.called .

Is Ubuntu right for you?

New users to Ubuntu may find that it takes some time to feel comfortable
when trying a new operating system. You will no doubt notice many similar-
ities to both Microso Windows and Mac  , as well as some differences.
Users coming from Mac   are more likely to notice similarities due to the
fact that both Mac   and Ubuntu originated from Unix.

Before you decide whether or not Ubuntu is right for you, we suggest A popular forum for Ubuntu discussion
and support is the Ubuntu Forums, http://
ubuntuforums.org.

giving yourself some time to grow accustomed to the way things are done in
Ubuntu. You should expect to find that some things are different from what
you are used to. We also suggest taking the following into account:

‣ Ubuntu is community based. at is, Ubuntu is made, developed, and
maintained by the community. Because of this, support is probably not
available at your local computer store. Fortunately, the Ubuntu community
is here to help. ere are many articles, guides, and manuals available,
as well as users on various Internet forums and Internet Relay Chat ()
rooms that are willing to help out beginners. Additionally, near the end of
this guide, we include a troubleshooting apter: Chapter : Troubleshoot-
ing.

‣ Many applications designed for Microso Windows or Mac   will
not run on Ubuntu. For the vast majority of everyday computing tasks,
there are suitable alternative applications available in Ubuntu. However,
many professional applications (su as the Adobe Creative Suite) are not
developed to work with Ubuntu. If you rely on commercial soware that is To learn more about dual-booting (running

Ubuntu side-by-side with another operating
system), see Chapter : Installation. For
more information on Wine, go to http://
www.winehq.org/.

not compatible with Ubuntu, yet still want to give Ubuntu a try, you may
want to consider dual-booting. Alternatively, some applications developed
for Windows will work in Ubuntu with a program called Wine.

http://ubuntuforums.org
http://ubuntuforums.org
http://www.winehq.org/
http://www.winehq.org/
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‣ Many commercial games will not run on Ubuntu. If you are a heavy
gamer, then Ubuntu may not be for you. Game developers usually design
games for the largest market, whi leads to larger profits. Since Ubuntu’s
market share is not as substantial as Microso’s Windows or Apple’s Mac
 , most game developers will not allocate resources towards making
their games compatible with Ubuntu. If you just like to play a game every
now and then, there is active game development within the community,
and many high quality games can be easily installed through Ubuntu
Soware Center. Additionally, some games developed for Windows will See Chapter : Soware Management to

learn more about Ubuntu Soware Center.also work in Ubuntu with Wine.

Contact details

Many people have contributed their time to this project. If you notice any
errors or think we have le something out, feel free to contact us. We do
everything we can to make sure that this manual is up to date, informative,
and professional. Our contact details are as follows:

e Ubuntu Manual Team

Website: http://www.ubuntu-manual.org/

Email: ubuntu-manual@lists.launchpad.net

: #ubuntu-manual on irc.freenode.net

Bug Reports: http://bugs.ubuntu-manual.org

Conventions used in this book

e following typographic conventions are used in this book:

‣ Buon names, menu items, and other  elements are set in boldfaced
type.

‣ Menu sequences are sometimes typeset as System ‣ Preferences ‣Appearance,
whi means, “Choose the System menu, then oose the Preferences sub-
menu, and then select the Appearance menu item.”

‣ Monospaced type is used for text that you type into the computer, text that
the computer outputs (as in a terminal), and keyboard shortcuts.

http://www.ubuntu-manual.org/
ubuntu-manual@lists.launchpad.net
irc.freenode.net
http://bugs.ubuntu-manual.org


 Installation

Geing Ubuntu

Before you can get started with Ubuntu, you will need to obtain a copy of the Many companies (such as Dell and Sys-
tem) sell computers with Ubuntu prein-
stalled. If you already have Ubuntu installed
on your computer, feel free to skip to
Chapter : The Ubuntu Desktop.

Ubuntu installation . Some options for doing this are outlined below.

Downloading Ubuntu

e easiest and most common method for geing Ubuntu is to download the
Ubuntu  image directly from http://www.ubuntu.com. Head to the website
and cli the “Download Ubuntu” link at the top. Select the nearest download
location to you in the drop-down box (to ensure maximum download speed),
then cli “Begin Download.”

-bit vs -bit

You may notice the words “Ubuntu Desktop . (-bit)” underneath the -bit and -bit are types of processor
architectures. -bit is newer, and most
recent computers will come with a -bit
capable processor. See Chapter : Learning
more for more information.

default download buon on the website. If you are unsure what -bit means,
don’t worry. -bit will work on most computers, so if in doubt, simply pro-
ceed with the download. However, if you know that your computer is capable
of using -bit soware, you may wish to try the -bit version instead. To do
this, cli on “Alternative download options” and make your selection.

Downloading Ubuntu as a torrent

When a new version of Ubuntu is released, sometimes the servers can get
clogged up with large numbers of people downloading or upgrading at the
same time. If you are familiar with using torrents, you may wish to download
the torrent file by cliing “Alternative download options,” and obtain your
copy of the  image this way instead. You may see significant improvements
to your download speed, and will also be helping to spread Ubuntu to other
users worldwide. Again, if you are unsure how to use torrents, you can use
the default download options on the website. Torrents are a way of sharing files and

information around the Internet via peer-
to-peer file sharing. When a new version of
Ubuntu is released, the Ubuntu servers can
become very busy. If you know how to use
torrents, we recommend that you download
the  image this way to take the load off
the servers during periods of high demand.

Burning the  image

Once your download is complete, you will be le with a file called ubuntu-

While the -bit version of Ubuntu is
referred to as the “AMD” version, it will
work on Intel, AMD, and other compatible
-bit processors.

.-desktop-i.iso or similar (i here in the filename refers to the -bit
version. If you had downloaded the -bit version, the filename would contain
amd instead). is file is a  image—a bit like a snapshot of the contents
of a —whi you will need to burn to a . To find out how to burn a 
image on your computer, refer to your operating system’s or manufacturer’s

http://www.ubuntu.com
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support documentation. You can also find detailed instructions at https://help.
ubuntu.com/community/BurningIsoHowto.

Ordering a free 

Alternatively, a free  can be ordered from Canonical. is option may be You will be required to create a free online
account with Launchpad before you can
place your  order. Once you have Ubuntu
installed and running, you will need this
account again for use with all Ubuntu
One services. See Chapter : Working with
Ubuntu for more information on Ubuntu
One.

preferred if you don’t have access to a  burner, have limited bandwidth,
or have a slow Internet connection. ere are no shipping costs or other
arges when you order an Ubuntu . Simply visit http://shipit.ubuntu.com
to request your free Ubuntu Desktop Edition .

e  usually takes two to six weeks to arrive, depending on your loca-
tion and the current demand. If you would rather start using Ubuntu sooner,
you may prefer to follow the instructions above for downloading the  im-
age, and then burn it to a disc instead.

It is possible to purchase Ubuntu on  from
some computer stores or online shops. Have
a look around your local area or on the
Internet to see if someone is selling it near
you. Even though Ubuntu is free soware,
it’s not illegal for people to sell it.

The Live 

e Ubuntu  functions not only as an installation  for puing Ubuntu
onto your computer, but also as a Live . A Live  allows you to test
Ubuntu without making any permanent anges to your computer by run-
ning the entire operating system straight from the .

Your computer reads information from a  at a mu slower speed than
it can read information off of a hard drive. Running Ubuntu from the Live
 also occupies a large portion of your computer’s memory, whi would
usually be available for programs to access when Ubuntu is running from
your hard drive. e Live  experience will therefore feel slightly slower
than it does when Ubuntu is actually installed on your computer. However,
running Ubuntu from the  is a great way to test things out and allows you
to try the default applications, browse the Internet, and get a general feel
for the operating system. It’s also useful for eing that your computer
hardware works properly in Ubuntu and that there are no major compatibility
issues.

To try out Ubuntu using the Live , insert the Ubuntu  into your  In some cases, your computer will not
recognize that the Ubuntu  is present
as it starts up, and will start your existing
operating system instead. Generally, it
means that the priority given to devices
when your computer is starting needs to
be changed. For example, your computer
might be set to look for information from
your hard drive first, and then to look for
information on a  second. In order to
run Ubuntu from the Live , we want
it to look for information from a  first.
Changing your boot priority is beyond the
scope of this guide. If you need assistance to
change the boot priority, see your computer
manufacturer’s documentation for more
information.

drive and restart your computer. Most computers are able to detect when a
bootable  is present in your drive at startup—that is, a  that will tem-
porarily take precedence over your usual operating system. As your computer
starts, it will run whatever information is stored on this bootable , rather
than the information stored on your hard drive whi your computer usually
looks for.

Once your computer finds the Live , and aer a qui loading screen,
you will be presented with the “Welcome” screen. Using your mouse, select
your language from the list on the le, then cli the buon labeled Try
Ubuntu .. Ubuntu will then start up, running straight from the Live .

Once Ubuntu is up and running, you will see the default desktop. We

https://help.ubuntu.com/community/BurningIsoHowto
https://help.ubuntu.com/community/BurningIsoHowto
http://shipit.ubuntu.com


 

Figure .: The “Welcome” screen allows
you to choose your language.

will talk more about how to actually use Ubuntu in Chapter : e Ubuntu
Desktop, but for now, feel free to test things out. Open some programs, ange
seings and generally explore—any anges you make will not be saved once
you exit, so you don’t need to worry about accidentally breaking anything.

When you are finished exploring, restart your computer by cliing the
“Power” buon in the top right corner of your screen (circle with a line
through the top) and then select Restart. Follow the prompts that appear on
screen, including removing the Live  and pressing Enter when instructed,
and then your computer will restart. As long as the Live  is no longer in the
drive, your computer will return to its original state as though nothing ever
happened!

Minimum system requirements

Ubuntu runs well on most computer systems. If you are unsure whether it The majority of computers in use today will
meet the requirements listed here; however,
refer to your computer’s documentation or
speak to the manufacturer if you would like
more information.

will work on your computer, the Live  is a great way to test things out first.
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For the more tenically minded, below is a list of hardware specifications
that your computer should meet as a minimum requirement.

‣  MHz x processor
‣   of system memory ()
‣   of disk space
‣ Graphics card capable of × resolution
‣ Sound card
‣ A network or Internet connection

Installing Ubuntu

e process of installing Ubuntu is designed to be qui and easy. However,
we do realize that some people may find the idea a lile daunting. To help
you get started, we have included step-by-step instructions below, along with
screenshots so you can see how things will look along the way.

If you have already tested out the Ubuntu Live , you should now be Alternatively, you can also use your mouse
to double-click the “Install Ubuntu .”
icon that is visible on the desktop when
using the Live . This will start the Ubuntu
installer.

familiar with the initial “Welcome” screen that appears (refer to e Live
 section above for more information). Again, select your language on the
le-hand side, then cli the buon labeled Install Ubuntu ..

At least   of free space on your hard drive is required in order to install
Ubuntu; however,   or more of free space is recommended. is will
ensure that you will have plenty of room to install extra programs later on, as
well as store your own documents, music, and photos. There are two other options presented on

the “Welcome” screen: release notes and
update this installer. Clicking on the blue
underlined release notes will open a web
page containing any important information
regarding the current version of Ubuntu.
Clicking update this installer will search
the Internet for any updates to the Ubuntu
Live  that may have been released since
your  was created.

Geing started

To get started, place the Ubuntu  in your  drive and restart your com-
puter booting into Ubuntu. When the welcome screen is displayed select your
language and cli the Install Ubuntu ..

e next screen will display a world map. Using your mouse, cli your
location on the map to tell Ubuntu where you are. Alternatively, you can use
the drop-down lists underneath. is allows Ubuntu to set up your system
clo and other location-based features. Cli Forward when you are ready to
move on.

Next, you need to tell Ubuntu what keyboard you are using. Usually, you
will find the suggested option is satisfactory. If you are unsure, you can cli
the Guess buon to have Ubuntu work out the correct oice by asking you
to press a series of keys. You can also oose your own keyboard layout from
the list. If you like, type something into the box at the boom to make sure
you are happy with your selection, then cli Forward to continue.



 

Figure .: Tell Ubuntu your location.

Prepare disk space

is next step is oen referred to as partitioning. Partitioning is the process of
allocating portions of your hard drive for a specific purpose. When you create
a partition, you are essentially dividing up your hard drive into sections that
will be used for different types of information. Partitioning can sometimes
seem complex to a new user; however, it does not have to be. In fact, Ubuntu
provides you with some options that greatly simplify this process.

Erase and use the entire disk

Use this option if you want to erase your entire disk. is will delete any Many people installing Ubuntu for the first
time currently use another operating system
on their computer, such as Windows ,
Windows Vista, Windows , or Mac  .
Ubuntu provides you with the option of
either replacing your existing operating
system altogether, or installing Ubuntu
alongside your existing system. The laer is
called dual-booting. Whenever you turn on
or restart your computer, you will be given
the option to select which operating system
you want to use for that session.

existing operating systems that are installed on that disk, su as Windows ,
and install Ubuntu in its place. is option is also useful if you have an empty
hard drive, as Ubuntu will automatically create the necessary partitions for
you.
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Figure .: Check your keyboard layout is
correct.

Guided partitioning

If you already have another operating system installed on your hard drive,
and want to install Ubuntu alongside it, oose the Install them side by side,
oosing between them ea startup option.

Ubuntu will automatically detect the other operating system and install
Ubuntu alongside it. For more complicated dual-booting setups, you will need
to configure the partitions manually.

Specifying partitions manually

is option is for more advanced users and is used to create special partitions, Ubuntu installs a home folder where your
personal files and configuration data are
located by default. If you choose to have
your home folder on a separate partition,
then in the event that you decide to reinstall
Ubuntu or perform a fresh upgrade to
the latest release, your personal files and
configuration data won’t be lost.

or format the hard drive with a filesystem different to the default one. It can
also be used to create a separate /home partition. is can be very useful in
case you decide to reinstall Ubuntu, as it allows you to format and reinstall
the operating system, whilst keeping all your personal files and program
seings intact in a separate partition.

Because this is quite an advanced task, we have omied the details from



 

Figure .: Choose where you would like to
install Ubuntu.

this edition of Geing Started with Ubuntu. You can see more information
and detailed instructions on partitioning here: https://help.ubuntu.com/
community/HowtoPartition.

Once you are happy with the way the partitions are going to be set up,
cli the Forward buon at the boom to move on.

Enter your details

Ubuntu needs to know some information about you so it can set up the pri-
mary login account on your computer. Your name will appear on the login
screen as well as the MeMenu, whi will be discussed further in Chapter :
e Ubuntu Desktop.

On this screen you will need to tell Ubuntu:

‣ your real name,
‣ your desired username,
‣ your desired password,
‣ what you want to call your computer,

https://help.ubuntu.com/community/HowtoPartition
https://help.ubuntu.com/community/HowtoPartition
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‣ how you want Ubuntu to log you in.

Figure .: Setup your user account.

Type in your full name under “What is your name?”. e next text field
is where you select a username for yourself, and is the name that will be
displayed at the Ubuntu login screen when you turn on your computer. You
will see this is automatically filled in for you with your first name. Most
people find it easiest to sti with this. However, it can be anged if you
prefer.

Next, oose a password and enter it into the first password field on the Although you can choose your preferred
username and computer name, you are
required to stick with Latin leers, numbers,
hyphens, and dots. You will receive a
warning if non-acceptable symbols or other
characters are entered, and until this is
altered you will be unable to progress to the
next screen.

le, then type the same again into the right field to verify. When both pass-
words mat, a strength rating will appear on the right that will tell you
whether your password is “too short,” “weak,” “fair,” or “strong.” You will be
able to continue the installation process regardless of your password strength,
but for security reasons it is best to oose a strong one. is is best aieved
by having a password that is at least six aracters long, and is a mixture of
leers, numbers, symbols, and uppercase/lowercase. For extra security, avoid
obvious passwords like your birth date, spouse’s name, or the name of your
pet.



 

Now you need to decide on your computer’s name. Again, this will be
filled in for you automatically using the login name you entered above (it
will say something like “john-desktop” or “john-laptop.”). However, it can be
anged if you prefer. Your computer name will mainly be used for identi-
fying your computer if you are on a home or office network with multiple
computers. To learn more about seing up a network, refer to Chapter :
Working with Ubuntu.

Finally, at the boom of this screen you have three options to oose from
regarding how you want to log in to Ubuntu.

Log in automatically

Ubuntu will log in to your primary account automatically when you start up
the computer so you won’t have to enter your username and password. is
makes your login experience quier and more convenient, but if privacy or
security are important to you, this option is not recommended. Anyone who
can physically access your computer will be able to turn it on and also access
your files.

Require my password to login

is option is selected by default, as it will prevent unauthorized people from
accessing your computer without knowing the password you created earlier.
is is a good option for those who, for example, share their computer with
other family members. Once the installation process has been completed, an
additional login account can be created for ea family member. Ea person
will then have their own login name and password, account preferences,
Internet bookmarks, and personal storage space.

Require my password to login and decrypt my home folder

is option provides you with an extra layer of security. Your home folder
is where your personal files are stored. By selecting this option, Ubuntu will
automatically enable encryption on your home folder, meaning that files and
folders must be decrypted using your password before they can be accessed.
erefore if someone had physical access to your hard drive (for example, if
your computer was stolen and the hard drive removed), they would still not
be able to see your files without knowing your password.

If you oose this option, be careful not to enable automatic login at a later date.
It will cause complications with your encrypted home folder, and will potentially
lo you out of important files.

Confirm your seings and begin installation

e last screen summarizes your install seings, including any anges that
will be made to the partitions on your hard drive. Note the warning about
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data being destroyed on any removed or formaed partitions—if you have
important information on your hard drive that is not baed up, now would
be a good time to e that you have set up your partitions correctly. Once You should not need to click the Advanced

buon unless you wish to change your
bootloader seings or network proxy. These
are more advanced tasks and beyond the
scope of this guide.

you have made sure that all the seings are correct, cli on Install to begin
the installation process.

Figure .: Check that everything is set up
right before Ubuntu is installed.Ubuntu will now install. As the installation progresses, a slideshow will

give you an introduction to some of the default applications included with
Ubuntu. ese applications are covered in more detail in Chapter : Working
with Ubuntu.

Aer approximately twenty minutes, the installation will complete and
you will be able to cli Restart Now to restart your computer and start
Ubuntu. e  will be ejected, so remove it from your  drive and press
Enter to continue.

Wait while your computer restarts, and you will then see the login window
(unless you selected automatic login).

Cli your username and enter your password, then press Enter or cli



 

Figure .: The first slide in the installation
slideshow.
Figure .: You are now ready to restart
your computer.

Log in. You will then be logged in to Ubuntu and will be presented with your
new desktop!
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Figure .: The Ubuntu login window.



 The Ubuntu Desktop

Understanding the desktop

At first glance, you will notice many similarities between Ubuntu and other Ubuntu . has an emphasis on “social
from the start” and features social network
integration in the desktop for sites like
Twier and Facebook.

operating systems su as Windows or Mac  . is is because they are
all based on the concept of a graphical user interface ()—that is, you use
your mouse to navigate the desktop, open programs, move files, and perform
most other tasks. In short, things are visually oriented, whi means that it’s
important for you to become familiar with where and what to cli in Ubuntu.

GNOME

All -based operating systems use a desktop environment. Desktop environ-
ments encompass many things, su as:

‣ the look and feel of your system
‣ how the desktop is organized
‣ the way the desktop is laid out
‣ how the desktop is navigated by the user

In Linux distributions (su as Ubuntu), there are a number of desktop envi-
ronments available for use. One of the most popular desktop environments
is called , whi the default in Ubuntu. , , and  are other To read more about other variants of

Ubuntu, refer to Chapter : Learning more.popular desktop environments (used in Kubuntu, Xubuntu, and Lubuntu, re-
spectively), although there are many more. Since Ubuntu uses , we will
limit this guide to exploring your  desktop.

When you first log in to Ubuntu aer installing it, you will see the 
desktop. Ubuntu is highly customizable, as is the  desktop, but for now
let’s just explore the default layout that is in front of you.

First, you will notice there are two panels—one at the top of your desktop
and one at the boom. A panel is a bar that sits on the edge of your screen
and contains various applets. ese applets provide useful functions su as Everything on a panel is an applet, even the

main menu.running programs, viewing the time, or accessing the main menu.

The top panel

Starting from the le, you will see three menu headings—Applications,
Places, and System—followed by two program icons. e first of these icons
will open the Firefox web browser (see Chapter : Working with Ubuntu for
more information), and the next will open the Ubuntu Help Center. The Ubuntu Help Center is a highly useful

resource. It provides a wealth of infor-
mation about your Ubuntu system, and is
always at your fingertips by simply clicking
this panel icon (or navigating to System ‣
Help and Support).

On the right side of this panel you will find the notification area, whi
is similar in function to the “system tray” in Windows, or the “menu extras”
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Figure .: The Ubuntu . default desk-
top.

area on the Mac   menubar. Next to this is the MeMenu, whi will dis-
play your username (the name you entered during installation) and is used
to update social network sites like Twier and Facebook as well as set your
Instant Messaging status in Empathy. Finally, on the far right of the panel is New notifications of emails and instant

messages appear in the messaging menu
applet. When you have a new message, the
envelope icon will turn green.

the session menu, whi provides menu options for loing your computer,
logging out, restarting, or shuing down completely.

The notification area

Inside the notification area you will find the network indicator, volume ad-
justment, Bluetooth indicator (if your computer has Bluetooth capability),
messaging, and the date and time applets. Some programs will also place an
icon in the notification area when you open them.

Le-cliing icons in the notification area will bring up a list of options To remove an applet, right-click on it and
select Remove From Panel. To add a new
applet to a panel, right-click in a clear area
on the panel and select Add to Panel.

associated with the application. In some cases right-cliing an icon will also
perform another action related to that application. For example, to adjust the



   

volume, simply le-cli once on the volume icon and a volume slider will
appear. Cli the date and time applet to open a small calendar, and then cli
a specific date to add a reminder to your calendar through Evolution (see
Chapter : Working with Ubuntu for more information on Evolution).

When the calendar is expanded there is a buon labeled Locations, whi
will open a small world map when clied. Here you can further set up your
location preferences by cliing Edit. In the window that appears, cli Add,
then enter your location in the text field. If you live in a major city it may be
on the list already; if not, you can enter your latitude and longitude manually
If you don’t know this information try searing online for it. Make sure your
time zone is selected, then cli OK to return to the preferences screen.

Feel free to explore the other options available under the General and
Weather tabs if you like, then cli Close at the boom when you are done.
If weather information is available for your home city, you will now see the
current temperature displayed alongside the date and time in the notification
area.

The boom panel

Ubuntu uses most of the boom panel to display a list of all programs or win-
dows that are currently open. ese appear as horizontal buons whi can
be clied to minimize or restore the corresponding windows (see Managing
windows below for more information).

To show the desktop you can press
Ctrl+Alt+DOn the far le of the boom panel is a small icon that resembles a desktop.

is Show Desktop buon will minimize all open windows at once, giving
you clear access to your desktop. is is oen useful when you have many
windows open at once and your desktop becomes cluered. Cliing the
buon again will restore the windows to their original position.

On the right side of the panel you will see some small boxes in a row; The  desktop environment used in
Ubuntu can provide two or more “virtual
desktops,” orworkspaces. Using these
workspaces can reduce cluer by opening
windows on separate desktops, without
needing a separate monitor. For example, in
order to organize your activities you may
have your email open in one workspace
and a text document you are working on in
another. To switch workspaces, simply click
on the boxes in theworkspace switcher or
use the keyboard shortcut Ctrl+Alt+Left
arrow or Ctrl+Alt+Right arrow to switch
workspaces quickly.

this is theWorkspace Switer. By default, Ubuntu . is set up with four
workspaces.

Finally, the icon farthest to the right is the trash, whi performs a similar
function to the Recycle Bin in Windows or the Trash in Mac  . Any files
you delete are first sent to the trash. To see the contents of the trash, cli
on this icon. You can empty it by cliing on the Empty Trash buon in
the window that appears, or alternatively by right-cliing the trash icon
in the boom panel and selecting Empty Trash from the menu. is will
permanently delete any files or folders that it contains.

The desktop background

In between the top and boom panels is an image that covers the entire desk-
top. is is the desktop baground or wallpaper and the one you see in front
of you belongs to the default Ubuntu . theme known as Ambiance. To
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learn more about customizing your desktop including anging your ba-
ground, see the section on Customizing your desktop below.

Managing windows

When you open a program in Ubuntu (su as a web browser or a text ed-
itor—see Chapter : Working with Ubuntu for more information on using
programs)—a window will appear on your desktop. If you have used another
operating system before, su as Microso Windows or Mac  , you are
probably familiar with the concept of a “window”—the box that appears on
your screen when you start a program. In Ubuntu, the top part of a window
(the titlebar) will have the title of the window in the center, and three buons
in the top le corner. From le to right, these buons close, minimize, and
maximize the window. Additionally, you can right-cli anywhere on the
titlebar for a list of other window management options.

Closing, maximizing, restoring, and minimizing windows

Figure .: The close, minimize, and max-
imize buons are on the top-le corner of
windows.

To close a window, cli on the “×” in the upper le corner of the window
—this will be the first buon on the le-hand side. Immediately to the right
of this is a downward-pointing arrow that is used to minimize the window to
the boom panel of your desktop. Once minimized the window will no longer
be visible, but its corresponding buon in the boom panel will remain,
indicating the program is still running in the baground. Cliing this buon
will restore the window to its original position. Finally, the right-most buon
of this group will maximize the window, making it fill the entire screen.
Cliing this buon again will return the window to its original size.

Moving and resizing windows

To move a window around the workspace, place the mouse pointer over the
window’s titlebar, then cli and drag the window while continuing to hold
down the le mouse buon. To resize a window, place the pointer on an edge You can also move a window by holding the

Alt key and dragging the windowor corner of the window so that it turns into a larger arrow, the resize icon.
You can then cli and drag to resize the window.

Switching between open windows

ere are at least three ways in Ubuntu to swit between open windows in
a workspace. You can find the window on the boom panel taskbar and cli



   

to bring it up on the screen, or you can use Alt+Tab to select the window you
wish to work on. Hold down the Alt key, and keep pressing the Tab buon
until the window you’re looking for appears in the popup. If the window is
visible on your screen, you can cli any portion of it to raises it above all
other windows.

Using the Applications menu

ere are three menu headers in the top panel. Let’s take a look at these in You may find that there are programs in
the Applications menu that you don’t
use frequently, or just don’t want to be
displayed on the menu. To hide those
applications (without deleting the actual
programs), click on System ‣Preferences ‣
Main Menu. Find the programs in the right
panel that you want to hide from the menu,
and deselect them in the “Show” column.

more detail, starting with the Applications menu.

Accessories

e Accessories sub-menu has many programs that are suited for productiv-
ity, including Calculator and Tomboy Notes.

Other programs in Accessories include the / Creator, gedit Text See Chapter : Working with Ubuntu
for more information about the included
applications.

Editor (similar to Windows’ Notepad and Mac  ’s TextEdit), Sear for
Files (we’ll discuss that later), and Take Screenshot, whi allows you to take a
picture of your desktop screen. Another way to take a screenshot is to press

PrtSc.

Games

Ubuntu has several games built in for your entertainment. If you enjoy card
games, e out AisleRiot Solitaire. Perhaps you’re looking for more of a
allenge: in that case, there’s gBrainy and Sudoku. e Games menu also
includes Mahjongg, Mines (similar to Windows’ Minesweeper game) and
adrapassel (similar to Tetris).

Graphics

Under the Graphics sub-menu, you’ll find the F-Spot photo manager where
you can view, edit and share pictures you’ve downloaded from your camera.
OpenOffice.org Drawing allows you to create images using the OpenOffice.org
suite, and Simple Scan is a program for scanning images and documents from
your scanner.

Internet

e Internet sub-menu is where you will find the Firefox web browser and Instant messaging () is a means of text-
based communication where you can hold
a conversation with someone over the
Internet, instantly.

the Empathy Instant Messenger client to allow you to talk to your friends and
family.

Office

e Office sub-menu is where you will find most of the OpenOffice.org suite To learn more about OpenOffice.org and to
get help with using the OpenOffice.org suite
of applications, visit http://openoffice.org.

to help you create formal documents, presentation, or spreadsheets. Also

http://openoffice.org
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under Office is the Evolution email client and an online dictionary. e full
OpenOffice.org suite installed in Ubuntu by default consists of:

‣ OpenOffice.org Word Processor
‣ OpenOffice.org Spreadsheet
‣ OpenOffice.org Presentation
‣ OpenOffice.org Drawing (located under the Graphics sub-menu)

Sound and video

e Sound and Video sub-menu has programs for working with multimedia,
su as:

‣ Brasero disc burner
‣ Totem movie player
‣ Pitivi video editor
‣ Rhythmbox music player
‣ Sound Recorder

More information on all of these programs can be found in Chapter :
Working with Ubuntu.

Ubuntu Soware Center

At the very boom of the Applications menu is the Ubuntu Soware Center. Learn more about the Ubuntu Soware
Center in Chapter : Soware Management.is application gives you access to a library of soware that you can down-

load. When you open the Ubuntu Soware Center, the main screen is similar
to your Applications menu, for easy searing. If you know the name of the
program you’re looking for, just type the name into the sear box in the top
right. e Ubuntu Soware Center keeps tra of programs that are installed
on your computer. If you’re simply curious as to what is available, you can
explore the soware available using the categories listed on the le side of the
window.

Using the System menu

e System menu, located on the top panel, contains two important sub- See Chapter : Hardware for more informa-
tion on seing up Ubuntu.menus. ese sub-menus, Preferences and Administration, allow you to

make modifications to Ubuntu’s appearance, as well as the way it functions.
rough the System menu, you can also open the Ubuntu Help Center (Help
and Support), find out more about your  desktop environment (About
GNOME), and find out more about Ubuntu in general (About Ubuntu).

Preferences

You can use the Preferences sub-menu to modify the appearance of the
desktop and windows, assign a default printer, designate keyboard shortcuts,



   

ange the entries listed in the Applications menu, edit network connections,
and ange mouse seings, among other options.

Administration

e Administration sub-menu contains programs you can use to monitor Most of the applications in the System ‣
Administration menu will prompt you to
enter your user password when you launch
them. Some applications will require you
to click a buon to unlock it. Press this
buon, and enter your password. Aer
entering your password you gain increased
privileges. This is a security feature to make
sure that only authorized people are allowed
to change system seings. To learn more
about security in Ubuntu, see Chapter :
Security.

computer performance, ange disk partitions, activate third-party drivers,
manage all installed printers, and manage how your computer receives up-
dates from Ubuntu. is sub-menu also has the Synaptic Paage Manager
for locating and downloading soware paages. is is a more tenical
alternative to Ubuntu Soware Center and should be used by power users.

Browsing files on your computer

ere are two ways to locate files on your computer. You can use the Sear
for Files tool in the Applications ‣ Accessories. You can also use the Places
menu on the top panel. See the section below about the Nautilus file browser
for more details.

Places

e Places menu holds a list of commonly used folders (su as Documents,
Music, Downloads, and the Home Folder). You can also browse the disks
on your computer by cliing Computer in this menu. If you set up a home
network, you will find a menu item to access shared files/folders. You can also
access the Sear for Files tool from the Places menu, as well as browse a list
of recently opened documents.

Your home folder

e home folder is where ea user’s personal files are located. When you
installed Ubuntu, you entered a name to set up your user account. at same
name is assigned to your home folder. When you open your personal folder,
you will see that there are several folders inside: Desktop (whi contains any
files that are visible on the desktop), Documents, Downloads, Music, Pictures,
Public, Templates, and Videos.

You will also see a link named Examples. Double-cli on that link to open You should open the example content to see
how different types of files are displayed in
Ubuntu.

a folder containing example documents, spreadsheets, and multimedia files.
You will note be able to edit them. If you want to edit them move them to you
home folder.

Nautilus file browser

Just as Windows has Windows Explorer and Mac   has Finder to browse
files and folders, Ubuntu uses the Nautilus file browser by default. We will
now look at the features offered in Nautilus.
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The Nautilus file browser window

When you open a folder on the desktop or from the Places menu, the Nautilus
file browser window opens up. e standard browser window contains the
following features:

‣ Menubar: e menubar is located at the top of the window. ese menus
allow you to modify the layout of the browser, navigate, bookmark
commonly used folders and files, and view hidden folders and files. If you bookmark a folder, it will appear in

the Places menu.‣ Toolbar: e toolbar has tools for navigation and a tool to make the con-
tents of the window larger or smaller. A drop-down list gives you the
option of switing the view from Icon View to List View or Compact
View. e sear icon (whi looks like a magnifying glass) opens a field
so you can sear for a file by name.

‣ Additional Navigation Tools: Just below the toolbar, you will see a repre- If you start typing a location starting with
a / character, Nautilus will automatically
change the navigation buons into a text
field labeled Location. It is also possible to
convert the navigation buons into a text
field by pressing Ctrl+L.

sentation of where you are currently browsing. is is similar to the his-
tory function of most browsers; it keeps tra of where you are and allows
you to batra if necessary. You can cli on the locations to navigate
ba through the file browser.

‣ Le Pane: e le pane of the file browser has shortcuts to commonly-
used folders. When you bookmark a folder, it appears in the le pane.
No maer what folder you open, the le pane will always contain the
same folders. is le pane can be anged to display different features by
cliing the down arrow beside “Places” near the top.

‣ Central Pane: e largest pane shows the files and folders in the directory
that you are currently browsing.

Navigating between directories

To navigate between directories, use the bookmarks in the le pane of the
Nautilus file browser. You can also retrace your steps by cliing on the name
of a folder where it is listed just below the navigational icons. Double-cliing
on a visible directory will cause you to navigate to it in Nautilus.

Opening files

To open a file, you can either double-cli on its icon or right-cli and select
Open With (program).

Creating new folders

To create a new folder from within Nautilus cli File ‣Create Folder, then Note that you can easily view hidden files
by clicking View ‣ Show Hidden Files, or
alternatively by pressing Ctrl+H. Hiding
files with a dot (.) is not a security measure
—instead it provides a way of keeping your
folders organized and tidy.

name the folder that appears by replacing the default “untitled folder” with
your desired label (e.g., “Personal Finances”). You can also create a new folder
by pressing Ctrl+Shift+N, or by right-cliing in the file browser window
and selecting Create Folder from the popup menu (this action will also work



   

Figure .: Nautilus file manager displaying
your home folder.

on the desktop). If you wish to hide certain folders or files, place a dot (.) in
front of the name (i.e., “.Personal Finances”). In some cases it impossible to
hide files and folders, without prefixing them with a dot. In Nautilus these
folders can be hidden by creating a .hidden file. Open the file and type in the
name of the file(s) or folder(s) you wish to hide. Make sure that ea file or
folder is on a separate line. When you open Nautilus the folder will no longer
be visible.

Copying and moving files and folders

You can copy files or folders in Nautilus by cliing Edit ‣Copy, or by right- You can also use the keyboard shortcuts
Ctrl+X, Ctrl+C and Ctrl+V to cut, copy and
paste (respectively) files and folders.

cliing on the item and selecting Copy from the popup menu. When using
the Edit menu in Nautilus, make sure you’ve selected the file or folder you
want to copy first (by le-cliing on it once).

Multiple files can be selected by le-cliing in an empty space (i.e., not
on a file or folder), holding the mouse buon down, and dragging the cursor
across the files or folders you want. is “cli-drag” move is useful when you
are selecting items that are grouped closely together. To select multiple files
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or folders that are not positioned next to ea other, hold down the Ctrl key
while cliing on ea item individually. Once multiple files and/or folders
are selected you can use the Edit menu to perform actions just like you would
for a single item.When one or more items have been “copied,” navigate to the When you “cut” or “copy” a file or folder,

nothing will happen until you “paste” it
somewhere. Paste will only affect the most
recent item that was cut or copied.

desired location then cli Edit ‣ Paste (or right-cli in an empty area of the
window and oose Paste) to copy them to the new location.

While the copy command can be used to make a duplicate of a file or folder
in a new location, the cut command can be used to move files and folders
around. at is, a copy will be placed in a new location, and the original will
be removed from its current location.

To move a file or folder, select the item you want to move then cli Edit ‣
Cut. Navigate to your desired location, then cli Edit ‣ Paste. As with the In the Nautilus Edit menu, you will also

find the Copy To andMove To buons.
These can be used to copy or move items to
common locations, and can be useful if you
are using panes (see below). Note that it is
unnecessary to use Paste when using these
options.

copy command above, you can also perform this action using the right-cli
menu, and it will work for multiple files or folders at once. An alternative
way to move a file or folder is to cli on the item, and then drag it to the new
location.

Using multiple tabs and multiple Nautilus windows

Opening multiple Nautilus windows can be useful for dragging files and
folders between locations. e option of tabs is also available in Nautilus,
as well as the use of panes. When browsing a folder in Nautilus, to open a When dragging items between Nautilus

windows, tabs or panes, a small symbol will
appear over the mouse cursor to let you
know which action will be performed when
you release the mouse buon. A plus sign
(+) indicates you are about to copy the item,
whereas a small arrow means the item will
be moved. The default action will depend
on the locations you are using.

second window select File ‣NewWindow or press Ctrl+N. is will open a
new window, allowing you to drag files and folders between two locations.
To open a new tab, cli File ‣New Tab or press Ctrl+T. A new row will
appear above the space used for browsing your files containing two tabs—both
will display the directory you were originally browsing. You can cli these
tabs to swit between them, and cli and drag files or folders between tabs
the same as you would between windows. You can also open a second pane
in Nautilus so you can see two locations at once without having to swit
between tabs or windows. To open a second pane, cli View ‣Extra Pane, or
press F3 on your keyboard. Again, dragging files and folders between panes is
a qui way to move or copy items.

Searching for files on your computer

Earlier, we mentioned that you can sear for files on the computer by using Search for files quickly by pressing Ctrl+F
in Nautilus and then typing what you want
to find.

the Sear for Files feature on the Places menu in the top panel. You can also
use the Nautilus browser to sear for files, as explained above.

Customizing your desktop

Now that you’ve been introduced to the  desktop environment, let’s
take a look at customizing some of its features, su as modifying the behav-
ior of your panels, or anging the look and feel of your desktop.



   

Panels

e panels (currently siing at the top and boom of your screen) can be
moved from their default positions to the sides of the screen, set to hide
from view when not in use, and can ange color. To access these features,
right-cli the panel you want to modify and select Properties from the pop-
up menu. e General tab has options to autohide, position the panel, and
ange the panel size (width).

Use the Orientation drop-down box to select where you want the panel to
be located, and underneath this you can set the desired width (in pixels).

By default, a panel covers the entire length of the desktop. To ange that,
you can deselect the Expand option. e panel will then shrink so that it is
just long enough to accommodate any applets or program launers that are
currently siing in it. Tiing the Autohide buon will cause your panel to
“fold” up into the edge of the screen when you are not using it, and remain
hidden until you move your mouse cursor ba to that screen edge.

An alternative way of hiding the panel is to do so manually. Cliing on
Show hide buttons will add a buon to ea side of the panel that can be
used to hide it from view. By default these buons will display directional ar-
rows; however, you can select the Arrows on hide buttons option to remove
the arrows and just have plain buons. Cliing one of these hide buons on
the panel will slide it across the screen and out of view, leaving just the oppo-
site hide buon in sight whi you can cli to bring it ba. e Baground By default, Ubuntu requires that you

maintain at least one panel on the desktop.
If you prefer a Microso Windows feel,
a panel at the boom of the desktop can
be set to start programs as well as select
between open windows. Alternatively, if
you prefer a Mac   look you can keep
a panel at the top and add an applications
dock such as Docky, Avant Window
Navigator (), or Cairo-Dock. These are
all available in the Ubuntu Soware Center,
which is discussed further in Chapter :
Soware Management.

tab in the “Panel Properties” window allows you to ange the appearance of
the panel. By default, this is set to None (use system theme), meaning that
your desktop theme will dictate the appearance of the panel (we will look
at how to ange your desktop theme below). If you prefer, you can oose
your own panel color by selecting the Solid color buon, then opening the
color select window. You can also set the panel transparency using the slider.
Alternatively, you can cli the Baground image buon if you have an
image or paern stored on your computer that you would like to use as your
panel baground. Use the file selector to locate the baground image in your
computer, then cli Open to apply the ange.

Adding applets

Ubuntu provides a selection of applets that can be added to any panel. Applets
range from the informative to the fun, and can also provide qui access to
some tasks. To add an applet, right-cli on a panel then select Add to Panel…
from the popup menu. A window will appear with a list of available applets,
whi can then be dragged to an empty space on a panel. You may want
to spend some time exploring the different ones available—they can easily
be removed from your panel by right-cliing on the applet and selecting
Remove From Panel.

Some applets will be locked and can’t be
moved. Right-click on them and deselect the
“Lock to Panel” check box.
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To reposition an existing applet, right-cli on it and selectMove. Move
your mouse cursor to the desired location (this can even be a different panel)
and the applet will follow, then le-cli to drop it into place.

e “Add to Panel…” window can also be used to add additional application You can also add program launchers to a
panel by dragging them directly from the
Applications menu, in the le of the top
panel.

launers to your panel, similar to the Firefox launer that sits to the right of
the System menu. To add a new one, double-cli on Application Launer…
near the top of the window. Here you can navigate through your applications
and drag them to your panel to create a new launer, just as you did to add
an applet previously. Program launers can also be removed and repositioned
through their right-cli menu.

Workspaces

To modify your workspaces, right-cli on the workspace switer applet (by
default this is on the right side of the boom panel, just to the le of the Trash
applet) and select Preferences. In the window that appears you can oose
how many workspaces you want in total, and whether these will be displayed
on the panel in one or more rows. You can also rename ea workspace, and
have the names displayed in the panel applet. If you prefer, you can also
oose to just have the workspace you are currently using displayed in the
panel. In this case, you can still ange between workspaces by moving the
mouse over the workspace switer and scrolling the mouse wheel.

Appearance

You can ange the baground, fonts, and window theme to further modify
the look and feel of your desktop. To begin, open the Appearance Preferences
by navigating to System ‣ Preferences ‣Appearances in the top panel.

Theme

e “Appearance Preferences” window will initially display theeme tab
when it opens. Here you can select a theme that will control the appearance
of your windows, buons, scroll bars, panels, icons, and other parts of the
desktop. e “Ambiance” theme is used by default, but there are seven other
themes you can oose from. Just cli once on the theme you want to try,
and the anges will take effect immediately.

You can download additional themes by cliing the “Get More emes
Online” link at the boom of this window. Your web browser will open and
take you to http://art.gnome.org/themes/, where you can download new
themes from a large selection. Once you have downloaded a theme, locate
the file on your computer (using Nautilus) and drag it across to the emes
window. is will add it to your list of available themes, and a window will
appear asking whether you want to apply the anges immediately.

You can also customize any theme to your liking by selecting it then cli-

http://art.gnome.org/themes/


   

ing the Customize… buon underneath. Here you can mix elements of dif-
ferent themes su as icons, mouse pointers, buons, and window borders to
create your own unique look.

Figure .: You can change the theme in the
Theme tab of “Appearance Preferences”.

Desktop background

Cli the Baground tab in the Appearance Preferences window to ange You can also change the background by
right-clicking on the desktop and selecting
Change Desktop Background from the
pop-up menu.

the desktop baground. Here you will see Ubuntu’s default selection of
bagrounds. To ange the baground simply cli the picture you would
like to use. You’re not limited to this selection though. To use one of your own
pictures, cli the Add… buon, and navigate to the image you want. Double-
cli it, and the ange will take effect immediately. is image will also then
be added to your list of available bagrounds.

If you are aer a larger selection of desktop bagrounds, cli the “Get
More Bagrounds Online” link at the boom of the Appearance Preferences
window. is link will open your web browser, and direct you to the http://
art.gnome.org/backgrounds website.

http://art.gnome.org/backgrounds
http://art.gnome.org/backgrounds
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Fonts

You can also ange the fonts used throughout your desktop through the
Appearance Preferences window by cliing on the Fonts tab. You can indi-
vidually set the font style and size for applications, documents, desktop items,
window titles, and for anything using fixed width fonts. e Rendering sec-
tion at the boom of the Fonts tab gives you four options for anging the
way that fonts are drawn on your screen. Changing these may improve the
appearance of text on different types of monitors.

Screensaver

Ubuntu offers a selection of screensavers. By default, a blank screen will be
displayed aer a short period of inactivity. To select a different screensaver,
cli on the System menu in the top panel, then Preferences ‣ Screensaver.
is will open the “Screensaver Preferences” window, with the available
screensavers listed on the le. When you select a screensaver, you will see
a mini-preview in the window, or you can see how it will look on your full
screen by cliing the Preview buon. e le and right arrow buons at the
top allow you to scroll through the different screensavers without leaving the
full screen preview. To return to the Screensaver Preferences window, cli
the Leave Fullscreen buon at the top of the screen.

Make sure that the Activate screensaver when computer is idle option
is selected if you want to enable the screensaver. e slider can be adjusted
to set the duration of inactivity before the screensaver appears. Once it does,
you can resume working on your computer by pressing any key or by moving
your mouse. For added security, you can also select the Lo screen when
screensaver is active option. In this case, Ubuntu will ask you for your login
password when you return to the computer.

Accessibility

Ubuntu has built-in tools that make using the computer easier for people
with certain physical limitations. You can find these tools by opening the
System menu, then selecting Preferences ‣Assistive Tenologies. You can
adjust keyboard and mouse seings to suit your needs through the “Assistive
Tenologies Preferences” window by cliing on the Keyboard Accessibility
orMouse Accessibility buons.

Other assistive technologies

Orca is another useful tool for persons with visual impairments, and comes
preinstalled on Ubuntu. To run Orca, press Alt+F2 and type orca into the
command text field. en press Enter or cli Run. Orca’s voice synthesizer
will activate and assist you through the various options su as voice type,



   

Figure .: Assistive Technologies allows
you to enable extra features to make it easier
to use your computer.

voice language, Braille, and screen magnification. Once you have finished
selecting your seings, you will need to log out of the computer (Orca will
offer to do this for you). When you log ba in, the Orca seings you ose
will automatically run every time you use your computer.

In addition to these options, selecting high-contrast themes and larger
on-screen fonts can further assist those with vision difficulties.

Managing your computer

When you have finished working on your computer, you can oose to log
out, suspend, restart, or shut down through the session menu on the far right
side of the top panel. You can also quily access these options by pressing the
Ctrl+Alt+Del keys.

Logging out

Logging out will leave the computer running but return you to the login
screen. is is useful for switing users, su as when a different person
wishes to log in to their account, or if you are ever instructed to “log out and
ba in again.” You should save your work before logging out.

Suspend

To save energy, you can put your computer into suspend mode, whi will
save its current condition and allow you to start more quily while remain-
ing on but using very lile energy. Suspending the computer spins down the
hard disk and saves your session to memory, so it is very qui to suspend and
resume from suspension.
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Hibernate

Hibernate is similar to suspend, except that instead of saving your session to
memory, hibernate will save your session to the hard disk. is takes a lile
longer, but with the added benefit that hibernation uses no power while it is
in a hibernated state.

Rebooting

To reboot your computer, select Restart from the session menu.

Shut down

To totally power down your computer, select Shut Down from the session
menu.

Other options

From the session menu, you can also select Lo Screen to require a password You can lock your screen quickly by using
the keyboard shortcut Ctrl+Alt+L. Locking
your screen is recommended if you move
away from your computer for a short
amount of time.

before using the computer again—this is useful if you need to leave your
computer for some duration. You can also use the session menu to set up a
guest session for a friend to try Ubuntu, or to swit users to log into another
user account without closing your applications.

Geing help

Ubuntu, just like other operating systems, has a built-in help reference, called Many programs have their own help which
can be accessed by clicking the Help menu
within the application window.

the Ubuntu Help Center. To access it, cli on the help icon in the top panel.
You can also access it by cliing Help and Support in the System menu.

Figure .: Clicking the blue help icon
in the top panel (just to the right of the
System menu and the Firefox icon) will
open Ubuntu’s built-in system help.

If you can’t find an answer to your question in this manual or in the
Ubuntu Help Center, you can contact the Ubuntu community through the
Ubuntu Forums (http://ubuntuforums.org). Many Ubuntu users open an ac- We encourage you to check any infor-

mation you find on other websites with
multiple sources when possible, but only
follow directions if you understand them
completely.

count on the forums to receive help, and in turn provide support to others
as they gain more knowledge. Another useful resource is the Ubuntu Wiki
(https://wiki.ubuntu.com), a website maintained by the Ubuntu community.

http://ubuntuforums.org
https://wiki.ubuntu.com


   

Figure .: The built-in system help provides
topic-based help for Ubuntu.





 Working with Ubuntu

Geing online

If you are in a location with Internet access, you will want to make sure
you are connected in order to get the most out of your Ubuntu operating
system. is section of the manual will help you e your connection and
configure it where necessary. Ubuntu can connect to the Internet using a
wired, wireless, or dialup connection. It also supports some more advanced
connection methods, whi we will briefly discuss at the end of this section.

A wired connection refers to when your computer is physically connected
to a router or an Ethernet port with a cable. is is the most common connec-
tion for desktop computers.

A wireless connection is when your computer is connected to the Internet
via a wireless radio network, also known as Wi-Fi. Laptop computers com-
monly use Wi-Fi due to portability, making it easy to access the Internet from
different rooms in the house or when traveling.

In order to connect wirelessly, you must be in a location with a working
wireless network. To have your own, you will need to purase and install a
wireless router or access point. Some locations may already have a publicly
accessible wireless network available.

A dialup connection is when your computer uses a modem to connect to an
Internet service provider through your telephone line.

NetworkManager

In order to connect to the Internet in Ubuntu, you need to use the Network- If you are unsure whether your computer
has a wireless card, check with your
manufacturer.

Manager utility. NetworkManager allows you to turn all networking on or off,
and helps you manage your wired, wireless, and other connections.

Figure .: NetworkManager will display
this icon in the top panel when you are
connected to a wired network.

You can access all the functions of NetworkManager using its icon in the
top panel. is icon may look different depending on whether you currently
have a working connection, and whether the connection is wired or wireless.
If you are unsure, try hovering your mouse over the icon until a short de-
scription appears near the cursor. is will read “Wired network connection
‘Auto eth0’ active” (for example) if you have a working wired connection, or
otherwise something else related to networking or connections su as “No
connection” or “Networking disabled.”

Cliing this icon will bring up a list of network connections that are
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Figure .: Here you can see the currently
active “auto eth0” connection listed in the
NetworkManager menu.

available to you. If you are currently connected to the Internet, the name of
this connection will be highlighted in bold.

Figure .: This is the menu when you
right-click the networking icon.

You can also right-cli on the NetworkManager icon. is will open a
menu allowing you to enable or disable networking, view tenical details
about your current connection, or edit all connection seings. In the image
above, the e box next to “Enable Networking” is currently selected; you
can deselect it to disable all network connections. is may be useful if you
need to shut off all wireless communication, su as when in an airplane.

Establishing a wired connection

If you have an Ethernet cable running from a wall soet, a router, or some
other device, then you will want to set up a wired network connection in
Ubuntu.

In order to connect with a wired connection, you need to know whether Are you already online? If the Network-
Manager icon in the top panel shows a
connection, then you may have successfully
connected during the installation process. If
so, you do not need to follow the rest of this
section.

your network connection supports . is stands for “Dynamic Host
Configuration Protocol,” and is a way for computers on your network to
automatically receive configuration information from your Internet service
provider (). is is usually the quiest and easiest way of establishing
a connection between your computer and your  in order to access the
Internet, although some s may provide what is called a static address
instead. If you are unsure whether your  supports , you may wish to
contact their customer service line to e. ey will also be able to provide
you with information on your static address if one has been allocated to you
(in many cases s only allocate static addresses to customers upon request).



   

Automatic connections with DHCP

If your network supports , you may already be set up for online access.
To e this, cli on the NetworkManager icon. ere should be a “Wired
Network” heading in the menu that is displayed. If “Auto eth0” appears di-
rectly underneath, then your computer is currently connected and probably
already set up correctly for . If “disconnected” appears in gray under-
neath the wired network section, look below to see if an option labeled “Auto
eth0” appears in the list. If so, cli on it to aempt to establish a wired con-
nection.

To e if you are online, right-cli on the NetworkManager icon in the
top panel and select the Connection Information option.

Figure .: This window displays your 
address and other connection information.

You should see a window showing details about your connection. If your  An Internet Protocol () address is a
numerical label assigned to devices on a
computer network. It is the equivalent of
phone numbers for your house and allows
your computer to be uniquely identified so
you can access the Internet and share files
with others.

address is displayed as ... or starts with ., then your computer was
not successfully provided with an address through . If it shows another
address, it is most likely that your connection was automatically configured
correctly. To test out your Internet connection, you may want to open the
Firefox web browser to try loading a web page. More information on using
Firefox can be found later in this apter.

If you are still not online aer following these steps, you may need to try To access the “Connection Information”
window, you will need to make sure that
networking is enabled. Otherwise this
option will be gray and you will not be
able to select it through the right-click
menu of the NetworkManager applet.
To enable networking, right-click on the
NetworkManager applet and select Enable
Networking from the popup menu.

seing up your Internet configuration manually, using a static  address.

Manual configuration with static addresses

If your network does not support , then you need to know a few items of
information before you can get online.

‣ An  address is a unique address used for identifying your computer on
the Internet. When connecting through  this is likely to ange at
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times. However, if your  has provided you with a static address then
it will not. An  address is always given in the form of four numbers
separated by decimal points, for example, ....

‣ e network mask tells your computer how large the network is that it be-
longs to. It takes the same form as an  address, but is usually something
like ...

‣ e gateway is the  address at your ’s end. It helps your computer
connect or “talk” with their network, whi acts as a “gateway” between
your computer and the Internet.

‣  servers are one or more  addresses of “Domain Name System”
servers. ese servers convert standard web addresses (like http://www.
ubuntu.com) into  addresses su as .... is step allows your
computer to “find” the correct web site when you type in the web address
you wish to visit. A minimum of one  server is required, up to a maxi-
mum of three. e additional ones are used in case the first one fails.

To manually configure a wired connection, right-cli on the Network- If you do not already have these seings,
you will need to consult your network
administrator or  customer support to
receive them.

Manager icon and select Edit Connections. Make sure you are looking at the
Wired tab inside the “Network Connections” window that is displayed.

e list may already have an entry su as “Auto eth0,” or a similar name.
If a connection is listed, select it and then cli the Edit buon. If no connec-
tion is listed, cli the Add buon instead.

If you are adding a connection, you first need to provide a name for the
connection so you can distinguish it from any others that are added later. In
the “Connection name” field, oose a name su as “Wired connection .”

Figure .: In this window you can manually
edit a connection.

http://www.ubuntu.com
http://www.ubuntu.com


   

To set up the connection:

. Under the connection name, make sure that the Connect automatically
option is selected.

. Swit to the v Settings tab.
. Change theMethod to “Manual.”
. Cli on the Add buon next to the empty list of addresses.
. Type in your  address in the field below the Address header.
. Cli to the right of the  address, directly below the Netmask header,

and type in your network mask. If you are unsure of your network mask,
“...” is the most common.

. Cli to the right of the network mask, directly below the Gateway header,
and type in the address of your gateway.

. In the  servers field below, type in the addresses of your  server. If
your network has more than one  server, enter them all, separated by
spaces or commas.

. Cli Apply to save your anges.

A  address is a hardware address for your computer’s network card, and
entering it is sometimes important when using a cable modem connection or
similar. If you know the  address of your network card, this can be entered in
the appropriate text field in theWired tab of the editing window.

When you have returned to the Network Connections screen, your newly-
added connection should now be listed. Cli Close to return to the desktop.
If your connection is configured correctly, the NetworkManager icon should
have anged to show an active connection. To test if your connection is
properly set up, refer to the instructions above for eing a  connec-
tion.

Wireless

If your computer is equipped with a wireless (Wi-Fi) card and you have a
wireless network nearby, you should be able to set up a wireless connection in
Ubuntu.

Connecting to a wireless network for the first time

If your computer has a wireless network card, you should be able to connect
to a wireless network. Most laptop and netbook computers have a wireless
network card.

Ubuntu is usually able to detect any wireless networks that are available To improve speed and reliability of your
connection, try to move closer to your
router or access point.

within range of your wireless card. To see a list of wireless networks, cli
on the NetworkManager icon. Under the “Wireless Networks” heading, you
should see a list of available wireless networks. Ea network will be shown
with a name on the le, and a signal meter on the right. A signal meter looks
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like a series of bars—the more bars that are filled in, the stronger the connec-
tion will be.

A wireless network may be open to anyone to connect, or may be pro-
tected with network security. A small padlo will be displayed next to the
signal meter of any wireless networks that are protected. You will need to
know the correct password in order to connect to these.

To connect to a wireless network, select the desired network’s name from
the list. is will be the name that was used when the wireless router or
access point was installed. If you are in a workplace or a location with a
publicly accessible wireless network, the network name will usually make it
easy to identify.

If the network is unprotected (i.e., the network signal meter does not
display a padlo), a connection should be established within a few seconds.
e NetworkManager icon in the top panel will animate as Ubuntu aempts
to establish a connection. If it connects successfully the icon will ange
to display a signal meter. A notification message in the upper right of your
screen will also appear, informing you that a connection was established.

If the network is secured, Ubuntu will display a window called “Wireless
Network Authentication Required” once it tries to connect. is means that a
password is required in order to connect.

Figure .: Type in your wireless network
passphrase.

If you know the password, enter it in the Password field, and then cli
Connect. As you type your password, it will be obscured to prevent others
from seeing it. If you prefer, you can select the Show password option to see
the password as you type.

Aer you cli the Connect buon, the NetworkManager icon in the top
panel will animate as it tries to connect to the network. If you have entered
the correct password, a connection will be established and the NetworkMan-
ager icon will ange to show signal meter bars. Again, Ubuntu will display
a pop up message in the upper right of your screen informing you that a con-
nection was established.

If you entered the wireless network’s password incorrectly, Network- Select the Show Password option to make
sure you haven’t made a mistake when
entering the password.

Manager will aempt to establish a connection then return to the “Wireless



   

Network Authentication Required” window. You can aempt to enter the
correct password again, or cli Cancel to abort your connection. If you do
not know the password to the network you have selected, you will need to get
the password from the network administrator.

Once you have successfully established a wireless network connection,
Ubuntu will store these seings (including the network password) in order
to make it easier to connect to the same wireless network in future. You
may also be prompted to select a keyring password here. e keyring stores
network and other important passwords in the one place, so you can access
them all in future by just remembering your keyring password.

Connecting to a saved wireless network

If you have previously successfully established a wireless connection, that
connection’s password will be saved on your computer. is will allow you to
connect to the same network without having to re-enter the password.

In addition, Ubuntu will automatically try to connect to a wireless network
within range if it has its seings saved. is will work for both open and
secured wireless networks.

If you have many saved wireless networks that are in range, Ubuntu may
oose to connect to one of them, while you may prefer to connect to another.
In this case, cli on the NetworkManager icon. You should see a list of wire-
less networks in range, along with their signal meters. Cli on your desired
network.

If the password and other seings have not anged, Ubuntu will connect
to the wireless network you ose. If the password has ange, Ubuntu will
open the “Wireless Network Authentication Required” window. In this case,
follow instructions in the previous section.

Connecting to a hidden wireless network

In some circumstances, you may need to connect to a hidden wireless net-
work. ese hidden networks do not broadcast their names, whi means that
they will not show up in the list of wireless networks in the NetworkManager
menu. In order to be able to connect to a hidden network, you will need to get
its name and security seings from your network administrator.

To connect to a hidden network:

. Cli on the NetworkManager icon in the top panel.
. Choose the Connect to Hidden Wireless Network option. Ubuntu should

open the “Connect to Hidden Wireless Network” window.
. By default, the Connection field should show “New…”—you can leave this

unanged.
. In the Network name field, enter the name of the wireless network. is

name is also known as a . Please enter the network name exactly as it
was given to you.
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. In theWireless security field, select one of the options. If the network is
open, leave this field as “None.” If you do not know the correct seing for
the network you will not be able to connect to the hidden network.

. Cli on the Connect buon.

e rest of the process should work exactly as in the section on the initial
connection to wireless networks. Once set up according to the instructions
above, the hidden network should show up in the list of saved networks.

Disabling and enabling your wireless network card

Wireless access in Ubuntu is enabled by default if you have a wireless net- Some computers may have a physical switch
or buon to turn off Wi-Fi.work card in your computer. In certain cases, for example on airplanes, you

may need or be required to turn your wireless radio off.
To do this, right-cli on the NetworkManager icon, and deselect the En-

able Wireless option. Your wireless network will be turned off, and your
computer will no longer sear for available wireless networks.

To turn wireless networking ba on, right-cli on the NetworkManager
icon, and cli on the Enable Wireless option to re-select it. Your wireless
network will be turned ba on. Ubuntu will then sear for nearby wireless
networks and will connect to any saved networks within range.

Changing an existing wireless network

At times, you may want to ange the seings for a wireless connection that
you have previously saved. Its password may have anged, or your system
administrator asked you to ange some networking or security seings.

To edit a saved wireless network connection:

. Right-cli on the NetworkManager icon and select Edit Connections…
. A “Network Connections” window should open. Cli on theWireless tab

to see a list of saved wireless connections
. By default, this list shows connections in the order of most recently used to

least recently used. Find the connection you want to edit, cli on it, and
then cli Edit.

. Ubuntu should open a window called “Editing ⟨connection name⟩”, where
⟨connection name⟩ is the name of the connection you are editing. e
window should display a number of tabs.

. Above the tabs, you may ange the Connection name field if you want to
give the connection a more recognizable name

. If the Connect automatically option is not selected, Ubuntu will detect
the wireless network but will not automatically connect to it without you
oosing it from the NetworkManager menu. Select or deselect this seing
as needed.

. On theWireless tab of the “Editing ⟨connection name⟩” window, you may
need to edit the  field. A  is the wireless connection’s network



   

name—if set incorrectly, the network may not be detected and a connection
may not be made. Please make sure that the  is set according to your
network administrator’s instructions.

. Below the , you should see theMode field. e “Infrastructure” mode
means that you would be connecting to a wireless router or access point.
is is the most common mode for wireless networks. e “Ad-hoc” mode
is a computer-to-computer mode and is oen only used in advanced cases.

. On theWireless Security tab of the “Editing ⟨connection name⟩” window,
you may need to ange the Security field to the correct seing. A selec-
tion of None means that you are using an open network with no security.
Other selections may require slightly different additional information:

‣  /-bit Key is an older security seing still in use by some
wireless networks. If your network uses this security mode, you will
need to enter a key in the Key field that should appear aer you select
this mode.

‣  -bit Passphrase is the same older security seing as the entry
above. However, instead of a key, your network administrator should
have provided you with a text passphrase—a password—to connect to
the network. Once you select this security mode, you will need to enter
your passphrase in the Key field.

‣  &  Personal is the most common security mode for wireless
network connections at home and at businesses. Once you select this
mode, you will need to enter a password in the Password field.

‣ If your network administrator requires , Dynamic , or  &
 Enterprise security, you will need to have the administrator help
you set up those security modes.

. On the v Settings tab, you may need to ange theMethod field from
“Automatic ()” to “Manual,” or one of the other methods. For seing
up manual seings (also known as static addresses), please see the section
above on manual set up for wired network connections.

. When you finish making anges to the connection, cli Apply to save
your anges and close the window. You can cli Cancel to close the
window without making anges.

. Finally, cli Close on the “Network Connections” window to return to the
desktop.

Aer making anges, your new seings should go into effect immediately.

Other connection methods

ere are other ways to get connected with Ubuntu.
With NetworkManager, you can also configure Mobile Broadband connec-

tions to keep online through your cellular or other mobile data carrier.
You can also connect to s (Digital Subscriber Lines), whi are a method

of Internet connection that uses your telephone lines and a “ modem.”
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Figure .: The default Ubuntu home page
for the Firefox web browser.

It’s also possible to use NetworkManager to establish a  (Virtual Private A  is a “Virtual Private Network,” and is
sometimes used to help secure connections.
s are “Digital Subscriber Lines,” a type of
broadband connection.

Network) connection. ese are commonly used to create secure connectivity
to a workplace.

e instructions for making connections using mobile broadband, s, or
s, are beyond the scope of this guide.

Browsing the web

Once you have connected to the Internet, you should be able to browse the
web with Ubuntu. Mozilla Firefox is the default application for browsing the
web in Ubuntu.

Starting Firefox

To start Firefox, cli Applications ‣ Internet ‣ Firefox Web Browser. If your To set other keyboard shortcuts or to
change the shortcut for launching Firefox,
go to System ‣Preferences ‣Keyboard
Shortcuts.

keyboard has a “” buon, you can also press that buon to start Firefox.



   

Navigating web pages

Viewing your homepage

When you start Firefox, you will see your home page. By default, you will see
the Ubuntu Start Page.

To go to your home page quily, press Alt+Home.

Navigating to another page

To navigate to a new web page, you need to type its Internet address (also  stands for uniform resource locator and
 stands for world wide web.known as a ) into the Location Bar. s normally begin with “hp://”

followed by one or more names that identify the address. One example is
“http://www.ubuntu.com/”.

Figure .: You can enter a web address or
search the Internet by typing in the location
bar.

To navigate:

. Cli on the Location Bar to select the  that is already there.
. Type the  of the page you want to visit. e  you type replaces any

text already in the Location Bar.
. Press Enter.

To quily select the  of the Location Bar, press Ctrl+L. You can also press F6 on your keyboard to
highlight the location bar in Firefox.If you don’t know a , try typing something specific to the page you

want to visit (for example a name or other sear request) into the Location
Bar and press Enter. is will sear your preferred sear engine—Google by
default—for that term, and take you to the web page that is the top result from
the sear.

Clicking a link

Most web pages contain links you can cli to move to other pages.
To cli a link:

. Move the mouse pointer until it anges to a pointing finger. is happens
whenever the pointer is over a link. Most links are underlined text, but
buons and pictures on a web page can also be links.

. Cli on the link once. While Firefox locates the link’s page, status mes-
sages will appear at the boom of the window.

Retracing your steps

If you want to visit a page you have seen before, there are several ways to do To go backwards and forwards you can also
use Alt+Leftto go backwards or Alt+Right
to go forwards.

http://www.ubuntu.com/
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so.

‣ To go ba or forward one page, cli on the Ba or Forward buon.
‣ To go ba or forward more than one page, cli on the small triangle
next to the Forward buon. You should see a list of pages you’ve recently
visited. To return to a page, select it from the list.

‣ To see a list of any s you’ve typed into the Location Bar, cli on the
down arrow at the right end of the Location Bar. To view a page, select it
from the list.

‣ To oose from pages you’ve visited during the current session, open the
History menu and oose from the list in the boom section of the menu.

‣ To oose from pages you’ve visited during the past several sessions, open
the History menu and oose Show All History. Firefox should open a
“Library” window, whi shows a list of folders. Cli on the folders to
displays sub-folders, or titles of web pages you’ve visited in the past. Cli
on a page’s title to view that page.

Stopping and reloading

If a page is loading too slowly or you no longer wish to view a page, cli on
the Stop buon.

To reload the current page or to get the most up-to-date version, cli on
the Reload buon or press Ctrl+R.

Opening new windows

At times, you may want to have more than one browsing window. is may
help you organize your browsing session beer, or separate web pages that
you are viewing for different reasons.

ere are two ways to create a new window:

‣ On the menubar, open the File menu, then oose NewWindow.
‣ Press Ctrl+N.

Once a new window has opened, you can use it just like the first window
—including navigation and opening tabs.

Opening a link in a new window

Sometimes, you may want to cli on a link to navigate to another web page,
but do not want the original page to close. To do this, you can open the link
you’d like to cli in its own window.

ere are two ways to open a link in its own window:

‣ Right-cli on a link to open its popup menu. Choose the Open Link in
New Window option. A new window will open, containing the web page
for the link you clied.



   

‣ Press-and-hold the Shift key while cliing a link. is will also open the
web page in a new window.

Tabbed browsing

If you would like to visit more than one web page at a time, you can use You can alternate quickly between differ-
ent tabs by using the keyboard shortcut
Ctrl+Tab.

Tabbed Browsing to navigate the web.
Tabbed browsing lets you open several web pages within a single Firefox

window, ea displaying in its own tab. is frees up space on your desk-
top since you don’t have to have a window open for every web page you’re
currently visiting. You can open, close, and reload web pages in one place
without having to swit to another window.

Opening a new blank tab

ere are three ways to create a new blank tab:

‣ Cli on the New Tab buon on the right side of the last tab.
‣ On the menubar, open the File menu, and then oose New Tab.
‣ Press Ctrl+T.

When you create a new tab, it will contain a blank page with the Location
Bar focused. Start typing a web address () or other sear term to open a
website in the new tab.

Opening a link in its own tab

Sometimes, you may want to cli on a link to navigate to another web page,
but do not want the original page to close. To do this, you can open the link
you’d like to cli in its own tab.

ere are many ways to open a link in its own tab:

‣ If your mouse has a middle buon, or a wheel, cli on the link with the
middle mouse buon or wheel. A new tab should open, containing the web
page for the link you clied.

‣ Cli on the link with the le mouse buon, and keep holding down the
mouse buon. Drag the link up to a blank space on the tab bar, and release
the mouse buon. A new tab should open, containing the web page for the
link you dragged.

‣ Press-and-hold the Ctrl key while cliing the le mouse buon on the
link. A new tab should open, containing the web page for the link you
clied.

‣ Right-cli on a link to open its popup menu. Choose the Open Link in
New Tab option. A new tab will open, containing the web page for the link
you clied.

‣ Cli on a link, holding both le and right mouse buons.
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Closing a tab

Once you are done viewing a web page in a tab, you can close that tab.
ere are four ways to close a tab:

‣ Cli on the Close buon on the right side of the tab you want to close.
‣ On the menubar, open the File menu, and then oose Close Tab.
‣ Cli on the tab you want to close with the middle mouse buon, or the
mouse wheel, if you have one.

‣ Press Ctrl+W.
‣ Cli on the tab with both mouse buons.

Restoring a closed tab

Sometimes, you may close the wrong tab by accident, or want to bring ba a
tab that you’ve recently closed.

To bring ba a tab you’ve closed, do one of the following:

‣ On the menubar, open the History menu, oose Recently Closed Tabs,
and then oose the name of the tab you want to restore.

‣ Press Ctrl+Shift+T to re-open the most recently closed tab.

Changing the tab order

To move a tab to a different location on the tab bar, drag it there using your
mouse. Cli-and-hold on the tab and drag the tab to a new place on the tab
bar. While you are dragging the tab, Firefox will display a small indicator to
show where the tab will be moved.

When moving a tab to a new window it
may reload the page. remember to save your
work before doing this.

Moving a tab between windows

If you have more than one Firefox window open, you can move an open tab to
a different window. You can also split a tab off to become its own window.

To move a tab from one Firefox window to another already open window,
cli-and-hold on the tab and drag it to the tab bar on the other Firefox win-
dow. When you release the mouse buon, the tab will be aaed to the new
window.

To move a tab from one window into its own window, cli-and-hold
on the tab and drag the tab below the tab bar. When you release the mouse
buon, the tab will become a new window.

Searching

You can sear the web, or other collections, from within Firefox without first
visiting the home page of the sear engine.

By default, Firefox will sear the web using the Google sear engine.



   

Searching the web

To sear the web in Firefox, type a few words into the Firefox sear Bar.
For example, if you want to find information about the Ubuntu:

. Cli on the Sear Bar.
. Type the phrase “Ubuntu.” Your typing replaces any text currently in the

Sear Bar.
. Press Enter to sear.

Sear results from Google for “Ubuntu” should appear in the Firefox
window.

Selecting search engines

Figure .: These are the other search
engines you can use—by default—from the
Firefox search bar.

If you do not want to use Google as your sear engine in the Sear Bar,
you can ange the sear engine that Firefox uses.

The Ubuntu home page’s search bar uses
Google by default, but will automatically
use Yahoo if Yahoo is selected in the Search
Bar.

To ange the sear engine, cli on the icon on the le side of the Sear
Bar. Choose one of the other sear engines in the list. Some sear engines,
like Google, sear the whole web; others, like Amazon.com, only sear
specific sites.

Searching the web for words selected in a web page

Sometimes, you may want to sear for a phrase that appears on a different
web page. Instead of copying and pasting the phrase into the Sear Bar,
Firefox allows you to sear the web for words you select within a web page.

. Highlight any words in a web page using your le mouse buon.
. Right-cli on the text you’ve highlighted to open a popup menu. Choose

the option Sear [Sear Engine] for “[your selected words]”.
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Firefox should open a new tab containing sear results for your high-
lighted words, found using the currently selected sear engine.

Searching within a page

Figure .: You can search within web
pages using the Find Toolbar.You may want to look for specific text within the web page you are view-

ing. To find text within the current page in Firefox:

. Press Ctrl+F or oose Edit ‣ Find to open the Find Toolbar at the boom
of Firefox.

. Enter the text you want to find into the Find field in the Find Toolbar. e
sear automatically begins as soon as you type something into the field.

. Once some text has been mated on the web page, you can:

‣ Cli Next to find text in the page that is below the current cursor
position.

‣ Cli Previous to find text that is above the current cursor position.
‣ Cli on the Highlight all buon to highlight occurrences of your
sear words in the current page.

‣ Select theMat case option to limit the sear to text that has the
same capitalization as your sear words.

To find the same word or phrase again, press F3 or oose Edit ‣ Find
Again from the menubar.

Viewing web pages full screen

To display more web content on the screen, you can use Full Screen mode.
Full Screen mode condenses the Firefox’s toolbars into one small toolbar. To
enable Full Screen mode, simply oose View ‣ Full Screen or press F11.

Copying and saving pages

With Firefox, you can copy part of a page so that you can paste it elsewhere,
or save the page or part of a page as a file on your computer.



   

Copying part of a page

To copy text from a page:

. Highlight the text and/or images with your mouse.
. Choose Edit ‣Copy from the menubar or press Ctrl+C.

You can paste the text into other programs.
To copy a text or image link () from a page:

. Position the pointer over the link or image.
. Right-cli on the link or image to open a popup menu.
. Choose Copy Link Location.

You can paste the link into other programs or into Firefox’s Location Bar.

Saving all or part of a page

To save an entire page in Firefox:

. Choose File ‣ Save Page As from the menubar. Firefox should open the
“Save As” window.

. Choose a location for the saved page.
. Type a file name for the page, and cli Save.

To save an image from a page:

. Position the mouse pointer over the image.
. Right-cli on the image to display a popup menu.
. Choose Save Image As. Firefox should open the “Save Image” window.
. Choose a location for the saved image.
. Enter a file name for the image and cli Save.

Changing your homepage

By default, Firefox will show the Ubuntu Start Page when you start Firefox.
If you prefer to view another page when you start Firefox, you will need to
ange your homepage preference.

The homepage can also be set by entering
the addresses that should be open in the
Home Page, with a pipe—|—separating
pages to be opened in a new tab

To ange your homepage:

. Navigate to the page that you would like to become your new homepage.
. Choose Edit ‣ Preferences from the menubar.
. In the “Startup” section on the General tab, whi is shown by default,

cli on the Use Current Page buon. If you had more than one tab open
then all the tabs will be opened when Firefox starts. If you prefer to have
one page open, close the other tabs and repeat Steps -.

. Cli Close.



     .

Figure .: You can change Firefox seings
in this window.

Download seings

The Downloads window shows the progress
of currently downloading files, and lists files
downloaded in the past. It can be used to
open or re-download files.

In Edit ‣ Preferences you can ange how Firefox behaves with down-
loads. You can tell Firefox where to place downloaded files, or to ask where
ea time. You can also set the behavior of Firefox’s Downloads window. e
Downloads window can be hidden entirely, or set to hide when downloads
finish.

Bookmarks

When browsing the web you may want to come ba to certain web pages
again without having to remember the .

In Firefox, you can create bookmarks, whi are saved in the web browser
and whi you can use to navigate ba to your pied web pages.

Bookmarking a page

Aer navigating to a web page you can save its location by bookmarking it.
ere are two ways to bookmark a page:

‣ From the menubar, oose Bookmarks and then Bookmark is Page. A
window will open. Provide a descriptive name for the bookmark, and cli
on the Done buon.



   

‣ Press Ctrl+D. A pop-up will appear. Provide a descriptive name for the
bookmark, and cli on the Done buon.

Navigating to a bookmarked page

To navigate to a bookmarked page, open the Bookmarks menu from the
menubar, and then oose your bookmark’s name. Firefox should open the
bookmark in the current tab.

You can also press Ctrl+B to display bookmarks in a sidebar on the le side of
the browser window. Press Ctrl+B again to hide the sidebar.

Deleting a bookmark

If you would like to delete a bookmark that you have previously made, open
the Bookmarks menu from the menubar, and then right-cli on your book-
mark’s name. Firefox should open a popup menu for your bookmark. Choose
the Delete option from the menu. Your bookmark should then be deleted.

History

Whenever you are browsing the web, Firefox is saving your browsing history.
is allows you to come ba to a web page that you have recently visited,
without needing to remember the page’s , or even bookmarking it.

To see your most recent history, open the History menu from the menubar.
e menu should then display several of the most recent web pages that you
were viewing. Choose one of the pages to return to it.

To see the web pages you have visited recently, press Ctrl+H. Firefox will
open a “sidebar” on the le side of the browser window, that contains your
browsing history, categorized as “Today,” “Yesterday,” “Last  days,” “is
month,” the past  months (listed month by month), and finally “Older than 
months.”

Cli on one of the date categories in the sidebar to expand it. en it will
reveal the pages you visited during that period. en, once you find the page
you need, cli on its title to return to it.

You can also sear for a page by its title. Enter a few leers, or a word,
in the Sear field at the top of the history sidebar. e sidebar should then
display a list of web pages whose titles mat your sear words. Cli on the
title of the page you need to return to it.

If you would like to hide the history sidebar again, press Ctrl+H again.

Clearing private data

At times, you may want to delete all private data that Firefox stores about
your browsing history. While this data is stored only on your computer, you
may want to remove it if you share access to your computer.
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To delete your private data, open the Tools menu from the menubar, and
oose Clear Recent History. In the drop down list for the Time range to
clear, oose how far ba you would like Firefox to delete.

If you would like more control over what you clear, cli on the Details
text to display a list of options.

When done, cli on the Clear Now buon.

Using a different web browser

Figure .: You can change the default
browser with the ”Preferred Applica-
tions” utility. To use it, open the System ‣
Preferences ‣Preferred Applications.

If you install a different web browser on your computer, you may want
to use it as the default browser when you cli on links from emails, instant
messages, and other places.

To ange your preferred web browser, open the System menu from
Ubuntu’s main menubar. en, oose System ‣ Preferences ‣ Preferred Appli-
cations. Ubuntu should then open the “Preferred Applications” window.

In the “Web Browser” section, oose your new preferred web browser, and
cli Close.

Reading and composing email

To send and receive email in Ubuntu, you can use the Evolution mail applica-
tion. To start Evolution, open the Applications menu, then oose Office and
then Evolution Mail and Calendar.

In addition to email, Evolution also can help manage your contact list, your
calendar, and a list of tasks.

Although Evolution can be used with many webmail systems, su as Yahoo!
Mail, Hotmail, and Gmail, you may prefer to use the Firefox web browser to
access them.



   

Running Evolution for the first time

When you start Evolution for the first time, you will need to configure it to
connect to your email account.

When Evolution starts, you should see the “Evolution Setup Assistant”
window, welcoming you to Evolution. Cli Forward to continue with the
setup.

Next, on the “Restore from baup” screen, Evolution may ask you to
restore from a previous baup. Since this is the first time you are running
Evolution, you can cli Forward to skip this step.

On the next screen, “Identity”, you need to enter your name and the email
address you wish to use with Evolution. Enter your full name in the Full
Name field, and the full email address in the Email Address field. You can
fill in the optional information, or leave it unanged if you desire. Cli
Forward when you are done.

Next, you should see the “Receiving Email” screen. On this screen, you
need to provide Evolution with the details of your email servers. If you do not
know these details, you will need to ask your network administrator or e
with your email provider.

ere are two common types of Internet email connections: , and
. ese are described below. In work environments there are sometimes
other types, su as Microso Exange or Novell GroupWise—for more
information on those types of connections, please see the documentation for
Evolution located in the Help ‣Contents menu.

Seing up an IMAP connection

 connections allow you to manage your email remotely—the actual email
and folders reside on your email server, while Evolution allows you to view,
edit, and delete the messages and folders as needed.

If your email provider recommends an  connection, oose IMAP
from the Server Type drop-down list. In the Server field, enter the Internet
address or  of your mail server. for example imap.example.com. In the
Username field; enter the username that you use to log into your email sys-
tem, for example joe.x.user or joe.x.user@example.com, as specified by
your email provider.

Your email provider may specify the security seings you will need to use
in order to receive email. If your connection does not use security, leave the
Use Secure Connection drop-down list set to No encryption. Otherwise,
oose either  encryption or  encryption, as specified by your email
provider.

Aer oosing these options, cli Forward to proceed to the “Receiv-
ing Options” screen. While it is normal to leave all options unselected, you
may want to select the Che for new messages option to have Evolution
automatically e email on a regular basis.
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When you are finished seing the options, cli Forward to continue to
the next screen.

Seing up a POP connection

 connections let you manage your email locally—Evolution will connect to
your email provider and download any new messages you may have received,
and store them in folders on your computer. e messages will be deleted
from the server.

If your email provider recommends a  connection, oose POP from
the Server Type drop-down list. In the Server field, enter the Internet address
or  of your mail server; for example pop.example.com. In the Username
field, enter the username that you use to log into your email system, for
example joe.x.user, or joe.x.user@example.com.

Your email provider may specify the security seings you will need to use
in order to receive email. If your connection does not use security, leave the
Use Secure Connection drop-down list set to No encryption. Otherwise,
oose either  encryption or  encryption, as specified by your email
provider.

Aer oosing these options, cli Forward to proceed to “Receiving Op-
tions” screen. While it is normal to leave all options unselected, you may
want to select the Che for new messages option to have Evolution auto-
matically e email on a regular basis.

You may also wish to adjust the Message Storage options, whi determine
what Evolution does aer downloading email to your computer. Select the
Leave messages on server option to have Evolution keep the messages on
your email system aer downloading them. is will allow you to use another
computer to re-download all of your new messages. Select the Delete aer 
days option to have Evolution keep the messages for a few days, and delete
them aer a while. You can adjust the number of days that Evolution keeps
the messages.

When you are finished seing the options, cli Forward to continue to
the next screen.

Seing up your sending options

e next screen should be the “Sending Email” screen. Here, you will need to
configure your connection for sending email through your email provider.

e most common type of sending connection is , whi is the default
server type selected.

In the Server field, type in the name of the outbound mail server (also
known as the  server), as described by your email provider. For example,
mail.example.com.

If your email provider requires authentication, select the Server requires
authentication option. is is common for commercial email providers.



   

In the “Authentication” section of the screen, oose the type of authen-
tication from the Type drop-down list—the most common authentication
type is “.” Below that, enter your username, for example, joe.x.user, or
joe.x.user@example.com, in the Username field.

Your email provider may specify the security seings you will need to use
in order to send email. If your connection does not use security, leave the Use
Secure Connection drop-down list set to No encryption. Otherwise, oose
either  encryption or  encryption, as specified by your email provider.

Aer oosing these options, cli Forward to proceed to the next screen.

Finalizing your account options

On the next screen, “Account Management”, enter a descriptive name for this
account. If you set up more email accounts with Evolution the name provided
here will help distinguish those accounts.

When finished, cli Forward. is should open the “Done” screen. If you
believe that you’ve entered the correct options, cli Apply to finish setup.
Otherwise, cli Ba to go ba one or more screens to correct your seings,
or cli Cancel to abort setup and discard your account seings.

Aer you finish setup, Evolution may ask you if you would like to make it
your default email client. Cli Yes if you plan on reading and sending email
only with Evolution. Cli No if you plan on installing or using a different
email program.

Around the Evolution workspace

e Evolution window is divided into four parts. At the top are the menubar
and toolbar. e menubar lets you access most of the functionality of Evo-
lution, while the toolbar provides convenient shortcuts to some of the most
frequently used features.

On the le side of the window is the folder list. Every message that you
send or receive will reside in one of the folders in this list.

Below the folder list on the le side of the window are theMail, Contacts,
Calendars, Tasks, andMemos buons. When working with email, theMail
buon is selected. e other buons take you to those other parts of Evolu-
tion.

On the right side of the window are the message list, and the message
preview beneath it. e message list shows all of the messages in the currently
selected folder, or mating your sear request. If a message is selected in
this list, its contents are shown in the message preview pane below.

Understanding the folder list

e folder list is the way that Evolution separates and categorizes your email.
e first group of folders in the list is titled “On is Computer.” ese are
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Figure .: Evolution allows you to manage
your mail, contacts and tasks.

your local folders—they reside on your computer only. If you use  servers
to retrieve your email, any new message will be placed in the Inbox local
folder.

You can cli on any folder to see its contents appear in the message list on
the right side of the window.

Ea of the initial folders in the list is special:

‣ Inbox stores your incoming messages.
‣ Dras stores messages that you’ve worked on, but have not yet sent.
‣ Junk stores messages that have been identified as unsolicited email that
you did not want. Junk mail is also known as “spam.”

‣ Outbox contains messages that you’ve finished composing, but whi
have not been sent yet. For example, if you are in an airplane or another
location without an Internet connection, you can still cli the Send buon
once you’ve finished writing an email. e message will be moved to the
Outbox, and will remain there until the next time you are able to send
and receive messages. Once you can send and receive messages, all email
messages in the Outbox will be sent out.



   

‣ Sent contains copies of messages that have been sent successfully. Once a
message from an Outbox is sent, it is copied to the Sent folder.

‣ Templates stores any email message templates you have saved. A template
is a partial message, for example, a blank invoice, that can be used as the
starting point for other messages.

‣ Trash contains messages that you have deleted. By default, the trash will
be emptied every time you exit Evolution.

If a folder contains any unread messages, the folder’s name will be dis-
played in bold, and the number of unread messages will be displayed in
parentheses following the folder name.

If you use an  server to retrieve your email, then your remote 
folders will also be shown in the folder list, below the “On is Computer”
section. e heading for ea folder list uses the name you gave to that ac-
count. Ea -enabled account has its own Inbox for new messages.

Towards the boom of the folder list, Evolution will show a list of “Sear
Folders.” ese are special folders that represent certain messages that mat
sear rules. Please see the section on Finding Messages for more on sear
folders.

Managing folders

In addition to the initial folders, you can create your own folders to manage
your email.

To create a new folder, open the Folder menu, and then oose New. Enter
a name for the folder that you would like to create. en, from the list of
folders below, select the parent folder. For example, if you would like your
new folder to be placed under the Inbox then select the Inbox folder. If you
select “On is Computer,” then your new folder will be placed under “On
is Computer” in the folder list.

Once you’ve made your selection, cli on the Create buon to create the
folder. Your new folder should now be in the folder list.

You can move folders that you have created. To do so, cli on the folder
that you would like to move, hold down the mouse buon, and drag the folder
to a new parent folder. Once the mouse cursor highlights a new parent folder,
release the mouse buon to finish the move.

You can also right-cli on a folder, and oose theMove… option. en,
select the new parent folder, and cli on theMove buon.

To delete a folder, right-cli on the folder and oose the Delete option.
To confirm that you want to delete the folder, cli on the Delete buon.
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Checking and reading messages

Checking mail

When you finish setup, or when you start Evolution in the future, Evolution
will first try to connect to your email provider to e your email. In order to
connect, Evolution will need to know your email account password, and will
ask you for it.

Figure .: You need to enter your pass-
word to authenticate your account.

In the “Enter Password” window, enter your password and cli OK. If you
wish for Evolution to remember this password and not ask you in the future,
you can select the Remember this password option.

Evolution will then show a “Send & Receive Mail” window, showing the
progress of the operation su as how many messages are being retrieved.

Listing messages

e top right portion of the Evolution window is the message list. Here, you
can see email messages for your currently selected folder, or mating your
sear terms.

By default, the message list shows six columns of information for ea
message. e first column is a read/unread indicator. If a message has been
read, the column shows an icon of an open envelope. If a message has not
been read, the icon will show a closed envelope.

e second column is an aament indicator. If a message contains an
aaed file, Evolution will show an icon of a paperclip in this column. Oth-
erwise, the column will be blank.

e third column is an importance indicator. If someone sends you a
message marked with high importance, Evolution will show an exclamation
mark in this column. Otherwise, this column will be blank.

e fourth column contains the sender of the message. Both the name and
email, or just the email address, may be displayed in this column.

e fih column contains the subject of the email message.
Finally, the sixth column is the date that the email was sent.
When you cli on a message, its contents will be displayed in the preview

pane below the message list. Once you select a message by cliing it, you can



   

cli on the Reply buon in the toolbar to begin composing a reply message
to be sent to the sender, or cli on the Reply to All buon to begin com-
posing a reply message to be sent to the sender and other recipients of your
selected message.

You can also cli on the Trash buon in the toolbar to put the message
in the Trash folder, or on the Junk buon to move the message into the Junk
folder. Note that Evolution, or your mail server, may automatically classify
some mail as Junk.

In addition to the buons on the toolbar, you can right-cli on a message
in the list. Evolution will open a menu with actions that you can perform for
the message.

Sometimes, you may wish to take an action on multiple email messages
(for example, delete multiple messages, or forward them to a new recipient).
To do this in Evolution, press-and-hold the Ctrl key while cliing on multi-
ple messages—the messages you cli on will be selected. You can also cli
on one message to select it, then press-and-hold the Shift key and cli on
another message in the list. All messages in the list between the original selec-
tion and the one you just clied on will be selected. Once you have multiple
messages selected, right-cli on one of them to perform your desired action.

Directly above the message list are the Show drop-down list, and the
sear options. You can use the Show drop-down list to filter your view to
show only unread messages, or only messages with aaments, etc.

e sear options will be covered in a later section.

Previewing messages

When you select an email message, its contents will be shown in the preview
pane below the message list.

e top of the preview pane will show the message header, whi contains
the sender, recipients, and subject of the message, as well as the date the
message was sent. Below the header, Evolution shows the contents of the
message itself.

If a message was sent with  formaing, some of the images may not Note that loading images may provide a
way for the sender to track your receipt of
the message. We do not recommend loading
images in messages that you suspect are
Junk.

be displayed when a message is previewed. To display the missing images,
open the View menu from the menubar, then Load Images, or press Ctrl+I.
If your Internet connection is active, the missing images should then load.

Opening messages

At times, you may want to display multiple messages at the same time. To do
so, you can open ea message in a separate window instead of just viewing it
in the preview pane.

To open a message in its own window, double cli a message in the mes-
sage list. e message should then open in a separate window. You can go
ba to the message list and open another message, if needed.
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In the open message window, you can use the options in the menubar or on
the toolbar to reply to the message, categorize it, delete it, as well as perform
other message actions.

Finding messages

ere are three ways to sear for messages in Evolution: you can use the
sear option at the top of the message list, use the Advanced Sear function,
or create a sear folder.

To use message list sear, enter the text you want to find in the Sear
field at the top right of the message list, and press Enter. e list of messages
will ange to show only those messages containing the text you entered.

To the right of the sear field you should be able to see a drop-down list
of options su as “Current Folder,” “Current Account,” and “All Accounts.”
By default, Evolution will use the “Current Folder” option and will only
show you results within the folder you’ve got selected in the folder list on
your le. If you oose the “Current Account” option, Evolution will sear
for messages in all folders within the current email account—su as all the
folders “On is Computer” or in your  folders, depending on your email
setup. If you have multiple email accounts added to Evolution, oosing the
“All Accounts” option lets you sear for messages in all of your accounts.

If no messages mat the text you’ve entered, you can edit the text and
try searing again. To return to the folder display, open the Sear menu
from the menubar and then oose Clear, or instead erase all the text you’ve
entered in the Sear field and press Enter.

In some cases, you may want to sear for messages using multiple criteria.
For example, you may want to find a message from a particular user with
some specific words in the subject of the message. In Evolution, you can
perform this sear using the Advanced Sear function.

Figure .: To use more search terms you
can use the advanced search window.To use Advanced Sear, oose Sear ‣Advanced Sear. Evolution

should open the “Advanced Sear” window. In the middle section of the



   

window, specify your sear criteria. For our example, to find messages from
myfriend@example.com that contained “boat” in the subject, you would enter
myfriend@example.com in the text field to the right of the drop-down list with
“Sender” selected, and would enter boat in the text field to the right of the
drop-down list with “Subject” selected. en, cli on Remove to the right of
all lines that are unused, and cli OK to perform the sear. e message list
should then only display messages that mat your advanced sear criteria.

When specifying the criteria for advanced sear, you can cli on the Add
Condition buon to add additional lines. You can also ange the selection
in the drop-down list at the beginning of ea line to specify a different field
to be eed, or ange the drop-down with “contains” selected by default
in order to have a different type of a mat. Please refer to the Evolution help
documents for more information.

In some cases, you may want to perform the same sear request on a reg-
ular basis. For example, you may want to always be able to see all messages
from myfriend@example.com regardless of whi folder you’ve used to store
the message. To help with this type of a sear, Evolution allows you to create
Sear Folders.

To create a sear folder, oose Sear ‣Create Sear Folder From
Sear from the menubar. Give the folder a name by entering it in the Rule
name field at the top. en, specify sear criteria in the same way as in
Advanced Sear. Below the criteria, pi whi folders should be seared by
this sear folder—for example, you can oose “All local and active remote
folders” to sear in all of your account’s folders. When you are finished, cli
OK.

e new sear folder should now be added to the list of sear folders
towards the boom of the message list. If you cli on the sear folder to
select it, you should be able to see a list of messages that mat your sear
criteria.

Subscribing to IMAP folders

If you use  to retrieve your email, you should see a set of folders in the
folder list on the le side of the window that is titled with the name of your
 account. Folders like Inbox, Dras, Junk and others should be displayed
in the folder list.

If you have other folders in your  account, you will need to subscribe
to them. If you subscribe to a folder, Evolution will download messages for
that folder whenever you e your email.

To subscribe to a folder select Folder ‣ Subscriptions from the menubar.
Evolution should open the “Folder Subscriptions” window. From the Server
drop-down list oose your account name. Evolution should then show a list
of folders in the list below.

Choose the folders you would like to subscribe to by selecting the e
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box to the le of the folder name. When you are finished, cli Close. e
folders will be updated the next time you e your email.

Composing and replying to messages

In addition to reading email, you will likely want to reply to the email you
read, or compose new messages.

Composing new messages

To compose a new message, cli on the New buon on the toolbar. Evolution
should open a “Compose message” window.

In the To: field, enter the email address of the destination—the contact to
whom you are sending this email. If there is more than one contact to whom
you are writing, separate multiple recipients with commas.

If a contact that you are addressing is in your address book, you can ad-
dress them by name. Start typing the name of the contact; Evolution will
display the list of mating contacts below your text. Once you see the con-
tact you intend to address, cli on their email address or use the down arrow

key and then Enter to select the address.
If you would like to carbon-copy some contacts, enter their email addresses

in the Cc: field in the same manner as the To: recipients. Contacts on the To:
and Cc: lines will receive the email, and will see the rest of the contacts to
whom an email was sent.

If you would like to send an email to some contacts without disclosing
to whom your email was sent, you can send a blind carbon-copy, or Bcc. To
enable Bcc, select View ‣Bcc Field from the menubar. A Bcc: field should
appear below the Cc: field. Any contacts entered in the Bcc: field will re-
ceive the message, but none of the recipients will see the names or emails of
contacts on the Bcc: line.

Instead of typing the email addresses, or names, of the contacts you are
addressing in the message, you can also select the contacts from your address
book. To do so, cli on the To:, Cc: or Bcc: buons to the le of the text
fields. Evolution should open the “Select Contacts from Address Book” win-
dow. Use the list on the le side of the window to select your contact, or type
a few leers from your contact’s first or last name in the Sear field to filter
the list to only show mating contacts.

Once you identify the contact you would like to address, cli on their
name in the list. en, cli on the Add buon to the le of either the To:,
Cc:, or Bcc: fields located on the right of the screen. Your selected contact will
be added to that list. If you’ve added the contact in error, cli their name in
the list on the right, and cli on the Remove buon. When you are finished
piing contacts, cli Close to return to the composing screen.

Enter a subject for your email. Messages should have a subject to help the



   

recipient to identify the email while glancing at their message list; if you do
not include a subject, Evolution will warn you about this.

Enter the contents of your message in the big text field below the subject.
ere is no practical limit on the amount of text you can include in your
message.

By default, new messages will be sent in “Plain Text” mode. is means
that no formaing or graphics will be shown to the recipient, but the message
is least likely to be rejected or displayed illegibly to the recipients. If you
know that your recipient uses a contemporary computer and a modern email
program, you can send them messages that include formaing. To swit to
this mode, cli the drop-down list buon on the le side directly above the
text field for the message contents. Change the selection from “Plain Text”
to “” to enable advanced formaing. When using  mode, a new
toolbar should appear right under the mode selection that will allow you to
perform advanced font styling and message formaing.

When you have finished composing your email, cli on the Send buon
on the window’s toolbar. Your message will be placed in the Outbox, and will
be sent when you next e your email.

Aaching files

At times, you may want to send files to your contacts. To send files, you will
need to aa them to your email message.

To aa a file to an email you are composing, cli on the Add Atta-
ment buon at the boom right of the email message window. Evolution
should show the “Add aament” window.

Select the file you would like to include in your message and cli on the
Atta buon. Evolution will return you to the email message window, and
your selected file should be listed in a section below the Add Attament
buon.

Replying to messages

In addition to composing new messages, you may want to reply to messages
that you receive.

ere are three types of email replies:

‣ Reply (or “Reply to Sender”)—sends your reply only to the sender of the
message to whi you are replying.

‣ Reply to All—sends your reply to the sender of the message, as well as
anyone else on the To or Cc lines.

‣ Forward—allows you to send the message, with any additional comments
you may add, to some other contacts.

To use any of these methods, cli on the message to whi you want
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to reply and then cli the Reply, Reply to All, or Forward buon on the
toolbar.

Evolution should open the reply window. is window should look mu
like the window for composing new messages, but the To, Cc, Subject, and
main message content fields should be filled in from the message to whi you
are replying. Ea line in the message should be prefixed with a “>” aracter.

Edit the To, Cc, Bcc, Subject or main body as you see fit. When your reply
is finished, cli on the Send buon on the toolbar. Your message will be
placed in the Outbox, and will be sent when you next e your email.

Using signatures

In order to give your messages a footer, Evolution allows you to use a “signa-
ture.” Signatures in email are a bit of standard text that is added to the boom
of any new messages or replies.

When composing of replying to a message, cli on the Signature drop-
down list below the toolbar just above the To: field. is list should contain
any signatures that you have created, as well as an “Autogenerated” signature.
If you select Autogenerated, Evolution will add two dashes, and then your
name and email address to the boom of the email message.

You can also specify some custom signatures. To create a signature, open
the “Evolution Preferences” window by selecting Edit ‣ Preferences from
the menubar. On the le side of the Evolution Preferences window, select
Composer Preferences and then select the Signatures tab.

Cli on the Add to add a new signature. Evolution should then open
the “Edit Signature” window. Give your signature a name, and enter the
contents of your signature in the big text field below. When finished, cli Note that the two dashes are added auto-

matically by Ubuntu, so there is no need to
include them in your custom signature.

on the Save buon on the toolbar (the buon’s icon looks like a floppy disk).
Your new signature’s name should appear in the list in preferences. Close the
preferences window.

Your signature should now show up in the drop-down list in the com-
pose/reply window.

Staying organized

e Evolution application in Ubuntu can let you keep and manage a list of
your contacts, maintain a calendar, and a task list.

If you have already set up Evolution with an email account, you do not
need to do any further setup to use these features. If you do not wish to
use Evolution for email, you can still use it for managing your contacts or
maintaining a sedule, as well as keep tra of tasks and memos that you can
create for yourself.

To start Evolution, open the Applications menu, then oose Office and
then Evolution Mail and Calendar.



   

Managing your contacts

Figure .: You can view, edit, and add
contacts.If you would like to keep a list of your contacts—personal or professional

contact information for people and organizations—you can manage these
contacts in Evolution.

To view contacts, cli on the Contacts buon below the folder list on
the le side of the Evolution window. e folder list on the le will be re-
placed by a list of address book types. Cli on an address book, for example
“Personal.”

e right side of the window will display a list of contacts. Cli a contact An address book is a collection of contacts
and contact lists. It can either be stored on
your computer, or on a remote server.

to show the contact’s details in the lower portion of the right side of the
window.

If you use Ubuntu One, you may have two address books—a “Personal” Ubuntu One is a free service you can use
to sync and store contacts, as well as other
information. For more information on
Ubuntu One see the dedicated section later
in this chapter.

address book stored on your computer, and an “Ubuntu One” address book.
You can add contacts to either address book, though only the “Ubuntu One”
address book is synronized to your Ubuntu One account.
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Searching for contacts

To find a contact, type in a few a few leers from the contact’s first or last
name in the sear text box on the upper right of the window, and press
Enter. e list below should ange to only show contacts whose name
mates your sear term.

Adding or editing a contact

To make anges to an existing contact, find the contact in the list and double-
cli on the entry. Evolution should open a “Contact Editor” window for the
contact.

Swit between the different tabs in the contact editor to make anges to
the contact. Cli OK when you have finished making your anges.

To add a new contact, cli on the New on the toolbar. Evolution should
open the “Contact Editor” window. Enter the contact’s details in the contact
editor window, and cli OK when finished.

Managing your schedule

If you like to manage your sedule with a computer, you can maintain this
sedule in Ubuntu using Evolution.

To view your calendar, cli on the Calendars buon below the folder
list on the le side of the Evolution window. e folder list on the le will
be replaced by a list of calendars, and a mini-calendar showing the current
month.

Evolution allows you to manage more than one calendar. For example, you
could have a personal calendar and a sool or work calendar. You can also
subscribe to the calendar of a friend or family member who may oose to
share their calendar with you.

Cli on one of the calendars in the list. By default, you should have a
“Personal” calendar in the list. e middle of the window should now show a
view of the current day, showing all the hours of the current day.

If the calendar already has some events, Evolution will show the event in
the day view between the hours when the event starts and finishes. You can
double-cli on the event to open its details, or drag the event to a different
time or date to resedule it.

In the day view, you can cli on a different day on the mini-calendar on
the le side of the screen. Evolution will then display that day in the day
view.

You may also wish to see more than one day at a time. is will allow you
to compare sedules on different days, or find a free day for an event you
wish to sedule. In Evolution, you can cli on theWork Week orWeek
buons on the toolbar to see an entire week at the same time. Cli on the
Month buon on the toolbar to see a view of the entire month—if an event



   

is difficult to read due to the small space alloed to ea day, you can hover
your mouse over the event to have Evolution show the full title of the event.
Finally, the List buon on the toolbar shows upcoming appointments in a list,
allowing you to see all of your upcoming appointments at a glance.

On the right side of the window, Evolution displays a list of tasks and
memos. You can add a new task or memo to Evolution

Adding a new event

e simplest way to add a new task is to cli a time in the day view, and
begin typing. An event “bubble” will appear, containing the text that you are
typing. If you want to add a longer event, drag your mouse from the first time
slot to the last before starting to type.

Figure .: You can stay organized by
adding events to your calendar.To add a new event without using the day view, cli on the New buon

on the toolbar. Evolution should open the “Appointment” window. In the
Summary field, enter a short title for the event as you want it to appear on
the calendar. Optionally specify the location and enter a longer description if
you would like. Make sure that the time and date, as well as the duration, are
as you want them. Finally, cli on the Save buon on the toolbar to save this
new event (the buon looks like a hard drive, and is the first buon on the
toolbar).

Scheduling a meeting

If you would like to sedule a meeting with one of your contacts, Evolution
can assist you in sending out an invitation and processing replies.

To create a meeting invitation, oose File ‣New ‣Meeting from the
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menubar. Specify the subject, location, time and duration, and description as
when you create a regular event.

You will then need to add aendees to this meeting. To add an aendee,
cli on the Add buon. In the list of aendees, Evolution will add a new row
—type the aendee’s email address or contact name.

When you are finished adding aendees, cli on the Save buon on the
toolbar. Evolution should then ask you if you would like to send meeting invi-
tations to your selected participants. Cli Send to send out these invitations.
e invitations will be sent the next time you e email in Evolution.

If your contact ooses to reply to the meeting invitation, Evolution will
show you a new email message. In the body of the email message, Evolution
will display an Update Attendee Status buon. Cli on that buon to mark
your contact as aending the meeting.

Using instant messaging

Instant messaging allows you to communicate with people you know in real
time. Ubuntu includes the Empathy application that lets you use instant
messaging features to keep in tou with your contacts. To start Empathy,
open the Applications menu from the menubar, then oose Internet and
then Empathy IM Client.

Empathy lets you connect to many instant messaging networks. You can
connect to , Gadu-Gadu, Google Talk, Groupwise, , Jabber, , MyS-
pace, QQ, , Sametime, Silc, , Yahoo, or Zephyr.

Running Empathy for the first time

When you open Empathy for the first time you will need to configure it with
the details of your instant messaging accounts.

When Empathy starts you will see the “Welcome to Empathy” window.
Choose the option corresponding to your situation.

You have an account

If you have an account that you have used previously with another instant
messaging program then select the Yes, I’ll enter my account details now
option. en, cli Forward to continue.

On the next screen, oose your account type from the drop-down list
belowWhat kind of at account do you have?. en, enter your account
details in the field below.

Depending on the account type that you oose, Empathy may request that
you enter a username, or an  for your account, followed by a password.

If you do not remember your account information, you will need to visit
the website of the instant messaging network to retrieve that information.

If you have another account to add then select the Yes option, and cli



   

Figure .: Creating a new instant messen-
ger account in Empathy.

Forward to repeat the above process. When you have entered all the accounts
leave the No, that’s all for now option selected, and cli Apply to finish the
setup process.

Next, Empathy should display the “Please enter personal details” screen. If
you oose to fill out this information, you will be able to communicate with
people who are on your local network either at home or in an office.

Enter your first name in the First name field, and your last name in the
Last name field. Type in a way that you would like to be identified on your
local network in the Niname field. When you have filled all of the informa-
tion, cli Apply.

If you don’t want to communicate with people on your local network,
select the I don’t want to enable this feature for now option and cli
Apply.

You would like an account

If you don’t have an account that you can use, then you can create one by
selecting the No, I want a new account option. Cli Forward to display the
next set of options.

Choose the account type that you would like to create from the drop-down
list belowWhat kind of at account do you want to create? You can
create either a Jabber or a Google Talk account. Note: If you wish to create another account

type then you will need to visit the relevant
website and create the account. Then follow
the “You have an account” section.

Next, enter the account name that you would like in the text field, and in
the proceeding text field enter a password of your oice. If you would like
to set up another account then select the Yes option, and repeat the above
process.

When you have entered all the accounts leave the No, that’s all for now
option selected, and cli Forward.
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Empathy should display the “Please enter personal details” window. Pro-
viding this information allows you to communicate with people who are on
your local network either at home or in the workplace.

Enter your First name in the text field, and enter your Last name in the
next field. In the Niname field enter a niname by whi you would like
to be identified. When you have filled all of the text fields cli Apply to save
your seings.

If you don’t want to talk to people on your local network then select the I
don’t want to enable this feature for now option and cli Apply.

You want to talk to people nearby

If you would only like to communicate with people on your local network
either at home or in the workplace, then you should select the No, I just want
to see people online nearby for now option.

Cli Forward to display the next set of options. en enter your First
name in the text field, and enter your Last name in the next field. In the
Niname field enter a niname by whi you would like to be identified.
When you have filled all of the text fields, cli Forward.

Figure .: You can talk to people nearby
by entering your information.

Changing account seings

If you need to add more accounts aer the first laun, then open the Edit
menu, then oose Accounts. Empathy will then display the “Accounts”
window.



   

Adding an account

To add an account cli on the Add buon. Empathy should display some
options on the right hand side of the window. Choose your account type from
the Protocol drop-down list. Next, enter your account name in the first text
field. en enter your password in the Password text field. Finally cli on
the Log in buon to save and verify your seings.

Editing an account

You might need to edit an account if you ange the password or get the
password wrong. Select the account you want to ange on the le side of
the “Accounts” window. Empathy should show the current seings for the
account. Once you have made your anges, cli Save.

Removing an account

To remove an account select the account on the le hand side of the window
and cli on the Remove buon. Empathy should open the “Do you want to
remove” window. Cli on the Remove buon to confirm that you want to
remove the account, or cli Cancel to keep the account.

Editing contacts

Adding a contact

To add a contact open the Chat menu, then oose Add contact. Empathy
should open the “New Contact” window.

In the Account drop-down list oose the account that you want to add
the contact to. When creating a contact you must select a service that mates
the service you contact is using.

For example if your contact’s address ends in “@googlemail.com” then you
will need to add it to an account that ends in “@googlemail.com.” Likewise if
the contact’s email ends in “@hotmail.com” then you would need to add it to
an account ending in “@hotmail.com.”

Aer oosing the account you wish to add the contact to, you will need to
enter their login , their username, their screen name or their email address
in the Identifier text field.

en, in the Alias text field, enter the name that you would like to see it in
your contact list. Cli Add to add the contact to your list of contacts.

Removing a contact

Cli on the contact that you want to remove and then open the Edit menu,
then oose Contact, then Remove. is will open the “Remove contact”
window.
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Cli on the Remove buon to confirm that you want to remove a contact,
or cli Cancel to keep the contact.

Communicating with contacts

Text

To communicate with a contact, select the contact in Empathy’s main window
and double-cli their name. Empathy should open a new window where you
can type messages to your contact, and see a record of previously exanged
messages.

To send a message to the contact, type your message in the text field below
the conversation history.

When you have typed your message press the Enter key to send the mes-
sage to your contact. If you are communicating with more than one person
then all of the conversations will be shown in tabs within the same window.

Audio

If your contact has audio capabilities then there will be an icon of a micro-
phone next to their name. Cli on the microphone icon to open a popup
menu. Choose the Audio call option from the menu. Empathy should then
open the “Call” window.

is window shows your picture on the right and your contact’s picture
on the le. Ensure that your microphone and speakers are connected, and
proceed with the audio conversation. You can finish the conversation by
cliing on the Hang up buon.

Video

If your contact has video at capabilities then there will be an icon of a
webcam next to their name. Cli on the icon to open a popup menu. Choose
the Video call option from the menu. Empathy should then open the “Call”
window.

is window shows your webcam view in the top right and your contact’s
webcam will be in the middle.

If you don’t have a webcam then your picture will be shown instead. You
can finish the call by cliing on the Hang up buon.

Sending and receiving files

Sending a file

When you are in a conversation with a contact and you would like to send
them a file, open the Contact menu and then oose Send file.

Empathy should open the “Select file” window. Find the file that you wish



   

to send and cli on the Send buon. A “File Transfers” window will open
showing the osen file and its transfer progress.

When the file transfer is complete, you can close the “File Transfers” win-
dow.

Receiving a file

When a contact wants to send you a file, the status icon to the le of the
contact’s name will flash with an icon of a paper plane.

To receive the file double-cli the contact’s name. Empathy will open
the “Select a destination” window. Choose a location where you would like
Empathy to save the file, and cli Save. Empathy should open the “File
Transfers” window.

e “File Transfers” window shows you the progress of current file trans-
fers. You can stop file transfers by cliing on the Stop buon, open trans-
ferred files by cliing on the Open buon, and clear the list of completed
transfers by cliing on the Clear buon.

Changing your status

You can use your status to show your contacts how busy you are or what you
are doing. You can use the standard statuses, whi are “Available,” “Busy,”
“Away,” “Invisible,” and “Off-line.” ese can be anged in the main Empathy
window from the drop-down list at the top of the window.

e same drop-down list lets you set a custom status by oosing “Custom
Message…” next to the icon that mates your status. Type what you would
like your status to say, and cli on the green e mark.

Changing your picture

Your picture is what your contacts will see next to your name in their contact
list. e default picture is the outline of a person. You can ange your picture
by opening the Edit menu, then oosing Personal Information.

Empathy should open the “Personal Information” window. From the Ac-
count drop-down list oose the account that you want to ange, then cli
on the picture on the right hand side of the window.

Empathy should open the “Select Your Avatar Image” window. Find the file
containing your picture, and cli Open. If you would like to return it to the
default avatar, cli on the No Image buon instead.

Microblogging

You can connect several microblogging services by opening the Applications
menu, then oosing Internet and then Gwibber Social Client. Until you add
accounts, the “Social Accounts” window will open.
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Aer you have added accounts you will see the “Social broadcast mes-
sages” window.

In this window in the Add new drop-down list you can oose the from
Flir, Twier, StatusNet, Qaiku, Facebook, FriendFeed, Digg, and Identi.ca.

Figure .: Gwibber lets you add many
different account types.

MeMenu

If you cli your name in the top panel, you will see the “MeMenu,” in the box
below your name you can type a message to post on the sites that you have
set up with Gwibber.

You can also ange your account seings by cliing Broadcast Ac-
counts…, this opens the “Broadcast Accounts” window.

Changing accounts

To add more accounts aer you have already added some. Cli Edit then
Accounts, the “Social Accounts” window will open.

Adding accounts

In the “Social Accounts” cli Add…, ea account will need you to enter your
account details. e details that you require for ea account is detailed as
follows.

Flir: To set up a Flir account all you need is the account login .
Twitter: Requires a user name and password.
StatusNet: A login , domain and password is needed.
Qaiku: You will need an  key, instructions for this are provided in the

Gwibber window. You will also need your login .
Facebook: Cli Authorize, then enter your email address and password

and cli Connect. If you want to be able to post on Facebook from Gwibber,
cli Allow publishing, otherwise cli Don’t allow.



   

If you want Gwibber to show your news feed, you will need to cli Al-
low access, otherwise cli Don’t allow. You will also need to allow status
updates—cli Allow status updates; if you don’t want Gwibber to be able to
update your status, cli Don’t allow.

In order for Gwibber to interact with Facebook ea time it is used, it will
need to have constant authorization. If not, you will have to authorize it ea
time you use it. To allow constant authorization cli Allow.

FriendFeed: A remote key is required for friend feed, Gwibber provides
information on where to get one from. You will also need a login .

Digg: A login  is all that is required for Digg.
Identi.ca: A login  and password is required for Identi.ca.

Removing accounts

In the “Broadcast Accounts” window cli the account that you want to re-
move and cli Remove.

How Gwibber displays accounts

Gwibber allows you to post to either all, one or a selection of accounts. is
can be set at the boom of the “Social broadcast message” window—ea of
the accounts that you can post with will have an icon. Cliing on an icon so
that it is disabled (appears gray) means that you will not post to that account.

Once you have decided on whi accounts you want to post to you can
type your message in the text field above the icons, then cli Send.

Ea one of your accounts will have a set of icons to go with it. ese icons
are displayed on the le hand size of the “Social broadcast message” window.
e set of icons that goes with an account has a baground color. Selecting
ea one of these icons allows you to do tasks for that specific account.

Viewing and editing photos

To view and edit photos in Ubuntu, you can use the F-Spot Photo Manager
application. To start F-Spot, open the Applications menu, then oose Graph-
ics, then F-Spot Photo Manager. When you start F-Spot for the first time,
you will see the “Import” window—how to use this is covered in ‘Importing’.

By default, F-Spot displays your photos by date. You can view photos from
a specific month by cliing on that month in the timeline near the top of the
window.

You can also play slide shows of your pictures by cliing on the Play
buon on the toolbar (this buon looks like a green triangle).

is guide oen refers to the side bar on the le. If you can’t see it, open
the View menu, then oose Components, and oose Sidebar—making sure
the option is selected.
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Figure .: F-Spot lets you store, tag, and
edit your photos.

Version system

When you edit a photo, F-Spot creates a new version so that the original is not
lost. You can create a new version by opening the Photo menu, then oosing
Create New Version…. is opens the “Create New Version” window. In the
Name text field you can type what you would like to call the version and then
cli OK. A new version will then be created.

You can view previous versions of photos by cliing on the photo that
you wish to view, then cliing on the Edit Image buon. is anges the
side bar on the le to the “Edit” side bar. In the boom le, the Version drop-
down list allows you to oose previous versions of the photo.

You might want to rename a version so that you remember whi version
is whi. To rename a version, cli on the photo that you want to ange,
then cli on the Edit Image buon. is anges the side bar on the le to
the “Edit” side bar. In the boom le the Version drop-down list lets you
oose the version of the photo that you want to rename.

Open the Photo menu, then oose Rename Version. is will open the
“Rename Version” window. Enter the new name in the New name text field,



   

then if you want to rename the version cli OK. If you don’t want to rename
the version, cli Cancel.

When editing photos, you may make a mistake and may decide to remove
that version as you no longer need it. To delete a version, cli on the photo
that you want to ange, then cli on the Edit Image buon. is anges
the side bar on the le to the “Edit” side bar. In the boom le the Version
drop-down list oose the version of the photo that you want to delete. en
open the Photo menu, then oose Delete Version. is will open the “Really
Delete?” window. If you want to delete the version cli Delete. If you don’t
want to delete the version, cli Cancel.

Importing

When you laun F-Spot for the first time you will see the “Import” window.
Aer the first laun you can import more photos by cliing on the Import
buon.

When you import some photos, only the photos that you have just im-
ported are shown. To show all of your photos, cli on the gray X to the right
of the blue Find.

Choosing where F-Spot saves photos

When importing pictures in the “Import” window, the Copy files to the
Photos folder option determines where the photos are saved.

If the Copy files to the Photos folder option is selected then F-Spot will
copy the photos into the Photos folder, whi is within your Pictures folder.
e pictures are then sorted by year, month and then date.

If the Copy files to the Photos folder option is unselected then F-Spot will
not copy the pictures into the Photos folder.

Importing from file

To import photos that are saved on your computer, oose Select Folder from
the Import Source drop-down list. is opens the “Import” window. Navigate
to the folder containing your photos and cli Open.

When the loading bar says “Done Loading” all the photos in that folder
and any sub-folders are then displayed in the “Import” window. You can
exclude importing photos from sub-folders by deselecting the Include sub-
folders option.

All of the photos are imported by default, but you can oose to import
only some photos. To do so, press-and-hold the Ctrl key while cliing the
photos you do not want to import. Duplicates are automatically detected
when the Detect duplicates option is selected.

You can aa tags by typing the names of the your current tags in the
Atta Tags text field. If you want to use multiple tags then separate them
with a comma.
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Figure .: You can import all of your
photos.

Once you have osen the photos that you want to import, cli on the
Import buon.

From digital camera

To import photos from a digital camera, plug your camera into the  port of
your computer, and turn your camera on. If your camera is detected, Ubuntu
should open a new window prompting you to import photos. Ensure that
Open F-Spot is osen in the drop-down list and cli OK. is will show the
“Import” window. In the Import Source drop-down list oose the option that
looks like …Camera.

A “Select Photos to Copy from Camera…” window will open. You can
then cli the photos that you want to copy. All of the photos are selected by
default but you can add or remove individual photos by pressing-and-holding
the Ctrl key while cliing on photos to deselect them.

You can aa tags to all of them by cliing on the Atta tag option and
oosing the tag in the Atta tag: drop-down list. For more information
about tags see Organizing photos.

You can ange where the files are saved in the Target location drop-down
list. e default is the Photos folder—this is where F-Spot saves the photos.

Once you have osen the photos that you want to import, cli on the
Copy buon. e “Transferring Pictures” window should open, and will show
the copying progress. When copying is complete, the progress bar will display
Download Complete. Finally, cli OK to show your photos in F-Spot.



   

Organizing photos

F-Spot makes finding photos of the same type easier by using tags. You can
apply as many tags to a photo as you like.

To apply tags to photos, first select the photos. en right-cli on the
photos and oose Atta Tag. Cli the tag you want add to your photos.
You can aa tags when importing photos, as covered in the “Importing”
section.

You can make new tags by opening the Tags and oosing Create New
Tag…. is will open up the “Create New Tag” window. Enter the name of
the tag in the Name of New Tag: text field. e Parent Tag: drop-down list
allows you to oose the “parent” tag for your new tag.

Editing Images

You may want to edit some of the photos you import into F-Spot. For exam-
ple, you may want to remove something at the edge, some discoloring, fix red
eyes, or straighten a photo. To edit a photo, cli on the photo that you want
to edit and then cli on the Edit Image buon. is anges the side bar on
the le of the “F-Spot” window. e panel will show eight options: Crop,
Red-eye Reduction, De-saturate, Sepia Tone, Straighten, So Focus, Auto
Color, and Adjust Colors. Some of these options are explained in more detail
in the next section.

Cropping photos

You might want to crop a photo to ange the framing or remove part of the
edge of the photo. Cli on the Crop on the le panel, then in the Select an
area to crop drop-down list oose the ratio that you would like to crop with.
You might want oose the ratio that mates the ratio that you would like to
print, so that the photo is not streted.

You can create custom constraints if one of the defaults does not meet your
requirements. is is done by oosing Custom Ratios from the Select an
area to crop drop-down list. is opens the “Selection Constraints” window.
Cli Add to place a new entry on the le of the window.

Once you have osen your constraint, move the cursor to one corner of
the section of the photo that you want to keep. Cli-and-hold the le mouse
buon and drag it to the opposite corner of the section that you want to keep.
Release the the mouse buon to finish your cropping selection.

To resize the cropping selection box, move the mouse until an arrow points
to the side of the cropping selection box that you want to move. Cli-and-
hold the le mouse buon, and move the mouse until the edge is in the right
place.

All ratios work in portrait and landscape mode. To ange between the
two, you need to cli on the edge of the cropping selection box as if you
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were to resize the box. Moving the cursor between top right and boom le
swites between portrait and landscape modes.

Red-eye Reduction

If you have taken a photo and the flash caused the subject to have red eyes,
you can fix this problem in F-Spot. First, cli on the Red-eye Reduction
buon. Move the cursor to the one corner of the subject’s eye and cli-and-
hold the le mouse buon as you drag the cursor to the opposite corner of the
eye. en, release the mouse buon.

is box can be moved by placing the cursor into the middle of the red
eye selection box until a hand cursor is shown. en, cli-and-hold the le
mouse buon and move the selection box into the correct place. When it is in
the correct place you can release the le mouse buon.

To resize the box, move the mouse until an arrow points to the side of the
red eye selection box that you want to move. Cli-and-hold the le mouse
buon, move the mouse until the edge is in the right place.

When the box covers all of the red in one eye, cli the Fix buon. You
will need to repeat the process for ea of the subject’s eyes that is affected.

Straighten

If you have a photo where the subject is at an angle, you can straighten the
photo with F-Spot. First, cli on the Straighten buon. en move the slider
until the picture is straight again. F-Spot will auto crop the picture to remove
any white parts that occur due to the rotation. When you are happy that the
picture is straight, cli on the Straighten buon.

Auto Color

To automatically correct the coloring of a photo, cli on the Auto Color
buon.

Exporting to web services

F-Spot allows you to export you photos to a Web Gallery, Folder or  and the
following services: SmugMug, Picasa Web, Flir, hq and Zooomr.

You can export to these services by selecting a picture and then opening
the Photo menu, then oosing Export to and cliing the service that you
require. is will open a window in whi you can enter your account name
and password for the service. is will allow you to upload pictures to this
service.



   

Watching videos and movies

To wat videos or s in Ubuntu, you can use the Movie Player application.
To start the Movie Player, open the Applications menu, then oose Sound &
Video, then ooseMovie Player. is will open the “Movie Player” window.

Figure .: Totem plays music and videos.

Codecs

Wating s may require Ubuntu to install a “codec,” whi is a piece of
soware that allows your computer to understand the contents of the ,
and display the video.

Legal Notice: Patent and copyright laws operate differently depending on whi
country you are in. Please obtain legal advice if you are unsure whether a par-
ticular patent or restriction applies to a media format you wish to use in your
country.

So that you can play all videos and s, you will need to install some
codecs. ese are located within theMultiverse repository. is is now
enabled by default.
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To install the codecs, open the Applications menu, then oose Ubuntu
Soware Center. When the “Ubuntu Soware Center” window opens, use
the sear box in the top right and sear for the following:

‣ gstreamer.-ffmpeg
‣ gstreamer.-plugins-bad
‣ gstreamer.-plugins-bad-multiverse
‣ gstreamer.-plugins-ugly
‣ gstreamer.-plugins-ugly-multiverse
‣ gstreamer.-plugins-base
‣ gstreamer.-plugins-good
‣ libdvdread
‣ libdvdnav

When you find ea one, select it with a double-cli and then cli the
Install buon. is may open an “Authenticate” window. If so, enter your
password then cli Authenticate to start the installation process.

To finish codec installation, you also need to run a command in the termi- For more information on the terminal see
Chapter : The Command Linenal. Open the Applications menu, then oose Accessories and then oose

Terminal. is will open the “Terminal” window.
Type the command as shown below. Sudo is a way to gain temporary adminis-

trative rights to perform certain tasks, such
as installing new soware. Usually, sudo is
presented in a window for you to enter your
password. When you enter your password
in a terminal, it will not be shown.

$ sudo /usr/share/doc/libdvdread4/install-css.sh

Once you have typed the command, press Enter. You will be asked for
your password—to authorize this action, type in you password and press
Enter. Wait for the process to finish. Once it has finished you can close the
“Terminal” window.

Playing videos from file

Open theMovie menu, then oose Open…. is will open the “Select Movies
or Playlists” window. Find the file or files that you want to play and cli on
the Add buon. e video or videos will start playing.

Playing a DVD

When you insert a  in the computer, Ubuntu should open the “You have
just inserted a Video . Choose what application to laun” window. Make
sure that Open Movie Player is osen in the drop-down list and then cli
OK. e “Movie Player” window will open and the movie will start.

If the “Movie Player” window is already open, openMovie menu, then
oose Play Disc… and the movie will start.



   

Listening to audio and music

Ubuntu comes with the Rhythmbox Music Player for listening to your music,
streaming Internet radio, managing playlists and podcasts, and purasing
songs.

Starting Rhythmbox

To start Rhythmbox, open the Applications menu, then oose Sound &
Video, then Rhythmbox Music Player.

To quit Rhythmbox, ooseMusic ‣it or press Ctrl+Q. Rhythmbox
will continue to run if you ooseMusic ‣Close or close the window. A few
Rhythmbox tools (su as Play, Next, and Previous) are available from the
Rhythmbox Music Player icon in the notification area (typically the top right
of your screen). You can also ooseit from this menu to quit Rhythmbox.

Playing music

Figure .: Rhythmbox with a  in.
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In order to play music, you must first import music into your library.
ChooseMusic ‣ Import Folder or press Ctrl+O on your keyboard to import a
folder of songs or Import File for single songs.

e Rhythmbox toolbar contains most of the controls that you will use for
browsing and playing your music.

If you want to play a song, select a tra and cli on the Play buon on
the toolbar (you can also oose Control ‣ Play from the menubar or press
Ctrl+Space). Cliing on the Play buon again will pause the song.

Next and Previous buons are next to the Play buon. You can cli on
these buons to play the next and previous songs in your library.

e Rhythmbox toolbar also has options to enable or disable Repeat
(Control ‣Repeat or Ctrl+R), Shuffle (Control ‣ Shuffle or Ctrl+U), the
Artist/Album browser (View ‣Browse or Ctrl+B), and Visualization.

When you insert a  into your computer, it will appear in the list of
Devices in the Side Pane. Select the  in the Devices list. Enable and disable
the Side Pane by oosing View ‣ Side Pane or F9. Rhythmbox will aempt
to find the correct artist, album, and tra names. To play the songs on the ,
oose the tra and press Play.

To import the songs into your library, select the  in the Devices list. You
can review information about the , make any anges if needed, or deselect
songs that you do not want to import. e toolbar will display additional
options to reload album information, eject the , and copy the tras to
your library. Press the Copy buon to import the songs.

Listening to streaming radio

Rhythmbox is preconfigured to enable you to stream radio from various Streaming radio are radio stations that are
broadcast over the Internet.sources. ese include Internet broadcast stations (Radio from the Side Pane)

as well as Last.fm. To listen to an Internet radio station, oose a station
from the list and cli Play. To listen to music from Last.fm, configure your
Account Settings.

Connect digital audio players

Rhythmbox can connect with many popular digital audio players. Connected
players will appear in the Devices list. Features will vary depending on the
player but common tasks like transferring songs and playlists should be sup-
ported.

Listen to shared music

If you are on the same network as other Rhythmbox users (or any music  stands for “Digital Audio Access
Protocol,” and is a method designed by
Apple Inc. to let soware share media
across a network.

player soware with  support), you can share your music and listen to
their shared music. Choose Shared from the Side Pane for a list of shared li-
braries on your network. Usually shares will be listed automatically but some-



   

times you will be required to add the IP manually. To do this cliMusic ‣
Connect to DAAP share…. en enter the IP address and the port number.
en cli Add. Cliing a shared library will enable you to browse and play
songs from other computers.

Manage podcasts

Rhythmbox can manage all of your favorite podcasts. Select Podcasts from
the Side Pane to view all added podcasts. e toolbar will display additional
options to Subscribe to a new Podcast Feed and Update all feeds. Choose
Music ‣New Podcast Feed, Ctrl+P, or press the Subscribe buon in the
toolbar to import a podcast . Podcasts will be automatically downloaded
at regular intervals or you can manually update feeds. Select an episode and
cli Play. You can also delete episodes.

Figure .: You can add and play your
podcasts in Rhythmbox.
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Rhythmbox preferences

e default configuration of Rhythmbox may not be exactly what you want.
Choose Edit ‣ Preferences to alter the application seings. e Preferences
tool is broken into four main areas: General, Playba,Music, and Podcasts.

‣ General options include music filtering and sorting options and a configu-
ration seing for toolbar buon labels.

‣ Playba options allow you to customize the crossfading feature and
define the buffer seing for streamed music from sources su as Internet
radio and shared libraries.

‣ Music options define the Library Location on your computer where
imported music is added, the Library Structure of how folders are created
based on your imported music, and the Preferred format for imported
music.

‣ Podcasts options define the Download location podcast episodes and the
frequency to Che for new episodes.

Managing your music

Rhythmbox supports creating playlists. Playlists are either static lists of songs
that are played in order or can be automatic playlists based on your specific
filter criteria. Playlists contain references to songs in your library. ey do
not contain the actual song file. If you remove a song from a playlist (Remove
from Playlist), it will remain in your library.

To create a playlist, ooseMusic ‣ Playlist ‣New Playlist or Ctrl+N and
give the new playlist a name. You can then either drag songs from you library
to the new playlist in the side pane or right-cli on songs and oose Add to
Playlist and pi the playlist.

Automatic Playlists are created almost the same way as static playlists
—ooseMusic ‣ Playlist ‣New Automatic Playlist. Next, define the fil-
ter criteria. You can add multiple filter rules. Finally, cli Close and give
the new automatic playlist a name. Automatic Playlists will appear in your
side pane with a different icon than any static playlists. You can update any
playlist by right-cliing on the name and oosing Edit….

Rhythmbox supports seing song ratings. Select a song in your library and
ooseMusic ‣ Properties, Alt+Enter, or right-cli on the file and oose
Properties. Select the Details tab and set the rating by piing the number
of stars. Other song information su as Title, Artist, and Album can be
anged from the Basic tab. Cli Close to save any anges.

To delete a song, select it in your library and oose Edit ‣Move to Trash
or right-cli on the song and ooseMove to Trash. is will move the song
file to your trash.

If you ever want to move a song (for example to another computer), oose



   

the song (or group of songs) from your library and drag it to a folder or to
your desktop. is will make a copy in the new location.

Rhythmbox plugins

Rhythmbox comes with a variety of plugins. ese are tools that you can
enable and disable that add more features to Rhythmbox. Examples include
Cover art, Song Lyrics, and various music stores. A few plugins are enabled
by default.

To view the list of available plugins, oose Edit ‣ Plugins. e Configure
Plugins window allows you to enable or disable individual plugins, view
descriptions, and configure additional options if they are available for the
plugin.

Music stores

Rhythmbox has three music stores whi give you access to an extremely
large catalog of music with a variety of licensing options.

e Jamendo store sells free, legal and unlimited music published under
the six Creative Commons licenses. You can browse the catalog and play
songs by oosing Jamendo in the Stores list in the side pane. More informa-
tion about their catalog can be found at http://www.jamendo.com/.

eMagnatune store sells music from independent musicians. ey work
directly with artists and hand-pi the songs available. eir catalog is com-
posed of high quality, non- (no copy protection) music and covers a
variety of genres from Classical and Jazz to Hip Hop and Hard Ro. You
can browse the catalog and play songs by oosingMagnatune in the Stores
list in the side pane. More information about their catalog and subscription
service can be found at http://www.magnatune.com/.

e Ubuntu One Music Store sells music from major and minor music
labels around the world. e store offers non- (no copy protection) songs
encoded in either high quality  or  format. Ubuntu does not come
with support for  playba, but the store will install the proper codecs
automatically for free. You can browse the catalog, play previews, and buy
songs by oosing Ubuntu One in the Stores list in the side pane.

e Ubuntu One Music Store integrates with the Ubuntu One service. All
purases are transferred to your personal cloud storage and then automati-
cally copied to all of your computers so an Ubuntu One account is required.
e catalog of music available for purase will vary depending on where you
live in the world. More information about the Ubuntu One Music Store can be
found at http://one.ubuntu.com/music/.

http://www.jamendo.com/
http://www.magnatune.com/
http://one.ubuntu.com/music/
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Audio codecs

Different audio files (e.g., , , ) require unique tools to decode them
and play the contents. ese tools are called codecs. Rhythmbox will aempt
to detect any missing codecs on your system so you can play all of your audio
files. If a codec is missing, it will try to find the codec in online resources and
guide you through installation.

Rhythmbox support

Rhythmbox is used by many users throughout the world. ere are a variety
of support resources available in many languages.

‣ Choose the Help buon for a variety of support options and information
about reporting Rhythmbox bugs.

‣ e Rhythmbox website: http://projects.gnome.org/rhythmbox/
‣ e Multimedia & Video category of Ubuntu Forums: http://ubuntuforums.
org/forumdisplay.php?f=

Working with documents, spreadsheets, and presentations

ite oen, you may need to use your computer for work. You may have a
need to use a word processor to write a document. You may need to work on
a spreadsheet, do calculations on a table of data or create a data art. You
may want to work on slides for a presentation.

In Ubuntu, you can use the OpenOffice.org suite of applications for these
tasks.

Working with documents

If you need to work with documents, you can use the OpenOffice.org Word The OpenOffice.org Word Processor is
also known as the OpenOffice.org Writer.
Spreadsheet is also known as Calc, and
Presentation is known as Impress.

Processor. To start the word processor, open the Applications menu, oose
Office, and then oose OpenOffice.org Word Processor. Ubuntu should
then open the main window for the word processor.

Working with spreadsheets

If you need to work with spreadsheets, you can use the OpenOffice.org
Spreadsheet. To start the spreadsheet application, open the Applications
menu, oose Office, and then oose OpenOffice.org Spreadsheet.

Working with presentations

If you need to work with slides for a presentation, you can use the OpenOf-
fice.org Presentation. To start the presentation application, open the Applica-
tions menu, oose Office, and then oose OpenOffice.org Presentation.

http://projects.gnome.org/rhythmbox/
http://ubuntuforums.org/forumdisplay.php?f=334
http://ubuntuforums.org/forumdisplay.php?f=334


   

Geing more help

Ea of these applications comes with a comprehensive set of help screens. If
you are looking for more assistance with these applications, press the F1 key
aer starting the application.

Taking notes

You can take notes in a program called Tomboy Notes. You can use it to make
a shopping or a to do list. Cli Applications, then cli Accessories and cli
Tomboy Notes.

Figure .: You can record information that
you need to remember.You can sear all of your notes by typing a word in the Sear: text field

in the main tomboy window.

Making notes

To create a new note cli File, then cli New. e “New Note” window will
open.
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e “New Note” window will contain a blue title “New Note”—this can
be deleted and anged to a title that makes the note more memorable. e
main content of the note can be typed where it says “Describe your new note
here.” Once you have entered your text just close your note as all anges are
automatically saved.

To delete the note cli the red delete note buon. is will open a “Really
delete this note?” window. If you do want to delete the note cli the Delete
buon, otherwise cli the Cancel buon.

You can add a note to a notebook by cliing the Notebook buon and
cliing the option next to the notebook that you want to move the note to.

Organizing notes

You can organize your notes in Tomboy using “Notebooks.” is makes find-
ing you notes quier and in a more logical location. To create a new note
book cli File, then Notebooks, and cli New Notebook….

e “Create a new notebook” window will open, type the name of the
notebook in the Notebook name: text field. Once you have typed the note-
book name cli the Create buon.

e notebook will now show up in the sidebar of Tomboy Notes. You can
cli and hold on the note of your oice and drag it on top of the notebook
that you want to move it to.

Synchronizing

You can synronize your notes with your Ubuntu One account, whi means
that you can access them across all of your Ubuntu computers. You can also
access them from https://one.ubuntu.com/.

To synronize your notes cli the Edit. en cli Preferences. is will
open the “Tomboy Preferences” window. Cli the Synronization tab and
then in the Service drop down cli Tomboy Web.

Next cli the Connect to Server buon. is will open a web page in
Firefox you will need to enter the email address that you use for Ubuntu One
and your password. en cli the Continue buon, then in the Computer
Name text field enter a name that reminds you of that computer and cli
the Addis Computer buon. Firefox will then display a page that says
something similar to “Tomboy Web Authorization Successful.”

Ba at the “Tomboy Preferences” window cli the Save buon. A new
window will pop up asking if you want to “synronize your notes now.”
Cli the Yes buon and the “Synronizing Notes…” window will show.
Once the synronization is complete cli the Close buon.

If you want to synronize the notes again cli Tools and cli Synro-
nize Notes. Your notes will start synronizing. When they are done, cli the
close buon.

https://one.ubuntu.com/


   

Ubuntu One

It is common for many people to use multiple computers in the course of their
work, sool, and personal life. You might have a desktop at your office as
well as a laptop for traveling or just going to a coffee shop. Ensuring that all
of your files are accessible no maer what computer you’re using is quite
a difficult task. e same could be said for the complexity of keeping your
Evolution address book, Tomboy notes, or Firefox bookmarks in sync.

Ubuntu One can help you keep your digital life in sync. All of your docu-
ments, music, bookmarks, address book contacts, and notes stay in sync across
all of your computers. In addition, they’re all stored in your personal cloud so
you can use a web browser from any computer to access all of your stuff from
the Ubuntu One website (http://one.ubuntu.com/).

Ubuntu One provides all Ubuntu users with   of storage for free. More
storage capacity and contacts synronization with mobile phones is available
for a monthly fee. Aer you set up Ubuntu One you can continue to use your
computer as you normally would, with Ubuntu One taking care of making
your data appear on all your other computers with Ubuntu One installed.

Seing up Ubuntu One

To set up Ubuntu One, first open the System menu, then oose Preferences,
then Ubuntu One. If this is your first time running the Ubuntu One Prefer-
ences application, it will add your computer to your Ubuntu One account.

Ubuntu One uses the Ubuntu Single Sign On () service for user ac-
counts. If you don’t already have an Ubuntu  account, the setup process
will let you create one. When you’re finished, you will have an Ubuntu 
account, a free Ubuntu One subscription, and your computer will be setup for
synronization.

Ubuntu One Preferences

e Ubuntu One Preferences application shows how mu of your storage
capacity you are currently using as well as provides account management
tools.

e Account tab displays your account information like name and email
address and links to more account management and tenical support re-
sources.

e Devices tab lists all of the devices that are currently added to synro-
nize with your account. Devices are either computers or mobile phones. For
the computer that you are currently using, you can adjust how mu of your
bandwidth is used by synronization and connect or reconnect to Ubuntu
One. You can also remove computers and mobile phones from your Ubuntu
One account.

http://one.ubuntu.com/
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e Services tab is where you manage what Ubuntu One features synro-
nize with your cloud storage and other computers. You can enable or disable
the synronization of files, purased music, contacts, and bookmarks.

More information

For more information about Ubuntu One, its services, and tenical support
resources, visit the Ubuntu One website at http://one.ubuntu.com/. Follow
the Ubuntu One blog at http://one.ubuntu.com/blog for news on the latest
features.

http://one.ubuntu.com/
http://one.ubuntu.com/blog
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Using your devices

Ubuntu supports a wide range of hardware, and support for new hardware
improves with every release.

Hardware identification

To identify your hardware you can install the following application: Cli
Applications, scroll down to Ubuntu Soware Center. When the “Ubuntu
Soware Center” window opens, use the sear box in the top right and
sear for the following: “sysinfo.” Now select the Application cli Install
and enter your password to install the application.

To run the application, oose Applications ‣ System Tools ‣ Sysinfo.
e Sysinfo program will then open a window with information about the
hardware that is part of your system.

Displays

Hardware drivers

A driver is some code paaged in a file, whi tells your computer how to
utilize a piece of hardware. Every component in a computer requires a driver
to function, whether it’s the printer,  player, hard disk, or graphics card.

A majority of graphics cards are manufactured by three well known com- Your graphics card is the component in your
computer that powers your display. When
you’re watching videos on YouTube or s
or simply enjoying the smooth transition
effects when you maximize/minimize your
windows, your graphics device is doing the
hard work behind the scenes.

panies: Intel, /, and  Corp. You can find your card manufacturer
by referring to your computer manual or looking for the specifications of
your particular model on the Internet. e Ubuntu Soware Center houses a
number of programs that allow detailed system information to be obtained.
SysInfo is one su program that you can use to find relevant information
about your System devices. Ubuntu comes with support for graphics devices
manufactured by the above companies, and many others, out of the box. at
means that you don’t have to find and install any drivers by yourself, Ubuntu
takes care of it on its own.

In keeping with Ubuntu’s philosophy, the drivers that are used by default
for powering graphics devices are open source. is means that the drivers
can be modified by the Ubuntu developers and problems with them can be
fixed. However, in some cases the proprietary driver (restricted driver) pro-
vided by the company may provide beer performance or features that are
not present in the open source driver wrien by the developer community. In
other cases, your particular device may not be supported by the open source
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drivers yet. In those scenarios, you may want to install the restricted driver
provided by the manufacturer.

For both philosophical and practical reasons, Ubuntu does not install
restricted drivers by default but allows the user to make an informed oice.
Remember that restricted drivers, unlike the open source drivers for your
device, are not maintained by Ubuntu. Problems caused by those drivers will
be resolved only when the manufacturer wishes to address them. To see if
restricted drivers are available for your system, cli System in the top panel,
go to Administration and find Hardware Drivers. If a driver is provided by
the company for your particular device, it will be listed there. You can simply
cli Activate and use the driver if you want. is process will require an
active Internet connection and will ask for your password.

e Ubuntu developers prefer open source drivers because they allow
the problem to be identified and fixed by anyone with knowledge in the
community. Ubuntu development is extremely fast and it is likely that your
device will be supported by open source drivers. You can use the Ubuntu
Live  to e for your device compatibility before installing Ubuntu or go
online in the Ubuntu forums to ask about your particular device.

Another useful resource is the official online
documentation (http://help.ubuntu.com),
which contains detailed information
about various graphics drivers and known
problems.

Seing up your screen resolution

One of the most common display related tasks is seing up your screen reso-
lution.

Ubuntu correctly identifies your native screen resolution by itself and sets Displays are made up of thousands of
tiny pixels. Each pixel displays a different
color, and when combined they all display
the image that you see. The native screen
resolution is a measure of the amount of
actual pixels on your display.

it for you. However, due to a huge variety of devices available, sometimes it
can make a mistake and set up an undesirable resolution.

To set up or just e your screen resolution, go to System ‣ Preferences ‣
Monitors. e Monitors application shows you your monitor name and size,
the screen resolution and refresh rate. Cliing on the displayed resolution
(e.g., “× (:)”) would open a drop-down menu where you can select
the resolution of your oice.

Connecting and using your printer

You can add, remove, and ange printer properties by navigating to System ‣
Administration ‣ Printing. is will display the “Printing-localhost” window.

When you want to add a printer, you will need to make sure that it
swited on, and plugged into your computer with a  cable or connected to
your network.

Adding a local printer

If you have a printer that is connected to your computer with a  cable then
this is termed a local printer. You can add a printer by cliing on the Add
Printer buon.

http://help.ubuntu.com


 

In the le hand pane of the “New Printer” window any printers that you
can install will be listed. Select the printer that you would like to install and
cli Forward.

You can now specify the printer name, description and location. Ea of If your printer can automatically do double
sided printing it will probably have a
duplexer. Please refer to the instructions
that came with the printer if you are unsure.
If you do have a duplexer you will need to
make sure the Duplexer Installed option is
checked and then click the Forward buon.

these should remind you of that particular printer so that you can oose the
right one to use when printing. Finally, cli Apply.

Adding a network printer

Make sure that your printer is connected to your network with an Ethernet
cable and is turned on. You can add a printer by cliing Add Printer. e
“New Printer” window will open. Cli the “+” sign next to Network Printer.

If your printer is found automatically it will appear under Network Printer.
Cli the printer name and then cli Forward. In the text fields you can
now specify the printer name, description and location. Ea of these should
remind you of that particular printer so that you can oose the right one to
use when printing. Finally cli Apply.

You can also add your network printer by entering the  address of the
printer. Select Find Network Printer, type in the  address of the printer
in the box that reads Host: and press the Find buon. Ubuntu will find the
printer and add it. Most printers are detected by Ubuntu automatically. If
Ubuntu cannot detect the printer automatically, it will ask you to enter the
make and model number of the printer.

The default printer is the one that is auto-
matically selected when you print a file.
To set a printer as default, right-click the
printer that you want to set as default and
then click Set As Default.

Changing printer options

Printer options allow you to ange the printing quality, paper size and media
type. ey can be anged by right-cliing a printer and oosing Prop-
erties. e “Printer Properties” window will show, in the le pane oose
Printer Options.

You can now specify seings by anging the drop-down entries. Some of
the options that you might see are explained.

Media Size

is is the size of the paper that you put into your printer tray.

Media source

is is the tray that the paper comes from.

Color Model

is is very useful if you want to print in Grayscale to save on ink, or to print
in Color, or Inverted Grayscale.



     .

Media type

Depending on the printer you can ange between:

‣ Plain Paper
‣ Automatic
‣ Photo Paper
‣ Transparency Film
‣  or  Media

Printality

is specifies how mu ink is used when printing, Fast Dra using the least
ink and High-Resolution Photo using the most ink.

Sound

Ubuntu usually detects the audio hardware of the system automatically dur-
ing installation. e audio in Ubuntu is provided by a sound server named
PulseAudio. e audio preferences are easily configurable with the help of a
very easy to use  whi comes preinstalled with Ubuntu.

A volume icon, siing on the top right corner of the screen, provides
qui access to different audio related functions. Le cliing on the vol-
ume icon shows up a slider buon whi you can move horizontally to in-
crease/decrease volume. Le cliing on the volume icon also allows you to
oose between muting the sound and Sound Preferences. Selecting Sound
Preferences opens up another window whi provides access to sound themes,
hardware, input and output preferences. Sound Preferences can also be found
if you go to System ‣ Preferences ‣ Sound.

e first tab whi shows up by default is sound themes. You can disable
the existing sound theme or configure it with the options available.

e hardware tab will have a list of all the sound cards available in your You can add new sound themes by installing
them from Soware Center (e.g., Ubuntu
Studio Sound theme.) You will get the
installed sound themes from the drop down
menu. You can also enable window and
buon sounds.

system. Usually there is only one listed, however, if you have a graphics card
whi supports  audio it will also show up in the list. is section should
be configured only if you are an advanced user.

e third tab is for configuring input audio. You will be able to use this A microphone is used for making au-
dio/video calls which are supported by
applications like Skype or Empathy. It can
also be used for sound recording.

section when you have an inbuilt microphone in your system or if you add an
external microphone.

You can increase/decrease and mute/unmute input volume from this tab. If You should note that by default in any
Ubuntu installation, the input sound is
muted. You will have to manually unmute
to enable your microphone to record sound
or use it during audio/video calls.

there is more than one input device, you will see them listed in the white box
whi reads Choose a device for sound input.

e output tab is used for configuring the output audio. You can in-
By default, the volume in Ubuntu is set to
maximum during installation.

crease/decrease and mute/unmute output volume and select your preferred
output device.

If you have more than one output device, it will be listed in the section If you change your sound output device, it
will remain as default.



 

whi reads “Choose a device for sound output.” e default output hardware,
whi is automatically detected by Ubuntu during installation will be selected.

e Applications tab is for anging the volume for running applica-
tions. is comes in very handy if you have multiple audio programs run-
ning, for example, if you have Rhythmbox, Totem Movie Player and a web-
based video playing at the same time. In this situation, you will be able to
increase/decrease, mute/unmute volume for ea application from this tab.

Burning CDs and DVDs

To create a  or  go to Applications ‣ Sound and Video ‣Brasero Disc
Burner. is opens Brasero, whi gives you five options to oose from.
Ea one of these is explained below.

Figure .: Brasero burns music, video, and
data s and s.

Universal options

ese options apply for all projects except Disc copy and Burn Image.
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Adding files to a project

To add files to the list, cli the Green + buon, whi opens the “Select Files”
window. en navigate your way to the file you want to add, cli it, and then
cli the Add buon. Repeat this process for ea file that you want to add.

Saving a project

To save a project so that you can finish it later, oose Project ‣ Save. e
“Save Current Project” window will be opened. Choose where you would like
to save the project. en, in the Name: text field, enter a name for the project
so that you will remember it. Now cli the Save buon.

Removing files

If you want to remove a file from the project, cli the file in the list and cli Icons of a broom are oen used in Ubuntu
to represent clearing a text field or returning
something to its default state.

on the Red - buon. To remove all the files in the list cli on the Broom
shaped buon.

Burning the disc

When you cli the burn buon you will see the “Properties of …” window.
You can specify the burning speed in the Burning speed drop down. It is

best to oose the highest speed.
To burn your project directly to the disc, select the Burn the image di-

rectly without saving it to disc option. With this option selected, no image
file is created and no files are saved to the hard disk.

e Simulate before burning option is useful if you encounter problems Temporary files are saved in the /tmp folder
by default. Should you wish to save these
files in another location, you will need to
change the seing in the Temporary files
drop down menu. Under normal conditions,
you should not need to change this seing.

burning discs. Selecting this option allows you to simulate the disc burning
process without actually writing data to a disc—a wasteful process if your
computer isn’t writing data correctly. If the simulation is successful, Brasero
will burn the disc aer a ten second pause. During that ten second pause, you
have the option to cancel the burning process.

Blanking a disk

If you are using a disc that has  wrien on it and you have used it before,  stands for Re-Writable which means that
disc can be used more than once.then you can blank it so that you can use it again. Doing this will cause you

to lose all of the data currently on the disc. To blank a disc, open the Tools
menu, then oose Blank. e “Disc Blanking” window will be open. In the
Select a disc drop down oose the disc that you would like to blank.

You can enable the Fast blank option if you would like to shorten the
amount of time to perform the blanking process. However, selecting this
option will not fully remove the files; if you have any sensitive data on your
disc, it would be best not to enable the Fast blank option.

Once the disc is blank the you will seee disc was successfully blanked.
Cli the Close buon to finish.



 

Audio project

If you record your own music, then you may want to transfer this music onto
an audio  so your friends and family can listen. You can start an audio
project by cliing Project, then New Project and then New Audio Project.

So that ea file does not play straight aer ea other you can add a
two second pause aer a file. is can be done by cliing the file and then
cliing the || buon.

You can slice files into parts by cliing the Knife buon. is opens a
“Split Tra” window. eMethod drop down gives you four options ea
one of these lets you split the tra in a different way. Once you have split the
tra cli OK.

In the drop down at the boom of the main “Brasero” window make sure
that you have selected the disc that you want to burn the files to. en cli
the Burn buon.

Data project

If you want to make a ba up of your documents or photos it would be best
to make a data project. You can start a data project by cliing Project then
cliing New Project and then New Data Project.

If you want to add a folder you can cli the Folder picture, then type the
name of the folder.

In the drop down at the boom of the main “Brasero” window make sure
that you have selected the disc that you want to burn the files to. en cli
the Burn buon.

Video project

If you want to make a  of your family videos it would be best to make
a video project. You can start a video project by cliing Project, then New
Project and then New Video Project.

In the drop down at the boom of the main “Brasero” window make sure
that you have selected the disc that you want to burn the files to. en cli
the Burn buon.

Disc copy

You can copy a disc cliing Project, then New Project and then Disc copy.
is opens the “Copy /” window.

If you have two / drives you can copy a disc from one to the other,
the disc that you want to copy to must be in the / drive. If you
have only one drive you will need to make an image and then burn it to a
disc. In the Select disc to copy drop-down oose the disc to copy. In the
Select a disc to write to drop-down either oose image file or the disc that
you want to copy to.
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Image file

You can ange where the image file is saved by cliing Properties, this
shows the “Location for Image File”. You can edit the name of the file in the
Name: text field.

e default save location is your home folder, you can ange this by
cliing the + next to Browse for other folders . Once you have osen
where you want to save it cli Close.

Ba in the “Copy /” window cli Create Image. Brasero will open
the “Creating Image” and will display the job progress. When the process is
complete cli Close.

Burn image

To burn an image, open the Project ‣ New Project, and then Burn Image.
Brasero will open the “Image Burning Setup” window. Cli on the Cli here
to select a disc image drop-down and the “Select Disc Image” window will
appear. Navigate your way to the image you wish to burn, cli on it, and
then cli Open.

In the Select a disc to write to drop-down menu, cli on the disc to
whi you’d like to write, then cli Create Image.

Using a webcam

Webcams oen come built into laptops and netbooks. Some computers, su
as Apple desktops, also have webcams built into the monitors. e rest of the
webcams typically use  connections. To use a  webcam, plug it into an
open  port in your computer.

Almost all new webcams are detected by Ubuntu automatically. You can There are quite a few applications which
are useful for webcams. Cheese can capture
pictures with your webcam and VLC media
player can capture video streaming from
your webcam. You can install these from the
Ubuntu Soware Center.

configure webcams for individual applications su as Skype and Empathy
from the application’s setup menu. For webcams whi do not work right
away with Ubuntu, visit https://wiki.ubuntu.com/Webcam for help.

Scanning text and images

Most of the time, Ubuntu will simply detect your scanner and you should just
be able to use it. To scan a document, follow these steps:

. Place what you want to scan on the scanner.
. Go to Applications ‣Graphics ‣ Simple Scan.
. Cli Scan.
. Cli the Paper Icon to add a another page.
. Cli Save to save.

https://wiki.ubuntu.com/Webcam


 

Does my scanner work with Ubuntu?

ere are three ways to see if you scanner works in Ubuntu:

. Simply plug it in. If it is a newer  scanner, it is likely that it will just
work.

. Che https://wiki.ubuntu.com/HardwareSupportComponentsScanners to
find out whi scanners work with Ubuntu.

.  project listing of supported scanners. e  (Scanner Access Now
Easy) project provides most of the ba-ends to the scanning soware on
Ubuntu.

Ubuntu can’t find my scanner

ere are a few reason why Ubuntu may give you a “No devices available
message”:

‣ Your scanner is not supported in Ubuntu. e most common type of scan-
ner not supported is old parallel port or Lexmark All-in-One printer/scanner/faxes.

‣ e driver for your scanner is not being automatically loaded.

Other devices

Firewire

Firewire is a special type of port that makes use of Firewire tenology to
transfer data. is port is generally used by camcorders and digital cameras.

If you want to import video from your camcorder you can do so by con-
necting your camcorder to the Firewire port. You will need to install a pro-
gram called Kino whi is available in the Ubuntu Soware Center.

To find out more about Kino, visit http://
www.kinodv.org/.

Bluetooth

Bluetooth is widely used on  devices, mouses, mobile phones, headsets,
music players, desktops and laptops for data transfer, listening to music,
playing games and for various other activities. All modern operating systems
support Bluetooth and Ubuntu is no exception.

You can access the Bluetooth preferences by le-cliing on the Bluetooth
icon on the right hand side of the top panel. It is usually located next to the
volume icon. Le-cliing on the Bluetooth icon opens a popup menu with
several oices, su as an option to Turn off Bluetooth.

e Bluetooth preferences can also be accessed from System ‣ Preferences ‣
Bluetooth. If you want to setup a new device su as a mobile phone to
synronize with your computer, oose the option that reads Setup new
device...

Ubuntu will then open a window for new device setup. When you cli
Forward, Ubuntu will open the second screen whi will show you how

https://wiki.ubuntu.com/HardwareSupportComponentsScanners
http://www.kinodv.org/
http://www.kinodv.org/
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Figure .: The Bluetooth applet menu.

many Bluetooth devices are present within the range of your system. e list
of available devices might take a minute or so to appear on the screen as your
system will be scanning for the devices. e scan and display is in real time,
whi means that every device will be displayed as soon as it is found. Cli
on the required Bluetooth device from the list of devices. en, select the 
number by selecting PIN options.

ree predefined  numbers are available but you can create a custom
 if you like. You will need to enter this  on the device you will be pair-
ing with Ubuntu.

Once the device has been paired, Ubuntu will open the “Setup completed”
screen.

In Ubuntu, your computer is hidden by default for security reasons. is
means that your Ubuntu system can sear other Bluetooth enabled systems
but they cannot sear for your Ubuntu system. You will have to enable
the option, if you want your Bluetooth device to find your Ubuntu system.
You can do this by selecting the option “Make computer discoverable” in
Bluetooth preferences. You can also add a fancy name for your Bluetooth-
enabled Ubuntu system by anging the text under Friendly Name.



 Soware Management

Soware management in Ubuntu

As discussed in Chapter : Working with Ubuntu, a range of default applica-
tions are available in Ubuntu that are suitable for many everyday tasks. At
some point you may decide to test out an alternative web browser, set up a
different email client, edit an audio file, or try some new games (for exam-
ple), and to do any of these you will need to install new soware. Ubuntu
keeps tra of many different soware paages, and finding and installing
what you are aer is designed to be as qui and easy as possible. Alterna-
tively, you may prefer to browse through the extensive library of available
applications, and try any that cat your interest.

Differences from other operating systems

Most other operating systems generally require a user to purase commer-
cial soware (online or through a physical store), or otherwise sear the
Internet for a free alternative (if one is available). e correct installation file
must then be downloaded and located on the computer, followed by the user
proceeding through a number of installation prompts and options.

While at times a similar process may be used for installing soware in
Ubuntu, the quiest and easiest way to find and install new applications is
through the Ubuntu Soware Center. is is a central location for accessing
new soware, and is based on the concept of repositories. A repository can be
thought of as a catalog of paages that are available for downloading from a
single location. You automatically have access to the official Ubuntu reposito-
ries when the operating system is installed; however, additional repositories
can be added later in order to access more soware.

Using the Ubuntu Soware Center

e Soware Center can be used to install most applications that are available Some soware packages have more ad-
vanced purposes, such as programming or
running a server, and cannot be installed
using the Soware Center. You will need
to use the Synaptic Package Manager (dis-
cussed towards the end of this chapter) to
install these packages.

in the official Ubuntu repositories.
To start the Soware Center, open the Applications menu and oose

Ubuntu Soware Center.
e Soware Center window has two parts—a list of sections on the le,

and a set of icons on the right. Ea icon represents a department, whi
is a category of soware. For example, the “Games” department contains
“Sudoku.”

e sections on the le side of the window represent your current view of
the Soware Center’s catalog. Cli the Get Soware buon on the le to
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Figure .: You can install and remove
applications from your computer using the
Soware Center.see soware that is available to install, and Installed Soware to see a list of

soware that is already installed on your computer.

Finding soware

If you are looking for an application, you may already know a specific name
(for example, “underbird” is a popular email client), or otherwise you may
just have a general category in mind (for example, the “sound and video”
category includes a number of different soware applications su as video
converters, audio editors, and music players).

To help you find the right application, you can browse the Soware Center
catalog by cliing on the department that reflects the category of soware
you are aer, or alternatively use the built-in sear at the top-right of the
window to look for specific names or keywords.

When you select a department, you will be shown a list of applications Check out the Featured Applications depart-
ment to see a list of highly recommended
applications.

that fit within that category. Some departments have sub-categories—for
example, the “Games” department has subcategories for “Simulation” and
“Card Games.”



  

To move through categories you can use the ba and forward buons at
the top of the window, as well as the navigational buons (oen referred to as
“breadcrumbs”) next to these.

Installing soware

Installing applications is practically only one cli away. Once you have found Note that you will need to be connected
to the Internet for the Soware Center
to work. To learn how to set up your
connection, see Chapter : Working with
Ubuntu.

an application that you would like to try:

. Cli the Install buon to the right of the selected paage. If you would
like to read more about the soware paage before installing it, first cli
onMore Info. is will take you to a short description of the application,
as well as a screenshot and a web link when available. If you wish to
proceed, you can also cli Install from this page.

. Type your password into the authentication window that appears. is is
the same password you use to log in to your account. You are required to
enter it whenever installing new soware, in order to prevent someone
without administrator access from making unauthorized anges to your
computer.

If you receive an “Authentication Failure”
message aer typing in your password,
check that you typed it correctly by trying
again. If the error continues, this may mean
that your account is not authorized to install
soware on the computer.

. Wait until the paage is finished installing. During the installation (or
removal) of soware paages, you will see an animated icon of rotating
arrows to the le of the In Progress buon in the sidebar. If you like, you
can now go ba to the main browsing window and queue additional so-
ware paages to be installed by following the steps above. At any time,
cliing the In Progress buon on the le will take you to a summary of
all operations that are currently processing. Here you can also cli the X
icon to cancel any operation.

Once the Soware Center has finished installing an application, it is now
ready to be used. Ubuntu will usually place an entry in your Applications
menu under the relevant sub-menu—its exact location will depend on the
purpose of the application. In some cases an application will appear in one of
the System ‣ Preferences or System ‣Administration menus instead.

Removing soware

Removing applications is very similar to installing them. First, cli on the
Installed Soware buon in the Soware Center’s sidebar. Scroll down to the
application you wish to remove (or use the sear field to quily find it), and
then:

. Cli the Remove buon to the right of the selected application. To completely remove a package and all
its configuration, you will need to purge it.
You can do this with the more advanced
Synaptic Package Manager, which is
discussed further in the Synaptic Package
Manager section below.

. Type your password into the authentication window that appears. Remov-
ing soware also requires that you enter your password to help protect
your computer against unauthorized anges. e paage will then be
queued for removal, and will appear under the In Progress section in the
sidebar.
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Removing a paage will also update your menus accordingly.

Managing additional soware

Although the Soware Center provides a large library of applications to
oose from, initially only those paages available within the official Ubuntu
repositories are listed. At times, a particular application you are aer may not
be available in these repositories. If this happens, it is important to understand
some alternative methods for accessing and installing soware in Ubuntu,
su as downloading an installation file manually from the Internet, or adding
extra repositories. First, we will look at how to manage your repositories
through Soware Sources.

Soware Sources

e Soware Center lists only those applications that are available in your
enabled repositories. Repositories can be added or removed through the So-
ware Sources application. To open this, cli System ‣Administration ‣ You can also open Soware Sources from

the Soware Center. Simply go to Edit ‣
Soware Sources.

Soware Sources in the top panel. You will be asked to enter your password,
then the “Soware Sources” window will open. ere are five tabs at the top
of this window: Ubuntu Soware, Other Soware, Updates, Authentica-
tion, and Statistics.

Managing the official repositories

e Ubuntu Soware tab lists the five official Ubuntu repositories, ea
containing different types of paages. When Ubuntu is first installed, four of
these are enabled—main, universe, restricted, and multiverse.

‣ Canonical-supported open source soware (main): is repository
contains all the open-source paages that are maintained by Canonical.

‣ Community-maintained open source soware (universe): is repos-
itory contains all the open-source paages that are developed and main-
tained by the Ubuntu community.

‣ Proprietary drivers for devices (restricted): is repository contains Closed-source packages are sometimes
referred to as non-free. This is a reference
to freedom of speech, rather than monetary
cost. Payment is not required to use these
packages.

proprietary drivers, whi may be required to utilize the full capabilities of
some of your devices or hardware.

‣ Soware restricted by copyright or legal issues (multiverse): is
repository contains soware that may be protected from use in some states
or countries by copyright or licensing laws. By using this repository you
assume responsibility for the usage of any paages that you install.

‣ Source code: is repository contains the source code that is used to build
the soware paages from some of the other repositories.
e Source code option should not be selected unless you have experience Building applications from source is an

advanced process for creating packages,
and usually only concerns developers. You
may also require source files when using
a custom kernel, or if trying to use the
latest version of an application before it
is released for Ubuntu. As this is a more
advanced area, it will not be covered in this
manual.

with building applications from source.



  

Selecting the best soware server

Ubuntu grants permission to many servers all across the world to act as mir-
rors. at is, they host an exact copy of all the files contained in the official
Ubuntu repositories. In the Ubuntu Soware tab, you can select the server
that will give you the best possible download speeds.

When selecting a server, you may want to consider the following:

‣ Connection speed. Depending on the physical distance between you and a
server, the connection speed may vary. Ubuntu provides a tool for selecting
the server that provides the fastest connection with your computer.
First, cli the dropdown box next to “Download from:” in the “So-

ware Sources” window, and select Other from the menu. In the “Server
Selection” window that appears, cli the Select Best Server buon in
the upper right. Your computer will now aempt a connection with all
the available servers, then select the one with the fastest speed. If you are
happy with the automatic selection, cli Choose Server to return to the
“Soware Sources” window.

‣ Location. Choosing a server that is close to your location will oen pro-
vide the best connection speed.
To select a server by country, oose your location in the “Server Selec-

tion” window. If there are multiple servers available in your location, select
one then cli Choose Server when you are finished.

Finally, if you do not have a working Internet connection, Ubuntu can
install some soware paages straight from your installation . To do this,
insert the disc into your computer’s  drive, then select the e box next to
Installable from the /. Once this e box is tied, the disc will
be treated just like an online repository, and applications will be installable
straight from the  through the Soware Center.

Adding more soware repositories

Ubuntu makes it easy to add additional, third-party repositories to your list of A  is a Personal Package Archive. These
are online repositories used to host the
latest versions of soware packages, digital
projects, and other applications.

soware sources. e most common repositories added to Ubuntu are called
s. ese allow you to install soware paages that are not available in the
official repositories, and automatically be notified whenever updates for these
paages are available.

Providing you know the web address of a ’s Launpad site, adding it to
your list of soware sources is relatively simple. To do so, you will need to use
the Other Soware tab in the “Soware Sources” window.

On the Launpad site for a , you will see a heading to the le called
“Adding this PPA to your system.” Underneath will be a short paragraph
containing a unique  in the form of ppa:test-ppa/example. Highlight this
 by selecting it with your mouse, then right-cli and oose copy.
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Figure .: This is an example of the Launch-
pad page for the Lifesaver PPA. Lifesaver
is an application that is not available in
the official Ubuntu repositories. However,
by adding this PPA to your list of soware
sources, it would then be easy to install and
update this application through the Soware
Center.

Return to the “Soware Sources” window, and in the Other Soware tab
cli Add… at the boom. A new window will appear, and you will see the
words “Apt line:” followed by a text field. Right-cli on the empty space in
this text field and select Paste, and you should see the  appear that you
copied from the s Launpad site earlier. Cli Add Source to return to the
“Soware Sources” window. You will see a new entry has been added to the
list of sources in this window, with a tied e box in front meaning it is
enabled.

If you cli Close in the boom right corner of this window, a message will
appear informing you that “e information about available soware is out-
of-date.” is is because you have just added a new repository to Ubuntu, and
it now needs to connect to that repository and download a list of the paages
that it provides. Cli Reload, and wait while Ubuntu refreshes all of your
enabled repositories (including this new one you just added). When it has
finished, the window will close automatically.

Congratulations, you have just added a  to your list of soware sources.
You can now open the Soware Center and install applications from this ,



  

in the same way you previously installed programs from the default Ubuntu
repositories.

Synaptic Package Manager

e Synaptic Paage Manager is a more advanced tool for managing so-
ware in Ubuntu. It can be used to perform the same tasks as the Ubuntu
Soware Center, su as installing and removing applications, but also allows
for more control over your paages. For example, it provides the following
options:

‣ Install any paage in your repositories. In many cases you can even select
whi version of a paage to install, although this option is only available
if there are multiple versions in the repository.

‣ Reinstall a paage. is may be useful if you wish to revert a paage to
its default state, or repair any conflicts or damaged files.

‣ Update a paage when a newer version is released.
‣ Remove any paage you no longer need.
‣ Purge a paage to completely remove it, including any stored prefer-
ences or configuration files (whi are oen le behind when a paage is
removed).

‣ Fix broken paages.
‣ Che properties of any paage, su as the version number, contained
files, paage size, dependencies, and more.

To open the Synaptic Paage Manager, navigate to System ‣Administration ‣
Synaptic Paage Manager. As explained above, Synaptic is a more complex
tool than the Soware Center, and generally not essential for a new user just
geing started with Ubuntu. If you want to read more information on how
to use this program, or require more support managing the soware on your
system, head to https://help.ubuntu.com/community/SynapticHowto.

Updates and Upgrades

Ubuntu also allows you to decide how to manage paage updates through the
Updates tab in the Soware Sources window.

Ubuntu updates

In this section, you are able to specify the kinds of updates you wish to install
on your system, and usually depends on your preferences around stability,
versus having access to the latest developments.

‣ Important security updates: ese updates are highly recommended to
ensure your system remains as secure as possible. ese are enabled by
default.

https://help.ubuntu.com/community/SynapticHowto
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‣ Recommended updates: ese updates are not as important for keeping
your system secure, but will mean your paages always have the most
recent bug fixes or minor updates that have been tested and approved. is
option is also enabled by default.

‣ Pre-released updates: is option is for those who would rather remain
up-to-date with the very latest releases of applications, at the risk of in-
stalling an update that has unresolved bugs or conflicts. Note that it is
possible that you will encounter problems with these updated applications,
therefore this option is not enabled by default. However, if this happens it
is possible to “roll-ba” to a previous version of a paage through Synap-
tic Paage Manager.

‣ Unsupported updates: ese are updates that have not yet been fully
tested and reviewed by Canonical. Some bugs may occur when using these
updates, and so this option is also not enabled by default.

Automatic updates

e middle section of this window allows you to customize how your sys-
tem manages updates, su as the frequency with whi it es for new
paages, as well as whether it should install important updates right away
(without asking for your permission), download them only, or just notify you
about them.

Release upgrade

Here you can decide whi system upgrades you would like to be notified Every  months, Canonical will release
a new version of the Ubuntu operating
system. These are called normal releases.
Every four normal releases—or  months
—Canonical releases a Long Term Support
(LTS) release. Long Term Support releases
are intended to be the most stable releases
available, and are supported for a longer
period of time.

about.

‣ Never: Choose this if you would rather not be notified about any new
Ubuntu releases.

‣ Normal releases: Choose this if you always want to have the latest
Ubuntu release, regardless of whether it is a Long Term Support release
or not. is option is recommended for normal home users.

‣ Long Term Support releases only: Choose this option if you need a
release that will be more stable and have support for a longer time. If you
use Ubuntu for business purposes, you may want to consider selecting this
option.



 The Command Line

Introduction to the terminal

roughout this manual, we have focused primarily on the graphical desktop
user interface. However, in order to fully realize the power of Ubuntu, you
may want to learn how to use the terminal.

What is the terminal?

Most operating systems, including Ubuntu, have two types of user interfaces.
e first is a graphical user interface (). is is the desktop, windows,
menus, and toolbars that you cli to get things done. e second, and mu
older, type of interface is the command-line interface ().

e terminal is Ubuntu’s command-line interface. It is a method of con-
trolling some aspects of Ubuntu using only commands that you type on the
keyboard.

Why would I want to use the terminal?

For the average Ubuntu user, most day-to-day activities can be completed
without ever needing to open the terminal. However, the terminal is a pow-
erful and invaluable tool that can be used to perform many useful tasks. For
example:

‣ Troubleshooting any difficulties that may arise when using Ubuntu some-
times requires you to use the terminal.

‣ A command-line interface is sometimes a faster way to accomplish a task.
For example, it is oen easier to perform operations on many files at once
using the terminal.

‣ Learning the command-line interface is the first step towards more ad-
vanced troubleshooting, system administration, and soware develop-
ment skills. If you are interested in becoming a developer or an advanced
Ubuntu user, knowledge of the command-line will be essential.

Opening the Terminal

You can open the terminal by cliing Applications ‣Accessories ‣Terminal. The terminal gives you access to what is
called a shell. When you type a command
in the terminal the shell interprets this
command, resulting in the desired action.
There are different types of shells that
accept slightly different commands. The
most popular is called “bash,” and is the
default shell in Ubuntu.

When the terminal window opens, it will be largely blank apart from some
text at the top le of the screen, followed by a blinking blo. is text is your
prompt—it displays your login name and your computer’s name, followed by
the current directory. e tilde (~) means that the current directory is your

In  environments the term “folder” is
commonly used to describe a place where
files are stored. In  environments the
term “directory” is used to describe the same
thing and this metaphor is exposed in many
commands (i.e., cd or pwd) throughout this
chapter.
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home directory. Finally, the blinking blo is the cursor—this marks where
text will be entered as you type.

To test things out, type pwd and press Enter. e terminal should display
/home/yourusername. is text is called the “output.” You have just used the
pwd (print working directory) command, and the output that was displayed
shows the current directory.

Figure .: The default terminal window
allows you to run hundreds of useful
commands.

All commands in the terminal follow the same approa. Type in the
name of a command, possibly followed by some parameters, and press Enter
to perform the specified action. Oen some output will be displayed that Parameters are extra segments of text,

usually added at the end of a command,
that change how the command itself is
interpreted. These usually take the form of
-h or --help, for example. In fact, --help
can be added to most commands to display
a short description of the command, as well
as a list of any other parameters that can be
used with that command.

confirms the action was completed successfully, although this depends on
the command. For example, using the cd command to ange your current
directory (see below) will ange the prompt, but will not display any output.

e rest of this apter covers some very common uses of the terminal.
However, there are almost infinite possibilities available to you when using
the command-line interface in Ubuntu. roughout the second part of this
manual we will continue to refer to the command line, particularly when
discussing steps involved in troubleshooting and the more advanced manage-
ment of your computer.

Ubuntu file system structure

Ubuntu uses the Linux file system, whi is based on a series of folders in
the root directory. Ea of these folders contain important system files that
cannot be modified unless you are running as the root user or use sudo. is
restriction exists for both security and safety reasons: computer viruses will



   

not be able to ange the core system files, and users should not be able to
accidentally damage anything vital.

Below are some of the most important directories.

Figure .: Some of the most important
directories in the root file system.e root directory—denoted by /—contains all other directories and files.

Here are the contents of some system essential directories:

‣ /bin & /sbin: Many essential system programs
‣ /etc: System-wide configuration files
‣ /home: Ea user will have a subdirectory to store personal files (for exam-
ple /home/your-username)

‣ /lib: Library files, similar to .dll files on Windows
‣ /media: Removable media ( and  drives) will be mounted in
this directory

‣ /root: is contains the root user’s files (not to be confused with the root
directory)

‣ /usr: Pronounced ‘user’, it contains most program files (not to be confused
with ea user’s home directory)

‣ /var/log: Contains log files wrien by many programs
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Every directory has a path. e path is a directory’s full name—it describes
a way to navigate the directory from anywhere in the system.

For example, the directory /home/your-username/Desktop contains all the
files that are on your Ubuntu desktop. e path, /home/your-username/Desktop,
can be broken down into a few pieces:

. /—indicates that the path starts at the root directory
. home/—from the root directory, the path goes into the home directory
. your-username/—from the home directory, the path goes into the your-

username directory
. Desktop—from the your-username directory, the path ends up in the Desk-

top directory

Every directory in Ubuntu has a complete path that starts with the / (the
root directory) and ends in the directory’s own name.

Directories and files that begin with a period are hidden directories. ese
are usually only visible with a special command or by selecting a specific op-
tion. In the Nautilus you can show hidden files and directories by selecting
View ‣ Show Hidden Files, or by pressing Ctrl+H. ere are many hidden di-
rectories in your home folder used to store program preferences. For example,
/home/your-username/.evolution stores preferences used by the Evolution
mail application.

Mounting and unmounting removable devices.

Any time you add storage media to your computer—an internal or external
hard drive, a  flash drive, a —it needs to be mounted before it is
accessible. Mounting a device means to associate a directory name with the
device, allowing you to navigate to the directory to access the device’s files.

When a device su as a  flash drive or a media player is mounted in
Ubuntu, a folder is automatically created for it in the media directory and
you are given the appropriate permissions to be able to read and write to the
device.

Most File Managers will automatically add a shortcut to the mounted
device in its side bar so it’s easy for you to get to. You shouldn’t have to
physically navigate to the media directory in Ubuntu, unless you oose to do
so from the command line.

When you are done using a device, you can unmount it. Unmounting a
device means to disassociate the device from its directory, allowing you to
eject it.



   

Geing started with the command line

Navigating directories

e pwd command is short for print working directory. It can be used to dis-
play the directory you are currently in. Note that the prompt (the text just
before the blinking cursor) also displays your current directory.

$ pwd
/home/your-username/

e cd command is short forange directory. It allows you to navigate
from your current working directory to another of your oosing.

$ cd /directory/you/want/to/go/to/

If there are spaces in one of the directories, you will need to put quotation
marks around the path:

$ cd ~/"Music/The Beatles/Sgt. Pepper's Lonely Hearts Club Band/"

If you leave out the quotation marks, the terminal will think that you are
trying to ange to a directory named ~/Music/The.

ere are some special directory names. ~ is a special name that always
refers to your home directory. You can type cd ~ to navigate to your home
directory from anywhere in the system. e name .. (two periods) is a spe-
cial name that refers to the directory’s “parent”—the directory one level above
it in the directory tree. For example, if your current working directory is
/home/your-username then typing cd .. will navigate to the /home direc-
tory.

Geing a list of files

e ls command is used to get a list of all the files and directories that exist
inside the current directory.

$ ls
alligator-pie.mp3
squirm.mp3
baby-blue.mp3

Moving things around

e mv command is used to move a file from one directory to another. Note that the terminal is case-sensitive.
For example, if you have a directory called
Directory1, you must remember to include
the capital leer whenever referring to it in
the terminal, otherwise the command will
not work.

$ mv /dmb/big-whiskey/grux.mp3 /home/john

You can also use the mv command to rename a file. For example:

$ mv grux.mp3 frub.mp3

e cp command is used to copy a file from one directory into another.
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$ cp /dmb/big-whiskey/grux.mp3 /media/ipod

Creating directories

e mkdir command is short for make directory, and is used to create a new
directory in the current directory or another specified location. For example,
this command will make a directory called newdirectory inside the current
directory:

$ mkdir newdirectory

e following command will ignore your current directory, and in-
stead make one called newdirectory inside a hypothetical directory called
/tmp/example/:

$ mkdir /tmp/example/newdirectory

You could then navigate to this new directory by using the cd command.

$ cd /tmp/example/newdirectory

Deleting files and directories

e rm command is used to delete files. For example, to delete a file named
deleteme.txt located in the current directory:

$ rm deleteme.txt

To delete a file located in another directory (i.e., not inside your current
working directory), you would need to include the path to the file. In other
words, you are specifying the file’s location. For example, to delete the file
deleteme.txt located in the /tmp/example/ directory, use the following
command:

$ rm /tmp/example/deleteme.txt

e rmdir command is similar to the rm command, except it is used to
delete folders. For example, this command would delete the directory called
newdirectory that we created earlier.

$ rmdir /tmp/example/newdirectory/

Introducing sudo

When you installed Ubuntu, the system automatically created two user ac-
counts: your primary user account, and a “root” account that operates behind
the scenes. is root account has the necessary privileges required for modi-
fying system files and seings, whereas your primary user account does not.
Rather than logging out of your primary user account and then logging ba
in as root (whi can be very dangerous), you can use the sudo command (for
command line applications) and gksudo to borrow root account privileges



   

for performing administrative tasks su as installing or removing soware,
creating or removing new users, and modifying system files.

For example, the following command would open Ubuntu’s default text When using sudo in the terminal, you
will be prompted to enter your password.
You will not see any dots, stars, or other
characters appearing in the terminal as you
type your password—this is an extra security
feature to help protect your password from
any prying eyes.

editor gedit with root privileges. You will then be able to edit important
system files that would otherwise be protected. e password you use with
sudo is the same password that you use to log in to your primary account, and
is set up during the Ubuntu installation process.

$ gksudo gedit
[sudo] password for username:
Opening gedit...

e sudo command gives you virtually unlimited access to important system files
and seings. It is important you only use sudo if you understand what you are
doing. You can find out more about using sudo in Chapter : Security.

Managing soware through the terminal

In Ubuntu there are many ways to manage your soware. Graphical tools
su as the Ubuntu Soware Center and Synaptic Paage Manager were
discussed in Chapter : Soware Management, however, many people prefer
to use the apt command (Advanced Paaging Tool) to manage their so-
ware from within the terminal. e apt command is extremely versatile and
encompasses several tools, the most commonly used of whi is apt-get.

e various apt commands should be prefixed with the sudo command,
since they typically require root privileges.

Using apt-get

e apt-get command is used for installing and removing paages from
your system. It can also be used to refresh the list of paages available in
the repositories, as well as download and install any new updates for your
soware.

Updating and upgrading

e apt-get update command can be used to quily refresh the list of pa-
ages that are available in the default Ubuntu repositories, as well as any addi-
tional repositories added by the user (see Chapter : Soware Management for
more information on repositories).

$ sudo apt-get update

You can then use apt-get upgrade to download and install any available
updates for your currently installed paages. It is best to run apt-get update

prior to running apt-get upgrade, as this will ensure you are geing the most
recent updates available for your soware.
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$ sudo apt-get upgrade
Reading package lists... Done
Building dependency tree
Reading state information... Done
The following packages will be upgraded:
tzdata
1 upgraded, 0 newly installed, 0 to remove and 0 not upgraded.
Need to get 683kB of archives.
After this operation, 24.6kB disk space will be freed.
Do you want to continue [Y/n]?

e terminal will give you a summary of what paages are to be up-
graded, the download size, and how mu extra disk space will be used (or
freed), and then ask you to confirm before continuing. To proceed with the
installation, press y and then Enter, and the upgrades will be downloaded and
installed for you. If you do not want to proceed with the installation, press n
and then Enter.

Installing and removing

e following command would be used to install  media player using
apt-get: Notice the sudo command before the apt-get

command. In most cases it will be necessary
to use sudo when installing soware, as you
will be modifying protected parts of your
system. Many of the commands we will be
using from here on require root access, so
expect to see sudo appearing frequently.

$ sudo apt-get install vlc
[sudo] password for username:

To remove , you would type:

$ sudo apt-get remove vlc
[sudo] password for username:

Cleaning up your system

Oen soware in Ubuntu depends on other paages being installed on your
system in order to run correctly. If you aempt to install a new paage
and these dependencies are not already installed, Ubuntu will automatically
download and install them for you at the same time (provided the correct
paages can be found in your repositories). When you remove a paage in
Ubuntu, any dependencies that were installed alongside the original paage
are not also automatically removed. ese paages sit in your system and
can build up over time, taking up disk space. A simple way to clean up your
system is to use the apt-get autoremove command. is will select and Another useful cleaning command is apt-

get autoclean which removes cache files
le over from downloading packages.

remove any paages that were automatically installed but no longer required.

$ sudo apt-get autoremove

Adding extra soware repositories

Sometimes you might want to install some soware that isn’t in the official
repositories but may be available in a what’s called a . s, or personal



   

paage arives, contain soware that you can install by adding that  to
your system. To add a PPA repository:

$ sudo add-apt-repository ppa:example/ppa

Once you have installed the  you may install soware from it in the
usual way using the apt-get install command.





 Security
is apter discusses ways to keep your Ubuntu computer secure.

Why Ubuntu is safe

Ubuntu is secure by default for a number of reasons:

‣ Ubuntu clearly distinguishes between normal users and administrative
users.

‣ Soware for Ubuntu is kept in a secure online repository, whi contains
no false or malicious soware.

‣ Open-source soware like Ubuntu allows security flaws to be easily de-
tected.

‣ Security pates for open-source soware like Ubuntu are oen released
quily.

‣ Many viruses designed to primarily target Windows-based systems do not
affect Ubuntu systems.

Basic Security concepts and procedures

When Ubuntu is installed, it is automatically configured for a single person
to use. If more than one person will use the computer with Ubuntu, ea
person should have her or his own user account. is way, ea user can
have separate seings, documents, and other files. If necessary, you can also
protect files from being viewed or modified by users without administrative
privileges. See Users and groups to learn more about creating additional users
accounts.

Permissions

In Ubuntu, files and folders can be set up so that only specific users can view,
modify, or run them. For instance, you might wish to share an important
file with other users, but do not want those users to be able to edit the file.
Ubuntu controls access to files on your computer through a system of “per-
missions.” Permissions are seings that you can configure to control exactly
how files on your computer are accessed and used.

To learn more about modifying permissions, visit https://help.ubuntu.com/
community/FilePermissions.

https://help.ubuntu.com/community/FilePermissions
https://help.ubuntu.com/community/FilePermissions
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Passwords

You can use a strong password to increase the security of your computer. Your
password should not contain names, common words or common phrases. By
default, the minimum length of a password in Ubuntu is four aracters. We
recommend a password with more than the minimum number of aracters.

Locking the screen

When you leave your computer unaended, you may want to lo the screen.
Loing your screen prevents anyone from using your computer until your
password is entered. To lo the screen:

‣ Cli the session menu icon in the right corner of the top panel, then select
Lo Screen, or

‣ press Ctrl+Alt+L to lo the screen. is keyboard shortcut can be
anged in System ‣ Preferences ‣Keyboard Shortcuts.

System updates

Good security depends on an up-to-date system. Ubuntu provides free so-
ware and security updates. You should apply these updates regularly. See
Chapter : Soware Management to learn how to update your Ubuntu com-
puter with the latest security updates and pates.

Trusting third party sources

Normally, you will add applications to your computer via the Soware Center,
whi downloads soware from the Ubuntu repositories as described in
Chapter : Soware Management. However, it is occasionally necessary to
add soware from other sources. For example, you may need to do this when
an application is not available in the Ubuntu repositories, or when you need a
newer version of the one available in the Ubuntu repositories.

Additional repositories are available from sites su as getdeb.net and
Launpad s, whi can be added as described in Chapter : Soware
Management. You can download the  paages for some applications
from their respective project sites on the Internet. Alternately, you can build
applications from their source code (an advanced method of installing and
using applications).

Using only recognized sources su as a project’s site, , or various
community repositories (su as getdeb.net) is more secure than downloading
applications from an arbitrary (and perhaps less reputable) source. When
using a third party source, consider its trustworthiness, and be sure you know
exactly what you’re installing on your computer.

http://getdeb.net
http://getdeb.net


 

Users and groups

Like most operating systems, Ubuntu allows you to create separate user ac-
counts for ea person that use the computer. Ubuntu also supports user
groups, whi allow you to administer permissions for multiple users at the
same time.

Every user in Ubuntu is a member of at least one group—the group’s name
is the same as the name of the user. A user can also be a member of additional
groups. You can configure some files and folders to be accessible only by a
user and a group. By default, a user’s files are only accessible by that user;
system files are only accessible by the root user.

Figure .: Add, remove and change the user
accounts.

Managing users

You can manage users and groups using the Users and Groups administra-
tion application. To find this application, cli System ‣Administration ‣
Users and Groups.

To adjust the user and group seings cli the keys icon next the phrase
“Cli to make anges.” You will need to input your password in order to
make anges to user and group seings.

Adding a user Cli the Add buon whi appears underneath a list of
the current user accounts that have already been created. A window will
appear that has two fields. e “Name“ field field is for a friendly display
name. e “Short Name“ field is for the actual username. Fill in the requested
information, then cli OK. A new dialog box will appear asking you to enter
a password for the user you have just created. Fill out the fields, then cli
OK. Privileges you grant to the new user can be altered in “Users Seings”.
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Modifying a user Cli on the name of a user in the list of users, then cli
on the Change… buon, whi appears next to ea of following options:

‣ Account type:
‣ Password:

For more advanced user options cli on the Advanced Settings buon.
Change the details as required in the dialog that appears. Cli OK to save the
anges.

Deleting a user Select a user from the list and cli Delete. Ubuntu will
deactivate the user’s account, and you can oose whether remove the user’s
home folder or leave it.

Managing groups

Cli on theManage Groups buon to open the group management dialog.

Adding a group To add a group, cli Add. In the dialog that appears, enter
the group name and select the names of users you would like to add to the
group.

Modifying a group To alter the users in an existing group, select a group and
cli on the Properties buon. Select and deselect the users as required, then
cli OK to apply the anges.

Deleting a group To delete a group, select a group and cli Delete.

Applying groups to files and folders

To ange the group associated with a file or folder, open the Nautilus file
browser and navigate to the appropriate file or folder. en, either select the
folder and oose File ‣ Properties from the menubar, or right-cli on the file
or folder and oose Properties. In the Properties dialog that appears, cli on
the Permissions tab and select the desired group from the Groups drop-down
list. en close the window.

Using the command line

You can also modify user and group seings via the command line. We
recommend that you use the graphical method above unless you have a
good reason to use the command line. For more information on using the
command line to modify users and groups, see the Ubuntu Server Guide at
hps://help.ubuntu.com/./serverguide/C/user-management.html

https://help.ubuntu.com/10.04/serverguide/C/user-management.html


 

Seing up a secure system

You may also want to use a firewall, or use encryption, to further increase the
security of your system.

Firewall

A firewall is an application that protects your computer against unauthorized
access by people on the Internet or your local network. Firewalls blo con-
nections to your computer from unknown sources. is helps prevent security
breaes.

Uncomplicated Firewall () is the standard firewall configuration pro-
gram in Ubuntu. It is a program that runs from the command line, but a
program called Gufw allows you to use it with a graphical interface. See
Chapter : Soware Management to learn more about installing the Gufw
paage.

Once it’s installed, start Gufw by cliing System ‣Administration ‣
Firewall configuration. To enable the firewall, select the Enable option. By
default, all incoming connections are denied. is seing should be suitable
for most users.

If you are running server soware on your Ubuntu system (su as a web
server, or an  server), then you will need to open the ports these services
use. If you are not familiar with servers, you will likely not need to open any
additional ports.

To open a port cli on the Add buon. For most purposes, the Precon-
figured tab is sufficient. Select Allow from the first box and then select the
program or service required.

e simple tab can be used to allow access on a single port, and the Ad-
vanced tab can be used to allow access on a range of ports.

Encryption

You may wish to protect your sensitive personal data—for instance, financial
records—by encrypting it. Encrypting a file or folder essentially “los” that
file or folder by encoding it with an algorithm that keeps it scrambled until it
is properly decoded with a password. Encrypting your personal data ensures
that no one can open your personal folders or read your private data without
your private key.

Ubuntu includes a number of tools to encrypt files and folders. is ap-
ter will discuss two of these. For further information on using encryption
with either single files or email, see Ubuntu Community Help documents at
hps://help.ubuntu.com/community.

https://help.ubuntu.com/community
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Home folder

When installing Ubuntu, it is possible to encrypt a user’s home folder. See
Chapter : Installation for more on encrypting the home folder.

Private folder

If you have not osen to encrypt a user’s entire home folder, it is possible to
encrypt a single folder—called Private—in a user’s home folder. To do this,
follow these steps:

. Install the ecryptfs-utils soware paage.
. Use the terminal to run ecryptfs-setup-private to set up the private

folder.
. Enter your account’s password when prompted.
. Either oose a mount passphrase or generate one.
. Record both passphrases in a safe location. ese are required if you ever

have to recover your data manually.
. Log out and log ba in to mount the encrypted folder.

Aer the Private folder has been set up, any files or folders in it will auto-
matically be encrypted.

If you need to recover your encrypted files manually see https://help.
ubuntu.com/community/EncryptedPrivateDirectory.

https://help.ubuntu.com/community/EncryptedPrivateDirectory
https://help.ubuntu.com/community/EncryptedPrivateDirectory


 Troubleshooting

Resolving problems

Sometimes, things simply do not work as they should. Luily, problems
encountered while working with Ubuntu are easily fixed. Below, we offer
a guide to resolving basic problems that users may encounter while using
Ubuntu. If you exhaust the troubleshooting advice below, see Geing more
help to learn about seeking support from the Ubuntu community.

Troubleshooting guide

e key to effective troubleshooting is working slowly and methodically,
documenting anges you make to your Ubuntu system at every step. is
way, you will always be able to roll ba your work—and give fellow users
information about your previous aempts, in the unlikely event that you
should need to turn to the community for support.

Ubuntu fails to start aer I’ve installed Windows

Occasionally you may install Ubuntu and then decide to install Microso
Windows as a second operating system running side-by-side with Ubuntu.
While this is supported by Ubuntu, you may find that aer installing Win-
dows you may no longer be able to start Ubuntu.

When you first turn on your computer, a program called a “bootloader”
must start Ubuntu or another operating system. When you installed Ubuntu, A bootloader is the initial soware that

loads the operating system when you turn
on the computer.

you installed an advanced bootloader called  that allowed you to oose
between the various operating systems on your computer, su as Ubuntu,
Windows and others. However, when you installed Windows, it replaced
 with its own bootloader, thus removing the ability to oose whi
operating system you’d like to use. You can easily restore —and regain
the ability to oose your operating system—by using the same  you used to
install Ubuntu.

First, insert your Ubuntu  into your computer and restart it, making sure
to have your computer start the operating system that is on the  itself (see
Chapter : Installation). Next, oose your language and select Try Ubuntu.
Wait while the soware loads. You will need to type some code to restore
your bootloader. On the Applications menu, cli Accessories, and then cli
the Terminal item. Enter the following:

$ sudo fdisk -l

Disk /dev/hda: 120.0 GB, 120034123776 bytes
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255 heads, 63 sectors/track, 14593 cylinders
Units = cylinders of 16065 * 512 = 8225280 bytes

Device Boot Start End Blocks Id System
/dev/sda1 1 1224 64228+ 83 Linux
/dev/sda2 * 1225 2440 9767520 a5 Windows
/dev/sda3 2441 14593 97618972+ 5 Extended
/dev/sda4 14532 14593 498015 82 Linux swap

Partition table entries are not in disk order

is output means that your system (Linux, on whi Ubuntu is based) The device (/dev/sda, /dev/sda, etc) we
are looking for is identified by the word
“Linux” in the System column. Modify the
instructions below if necessary, replacing
/dev/sda with the name of your Linux
device.

is installed on device /dev/sda, but your computer is booting to /dev/sda
(where Windows is located). We need to rectify this by telling the computer to
boot to the Linux device instead.

To do this, first create a place to manipulate your Ubuntu installation:

$ sudo mkdir /media/root

Next, link your Ubuntu installation and this new folder:

$ sudo mount /dev/sda1 /media/root

If you’ve done this correctly, then you should see the following:

$ ls /media/root
bin dev home lib mnt root srv usr
boot etc initrd lib64 opt sbin sys var
cdrom initrd.img media proc selinux tmp vmlinuz

Now, you can reinstall :

$ sudo grub-install --root-directory=/media/root /dev/sda
Installation finished. No error reported.
This is the contents of the device map /boot/grub/device.map.
Check if this is correct or not. If any of the lines is incorrect,
fix it and re-run the script grub-install.
(hd0) /dev/sda

Finally, remove the Ubuntu disc from your  drive, reboot your
computer, and enjoy your Ubuntu system once again.

is guide may not work for all Ubuntu users due to differences in sys-
tem configuration. Still, this is the recommended method, and the most suc-
cessful method, for restoring the  bootloader. If following this guide
does not restore  on your computer, please consider trying some of
the other troubleshooting methods at https://help.ubuntu.com/community/
RecoveringUbuntuAfterInstallingWindows. When following the instructions,
please note that your Ubuntu installation uses Grub. is guide replicates
the method described in the first section of the referenced web page. Please
consider starting with the third section, https://help.ubuntu.com/community/
RecoveringUbuntuAfterInstallingWindows.

https://help.ubuntu.com/community/RecoveringUbuntuAfterInstallingWindows
https://help.ubuntu.com/community/RecoveringUbuntuAfterInstallingWindows
https://help.ubuntu.com/community/RecoveringUbuntuAfterInstallingWindows
https://help.ubuntu.com/community/RecoveringUbuntuAfterInstallingWindows


 

Ubuntu doesn’t present the login screen when my computer boots

e simplest and easiest way to correct this issue is to order Ubuntu to reset
the graphics configuration. Press and hold Control, Alt and F. You should
now see a bla and white screen with a prompt for your username and
password.

Enter your username, press Enter, and then enter your password. (Char-
acters will not appear on the screen as you enter your password. Don’t worry
—this behavior is normal and was implemented for security purposes). Next,
enter the following commands. Your password will be needed again.

$ sudo cd /etc/X11
$ sudo mv ./xorg.conf ./xorg.conf_old
$ sudo service gdm stop
$ sudo X -configure
$ sudo mv ./xorg.conf.new ./xorg.conf
$ sudo reboot now

Ubuntu will reboot, and your login screen should be restored.

I forgot my password

If you forget your password in Ubuntu, you will need to reset it using “Recov-
ery mode.”

To start Recovery mode, shut down your computer, then power it up.
As the computer starts up, press Shi (Grub) Esc (Grub) when you see
the white-on-bla screen with a countdown (the  prompt). Select the
Recovery mode option using the arrow keys on your keyboard. Recovery
mode should be the second item in the list.

Wait while Ubuntu starts up. You will not see a normal login screen. In-
stead, you will be presented with a terminal prompt that looks something
like:

root@something#

To reset your password, enter:

$ passwd username

Replace “username” above with your username. Ubuntu will prompt you
for a new password. Enter your desired password, press enter and then type
your password again, pressing enter aer you are done. (Ubuntu asks for your
password twice to make sure you did not make a mistake while typing). Once
you have restored your password, return to the normal system environment
by entering:

$ init 2

Login as usual and continue enjoying Ubuntu.
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Figure .: This is the grub screen in which
you can choose recovery mode.

I accidentally deleted some files that I need

If you’ve deleted a file by accident, you may be able to recover it from
Ubuntu’s trash folder. is is a special folder where Ubuntu stores deleted
files before they are permanently removed from your computer.

The Wastebasket is called different things
in various parts of the desktop. This could
cause confusion. This is a known issue
and will be resolved in the next version
of . The Wastebasket could also be
know as the “Deleted Items Folder“.

To access the trash folder, select Places ‣Computer from the top panel,
then oose Trash from the list of places in the le-hand sidebar of the win-
dow that appears (alternatively, cli on the trash applet at the far right of
the boom panel). To remove items from this folder and restore them to your
computer, right-cli on the items you want and select Restore, or otherwise
drag them wherever you would like (we recommend a memorable location,
su as your home folder or desktop).



 

How do I clean Ubuntu?

Over time, Ubuntu’s soware paaging system can accumulate unused pa-
ages or temporary files. ese temporary files, also called caes, contain
paage files from all of the paages that you have ever installed. Eventu-
ally, this cae can grow quite large. Removing them allows you to reclaim
space on your computer’s hard drive for storing your documents, music,
photographs, or other files.

To clear the cae, you can use either the clean, or the autoclean option
for a command-line program called apt-get. e clean command will re-
move every single caed item, while the autoclean command only removes
caed items that can no longer be downloaded (these items are oen unnec-
essary). To run clean, open Terminal and type:

$ sudo apt-get clean

Paages can also become unused over time. If a paage was installed to
assist with running another program—and that program was subsequently
removed—you no longer need the supporting paage. You can remove it with
autoremove.

Load Terminal and type:

$ sudo apt-get autoremove

to remove the unnecessary paages.

I can’t play certain audio or video files

Many of the formats used to deliver ri media content are proprietary,
meaning they are not free to use, modify and distribute with an open-source
operating system like Ubuntu. erefore, Ubuntu does not include the ca-
pability to use these formats by default; however, users can easily configure
Ubuntu to use these proprietary formats. For more information about the
differences between open source and proprietary soware, see Chapter :
Learning more.

If you find yourself in need of a proprietary format, you may install the
files necessary for using this format with one command. Before initiating this
command, ensure that you have Universe and Multiverse repositories enabled.
See the Synaptic Paage Manager section to learn how to do this.

Open the Ubuntu Soware Center by selecting it from Applications.
Sear for ubuntu-restricted-extras by typing “ubuntu restricted extras”
in the sear box on the right-hand side of the Ubuntu Soware Center’s
main window. When the Soware Center finds the appropriate soware, cli
the arrow next to its title. Cli Install, then wait while Ubuntu installs the
appropriate soware.

Once Ubuntu has successfully installed soware, your ri media content
should work properly.
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How can I change my screen resolution?

e image on every monitor is composed of millions of lile colored dots
called pixels. Changing the number of pixels displayed on your monitor is
called “anging the resolution.” Increasing the resolution will make the dis-
played images sharper, but will also tend to make them smaller. e opposite
is true when screen resolution is decreased. Most monitors have a “native res-
olution,” whi is a resolution that most closely mates the number of pixels
in the monitor. Your display will usually be sharpest when your operating
system uses a resolution that mates your display’s native resolution.

e Ubuntu configuration utilityMonitors allows users to ange the
resolution. Open it by oosing System from the Main Menu, then oosing
Preferences and thenMonitors. e resolution can be anged using the
drop down list within the program. Piing options higher up on the list (for
example, those with larger numbers) will increase the resolution.

Figure .: You can change your display
seings.

You can experiment with various resolutions by cliing Apply at the bot-
tom of the window until you find one that’s comfortable for you. Typically
the highest resolution will be the native resolution. Selecting a resolution
and cliing Apply will temporarily ange the screen resolution to the se-
lected value. A dialog box will also be displayed. It allows you to revert to
the previous resolution seing or keep the new resolution. e dialog box
will disappear in  seconds, restoring the old resolution.is feature was
implemented to prevent someone from being loed out of the computer by
a resolution that distorts the monitor and makes it unusable. When you have
finished seing the screen resolution, cli Close.



 

Figure .: You can revert back to your old
seings if you need to.

Ubuntu is not working properly on my Apple MacBook or MacBook
Pro

When installed on notebook computers from Apple—su as the MacBook or
MacBook Pro—Ubuntu does not always enable all of the computer’s built-in
components, including the iSight camera and the Airport wireless Internet
adapter. Luily, the Ubuntu community offers documentation on fixing these
and other problems. If you are having trouble installing or using Ubuntu on
your Apple notebook computer, please follow the instructions at https://help.
ubuntu.com/community/MacBook. You can select the appropriate guide aer
identifying your computer’s model number. For instructions on doing this,
visit the web page above.

Ubuntu is not working properly on my Asus EeePC

When installed on netbook computers from Asus—su as the EeePC—
Ubuntu does not always enable all of the computer’s built-in components,
including the keyboard shortcut keys and the wireless Internet adapter.
e Ubuntu community offers documentation on enabling these com-
ponents and fixing other problems. If you are having trouble installing
or using Ubuntu on your Asus EeePC, please follow the instructions at
https://help.ubuntu.com/community/EeePC. is documentation page con-
tains information pertaining specifically to EeePC netbooks.

My hardware is not working properly

Ubuntu occasionally has difficulty running on certain computers, gener-
ally when hardware manufacturers use non-standard or proprietary com-
ponents. e Ubuntu community offers documentation to help you trou-
bleshoot many issues that may arise from this situation, including problems
with wireless cards, scanners, mice and printers. You can find the complete
hardware troubleshooting guide on Ubuntu’s support wiki, accessible at
https://wiki.ubuntu.com/HardwareSupport. If your hardware problems per-
sist, please see Geing more help for more troubleshooting options or infor-
mation on obtaining support or assistance from an Ubuntu user.

https://help.ubuntu.com/community/MacBook
https://help.ubuntu.com/community/MacBook
https://help.ubuntu.com/community/EeePC
https://wiki.ubuntu.com/HardwareSupport
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Geing more help

is guide does not cover every possible workflow, task or issue in Ubuntu.
If you require assistance beyond the information in the manual, you can find
a variety of support opportunities online. You can access extensive and free
documentation, buy professional support services, query the community for
free support or explore tenical solutions. More information is available here:
http://www.ubuntu.com/support

http://www.ubuntu.com/support


 Learning more

What else can I do with Ubuntu?

By now, you should be able to use your Ubuntu desktop for all your daily
activities—su as browsing the web and editing documents. But you may be
interested in learning about other versions of Ubuntu you can integrate into
your digital lifestyle. In this apter, we’ll provide you with more detail about
versions of Ubuntu that are specialized for certain tasks. But first, we’ll first
discuss the tenologies that make Ubuntu a powerful collection of soware.

Open Source Soware

Ubuntu is open source soware. Open source soware differs from propri-
etary soware—soware whose source code is patented and is therefore not
freely available for modification or distribution by anyone but the rightsh-
older.Microso Windows and Adobe Photoshop are examples of proprietary The source code of a program is the

collection files that have been wrien in a
computer language to make the program.

soware.

Proprietary soware is soware that
cannot be copied, modified, or distributed
freely.

Unlike proprietary soware programs, Ubuntu is specifically licensed
to promote sharing and collaboration. e legal rules governing Ubuntu’s
production and distribution ensure that anyone can obtain, run, or share it
for any purpose they wish. Computer users can modify open source soware
to suit their individual needs, share it, improve it, or translate it into other
languages—provided they release these modifications so others can do the
same. In fact, the terms of many open source licensing agreements make it
illegal not to do so.

Because open source soware is developed by large communities of pro-
grammers distributed throughout the globe, it benefits from rapid develop-
ment cycles and speedy security releases (in the event that someone discovers
bugs in the soware). In other words, open source soware is updated, en-
hanced, and made more secure every day as programmers all over the world
continue to improve it.

Aside from these tenical advantages, open source soware also has
economic benefits. While users must adhere to the terms of an open source
licensing agreement when installing and using Ubuntu, for instance, they
needn’t pay to obtain this license. While not all open source soware is free of
monetary costs, mu is.

To learn more about open source soware, see the Open Source Initia-
tive’s open source definition, available at http://www.opensource.org/docs/
definition.php.

http://www.opensource.org/docs/definition.php
http://www.opensource.org/docs/definition.php
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Distribution families

Ubuntu is one of several popular operating systems based on Linux (an open
source operating system). While other versions of Linux, or “distributions,”
may look different from Ubuntu at first glance, they share similar aracteris-
tics because of their common roots. A distribution, or “distro,” is a operating

system made from open source programs,
bundled together to make them easier to
install and use.

Linux distributions can be divided into two broad families: the Debian
family and the Red Hat family. Ea family is named for a distribution on
whi subsequent distributions are based. For example, “Debian” refers to
both the name of a distribution as well as the family of distributions derived
from Debian. Ubuntu is part of the Debian family of distributions, as are
Linux Mint, Xandros, and CrunBang Linux. Distributions in the Red Hat
family include Fedora, openSUSE, and Mandriva.

e most significant difference between Debian-based and Red Hat-based
distributions is the system ea uses for installing and updating soware.
ese systems are called “paage management systems.”Debian soware Package management systems are

the means by which users can install,
remove, and organize soware installed
on computers with open source operating
systems like Ubuntu.

paages are  files, while Red Hat soware paages are  files. For
more information about paage management, see Chapter : Soware Man-
agement.

You will also find distributions that have been specialized for certain tasks.
Next, we’ll describe these versions of Ubuntu and explain the uses for whi
ea has been developed.

Choosing amongst Ubuntu and its derivatives

Just as Ubuntu is based on Debian, several distributions are subsequently
based on Ubuntu. Some of these are made for general use, and ea differs
with respect to the soware included as part of the distribution. Others are
designed for specialized uses.

Four derivative distributions are officially recognized and supported by
both Canonical and the Ubuntu community. ese are:

‣ Ubuntu Netbook Edition, whi is optimized for netbook computers.
‣ Kubuntu, whi uses the  graphical environment instead of the 
environment found in Ubuntu;

‣ Edubuntu, whi is designed for use in sools; and
‣ Ubuntu Server Edition, whi is designed for use on servers, and typi-
cally is not used as a desktop operating system because it doesn’t have a
graphical interface.

Four other derivatives of Ubuntu are available. ese include:

‣ Xubuntu, whi uses the  graphical environment instead of the
 environment found in Ubuntu;

‣ Ubuntu Studio, whi is designed for creating and editing multimedia; and
‣ Mythbuntu, whi is designed for creating a home theater  with
MythTV (an open source digital video recorder).



  

For more information about these derivative distributions, see http://www.
ubuntu.com/project/derivatives.

Ubuntu Netbook Edition

Ubuntu Netbook Edition is a version of Ubuntu designed specifically for
netbook computers.It is optimized for computing devices with small screens Netbooks are low-cost, low-power note-

book computers designed chiefly for
accessing the Internet.

and limited resources (like the energy-saving processors and smaller hard
disks common among netbooks). Ubuntu Netbook Edition sports a unique
interface and features a collection of soware applications particularly useful
to on-the-go users.

Because many netbooks do not contain  drives, Ubuntu Netbook
Edition allows users to install it on their computers using  flash drives.
To learn more about using a flash drive to install Ubuntu Netbook Edition on
a netbook computer, visit https://help.ubuntu.com/community/Installation/
FromImgFiles.

Ubuntu Server Edition

e Ubuntu Server Edition is an operating system optimized to perform
multiuser tasks when installed on servers.Su tasks include file sharing and A server is a computer that’s been con-

figured to manage, or “serve,” files many
people wish to access.

website or email hosting. If you are planning to use a computer to perform
tasks like these, you may wish to use this specialized server distribution in
conjunction with server hardware.

is manual does not explain the process of running a secure web server
or performing other tasks possible with Ubuntu Server Edition. For details on
using Ubuntu Server Edition, refer to the manual at http://www.ubuntu.com/
server.

Ubuntu Studio

is derivative of Ubuntu is designed specifically for people who use com-
puters to create and edit multimedia projects. For instance, it features ap-
plications to help users manipulate images, compose music, and edit video.
While users can install these applications on computers running the desktop
version of Ubuntu, Ubuntu Studio makes them all available immediately upon
installation.

If you would like to learn more about Ubuntu Studio (or obtain a copy for
yourself), visit http://ubuntustudio.org/home.

Mythbuntu

Mythbuntu allows users to turn their computers into entertainment systems.
It helps users organize and view various types of multimedia content su as
movies, television shows, and video podcasts. Users with  tuners in their
computers can also use Mythbuntu to record live video and television shows.

http://www.ubuntu.com/project/derivatives
http://www.ubuntu.com/project/derivatives
https://help.ubuntu.com/community/Installation/FromImgFiles
https://help.ubuntu.com/community/Installation/FromImgFiles
http://www.ubuntu.com/server
http://www.ubuntu.com/server
http://ubuntustudio.org/home
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To learn more about Mythbuntu, visit http://www.mythbuntu.org/.

-bit or -bit?

As mentioned earlier in this manual, Ubuntu and its derivatives are available
in two versions: -bit and -bit. is difference refers to the way computers
process information. Computers capable of running -bit soware are able to
process more information than computers running -bit soware; however,
-bit systems require more memory in order to do this. Nevertheless, these
computers gain performance enhancements by running -bit soware.

Why oose one over another? Pay aention to the version you select in
the following cases:

‣ If your computer is fairly old (made before ), then you may want to
install the -bit version of Ubuntu. is is also the case for most netbooks.

‣ If your computer has more than   of memory (), then you may need
to install the -bit version in order to use all the installed memory.

Finding additional help and support

is guide is not intended to be an all-encompassing resource filled with ev-
erything you’ll ever need to know about Ubuntu. Because Geing Started
with Ubuntu . could never answer all your questions, we encourage you
to take advantage of Ubuntu’s vast community when seeking further infor-
mation, troubleshooting tenical issues, or asking questions about your com-
puter. Below, we’ll discuss a few of these resources—located both inside the
operating system and on the Internet—so you can learn more about Ubuntu or
other Linux distributions.

System help

If you need additional help when using Ubuntu or its applications, cli
the Help icon on the top panel, or navigate to System ‣Help and Support.
Ubuntu’s built-in help guide covers a broad range of topics in great detail.

Online Ubuntu help

e Ubuntu Documentation team has created and maintains a series of wiki
pages designed to help both new and experienced users learn more about
Ubuntu. You can access these at http://help.ubuntu.com.

The Ubuntu Forums

e Ubuntu Forums are the official forums of the Ubuntu community. Mil-
lions of Ubuntu users use them daily to seek help and support from one
another. You can create an Ubuntu Forums account in minutes. To create

http://www.mythbuntu.org/
http://help.ubuntu.com


  

an account and learn more about Ubuntu from community members, visit
http://ubuntuforums.org.

Launchpad Answers

Launpad, an open source code repository and user community, provides a
question and answer service that allows anyone to ask questions about any
Ubuntu-related topic. Signing up for a Launpad account requires only a few
minutes. Ask a question by visiting Launpad at https://answers.launchpad.
net/ubuntu/+addquestion.

Live chat

If you are familiar with Internet relay at (), you can use at clients su
as XChat or Pidgin to join the annel #ubuntu on irc.freenode.net. Here,
hundreds of user volunteers can answer your questions or offer you support in
real time.

In addition to official Ubuntu and commu-
nity help, you will oen find third-party
help available on the Internet. While these
documents can oen be great resources,
some could be misleading or outdated. It’s
always best to verify information from
third-party sources before taking their
advice.

LoCo teams

Within the Ubuntu community are dozens of local user groups called “LoCo
teams.” Spread throughout the world, these teams offer support and ad-
vice, answer questions and promote Ubuntu in their communities by host-
ing regular events. To locate and contact the LoCo team nearest you, visit
http://loco.ubuntu.com/.

Community support

If you’ve exhausted all these resources and still can’t find answers to your
questions, visit Community Support at http://www.ubuntu.com/support/
community.

http://ubuntuforums.org
https://answers.launchpad.net/ubuntu/+addquestion
https://answers.launchpad.net/ubuntu/+addquestion
http://loco.ubuntu.com/
http://www.ubuntu.com/support/community
http://www.ubuntu.com/support/community
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. Definitions

(a) “Adaptation” means a work based upon the Work, or upon the Work
and other pre-existing works, su as a translation, adaptation, deriva-
tive work, arrangement of music or other alterations of a literary or
artistic work, or phonogram or performance and includes cinemato-
graphic adaptations or any other form in whi the Work may be recast,
transformed, or adapted including in any form recognizably derived
from the original, except that a work that constitutes a Collection will
not be considered an Adaptation for the purpose of this License. For the
avoidance of doubt, where the Work is a musical work, performance
or phonogram, the synronization of the Work in timed-relation with
a moving image (“syning”) will be considered an Adaptation for the
purpose of this License.

(b) “Collection” means a collection of literary or artistic works, su as
encyclopedias and anthologies, or performances, phonograms or broad-
casts, or other works or subject maer other than works listed in Sec-
tion (f) below, whi, by reason of the selection and arrangement of
their contents, constitute intellectual creations, in whi the Work is
included in its entirety in unmodified form along with one or more
other contributions, ea constituting separate and independent works
in themselves, whi together are assembled into a collective whole. A
work that constitutes a Collection will not be considered an Adaptation
(as defined below) for the purposes of this License.

(c) “Creative Commons Compatible License” means a license that is listed
at http://creativecommons.org/compatiblelicenses that has been ap-
proved by Creative Commons as being essentially equivalent to this
License, including, at a minimum, because that license: (i) contains
terms that have the same purpose, meaning and effect as the License

http://creativecommons.org/compatiblelicenses
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Elements of this License; and, (ii) explicitly permits the relicensing of
adaptations of works made available under that license under this Li-
cense or a Creative Commons jurisdiction license with the same License
Elements as this License.

(d) “Distribute” means to make available to the public the original and
copies of the Work or Adaptation, as appropriate, through sale or other
transfer of ownership.

(e) “License Elements” means the following high-level license aributes as
selected by Licensor and indicated in the title of this License: Aribu-
tion, ShareAlike.

(f) “Licensor” means the individual, individuals, entity or entities that
offer(s) the Work under the terms of this License.

(g) “Original Author” means, in the case of a literary or artistic work, the
individual, individuals, entity or entities who created the Work or if
no individual or entity can be identified, the publisher; and in addition
(i) in the case of a performance the actors, singers, musicians, dancers,
and other persons who act, sing, deliver, declaim, play in, interpret or
otherwise perform literary or artistic works or expressions of folklore;
(ii) in the case of a phonogram the producer being the person or legal
entity who first fixes the sounds of a performance or other sounds;
and, (iii) in the case of broadcasts, the organization that transmits the
broadcast.

(h) “Work” means the literary and/or artistic work offered under the terms
of this License including without limitation any production in the liter-
ary, scientific and artistic domain, whatever may be the mode or form
of its expression including digital form, su as a book, pamphlet and
other writing; a lecture, address, sermon or other work of the same na-
ture; a dramatic or dramatico-musical work; a oreographic work or
entertainment in dumb show; a musical composition with or without
words; a cinematographic work to whi are assimilated works ex-
pressed by a process analogous to cinematography; a work of drawing,
painting, aritecture, sculpture, engraving or lithography; a photo-
graphic work to whi are assimilated works expressed by a process
analogous to photography; a work of applied art; an illustration, map,
plan, sket or three-dimensional work relative to geography, topogra-
phy, aritecture or science; a performance; a broadcast; a phonogram; a
compilation of data to the extent it is protected as a copyrightable work;
or a work performed by a variety or circus performer to the extent it is
not otherwise considered a literary or artistic work.

(i) “You” means an individual or entity exercising rights under this License
who has not previously violated the terms of this License with respect to
the Work, or who has received express permission from the Licensor to
exercise rights under this License despite a previous violation.

(j) “Publicly Perform” means to perform public recitations of the Work and



 

to communicate to the public those public recitations, by any means
or process, including by wire or wireless means or public digital per-
formances; to make available to the public Works in su a way that
members of the public may access these Works from a place and at a
place individually osen by them; to perform the Work to the public
by any means or process and the communication to the public of the
performances of the Work, including by public digital performance;
to broadcast and rebroadcast the Work by any means including signs,
sounds or images.

(k) “Reproduce” means to make copies of the Work by any means includ-
ing without limitation by sound or visual recordings and the right of
fixation and reproducing fixations of the Work, including storage of a
protected performance or phonogram in digital form or other electronic
medium.

. Fair Dealing Rights. Nothing in this License is intended to reduce, limit, or
restrict any uses free from copyright or rights arising from limitations or
exceptions that are provided for in connection with the copyright protec-
tion under copyright law or other applicable laws.

. License Grant. Subject to the terms and conditions of this License, Licensor
hereby grants You a worldwide, royalty-free, non-exclusive, perpetual (for
the duration of the applicable copyright) license to exercise the rights in the
Work as stated below:

(a) to Reproduce the Work, to incorporate the Work into one or more Col-
lections, and to Reproduce the Work as incorporated in the Collections;

(b) to create and Reproduce Adaptations provided that any su Adapta-
tion, including any translation in any medium, takes reasonable steps to
clearly label, demarcate or otherwise identify that anges were made
to the original Work. For example, a translation could be marked “e
original work was translated from English to Spanish,” or a modification
could indicate “e original work has been modified.”;

(c) to Distribute and Publicly Perform the Work including as incorporated
in Collections; and,

(d) to Distribute and Publicly Perform Adaptations.
(e) For the avoidance of doubt:

i. Non-waivable Compulsory License Semes. In those jurisdictions
in whi the right to collect royalties through any statutory or com-
pulsory licensing seme cannot be waived, the Licensor reserves the
exclusive right to collect su royalties for any exercise by You of the
rights granted under this License;

ii. Waivable Compulsory License Semes. In those jurisdictions in
whi the right to collect royalties through any statutory or com-
pulsory licensing seme can be waived, the Licensor waives the
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exclusive right to collect su royalties for any exercise by You of the
rights granted under this License; and,

iii. Voluntary License Semes. e Licensor waives the right to collect
royalties, whether individually or, in the event that the Licensor is a
member of a collecting society that administers voluntary licensing
semes, via that society, from any exercise by You of the rights
granted under this License.

e above rights may be exercised in all media and formats whether
now known or hereaer devised. e above rights include the right to
make su modifications as are tenically necessary to exercise the
rights in other media and formats. Subject to Section (f), all rights not
expressly granted by Licensor are hereby reserved.

. Restrictions. e license granted in Section  above is expressly made
subject to and limited by the following restrictions:

(a) You may Distribute or Publicly Perform the Work only under the terms
of this License. You must include a copy of, or the Uniform Resource
Identifier (URI) for, this License with every copy of the Work You Dis-
tribute or Publicly Perform. You may not offer or impose any terms on
the Work that restrict the terms of this License or the ability of the re-
cipient of the Work to exercise the rights granted to that recipient under
the terms of the License. You may not sublicense the Work. You must
keep intact all notices that refer to this License and to the disclaimer of
warranties with every copy of the Work You Distribute or Publicly Per-
form. When You Distribute or Publicly Perform the Work, You may not
impose any effective tenological measures on the Work that restrict
the ability of a recipient of the Work from You to exercise the rights
granted to that recipient under the terms of the License. is Section
(a) applies to the Work as incorporated in a Collection, but this does
not require the Collection apart from the Work itself to be made sub-
ject to the terms of this License. If You create a Collection, upon notice
from any Licensor You must, to the extent practicable, remove from the
Collection any credit as required by Section (c), as requested. If You
create an Adaptation, upon notice from any Licensor You must, to the
extent practicable, remove from the Adaptation any credit as required
by Section (c), as requested.

(b) You may Distribute or Publicly Perform an Adaptation only under the
terms of: (i) this License; (ii) a later version of this License with the
same License Elements as this License; (iii) a Creative Commons juris-
diction license (either this or a later license version) that contains the
same License Elements as this License (e.g., Aribution-ShareAlike .
US)); (iv) a Creative Commons Compatible License. If you license the
Adaptation under one of the licenses mentioned in (iv), you must com-
ply with the terms of that license. If you license the Adaptation under



 

the terms of any of the licenses mentioned in (i), (ii) or (iii) (the “Ap-
plicable License”), you must comply with the terms of the Applicable
License generally and the following provisions: (I) You must include
a copy of, or the URI for, the Applicable License with every copy of
ea Adaptation You Distribute or Publicly Perform; (II) You may not
offer or impose any terms on the Adaptation that restrict the terms of
the Applicable License or the ability of the recipient of the Adaptation
to exercise the rights granted to that recipient under the terms of the
Applicable License; (III) You must keep intact all notices that refer to the
Applicable License and to the disclaimer of warranties with every copy
of the Work as included in the Adaptation You Distribute or Publicly
Perform; (IV) when You Distribute or Publicly Perform the Adapta-
tion, You may not impose any effective tenological measures on the
Adaptation that restrict the ability of a recipient of the Adaptation from
You to exercise the rights granted to that recipient under the terms of
the Applicable License. is Section (b) applies to the Adaptation as
incorporated in a Collection, but this does not require the Collection
apart from the Adaptation itself to be made subject to the terms of the
Applicable License.

(c) If You Distribute, or Publicly Perform the Work or any Adaptations
or Collections, You must, unless a request has been made pursuant to
Section (a), keep intact all copyright notices for the Work and provide,
reasonable to the medium or means You are utilizing: (i) the name of
the Original Author (or pseudonym, if applicable) if supplied, and/or if
the Original Author and/or Licensor designate another party or parties
(e.g., a sponsor institute, publishing entity, journal) for aribution
(“Aribution Parties”) in Licensor’s copyright notice, terms of service
or by other reasonable means, the name of su party or parties; (ii) the
title of the Work if supplied; (iii) to the extent reasonably practicable,
the URI, if any, that Licensor specifies to be associated with the Work,
unless su URI does not refer to the copyright notice or licensing
information for the Work; and (iv) , consistent with Ssection (b), in
the case of an Adaptation, a credit identifying the use of the Work
in the Adaptation (e.g., “Fren translation of the Work by Original
Author,” or “Screenplay based on original Work by Original Author”).
e credit required by this Section (c) may be implemented in any
reasonable manner; provided, however, that in the case of a Adaptation
or Collection, at a minimum su credit will appear, if a credit for all
contributing authors of the Adaptation or Collection appears, then
as part of these credits and in a manner at least as prominent as the
credits for the other contributing authors. For the avoidance of doubt,
You may only use the credit required by this Section for the purpose
of aribution in the manner set out above and, by exercising Your
rights under this License, You may not implicitly or explicitly assert or
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imply any connection with, sponsorship or endorsement by the Original
Author, Licensor and/or Aribution Parties, as appropriate, of You
or Your use of the Work, without the separate, express prior wrien
permission of the Original Author, Licensor and/or Aribution Parties.

(d) Except as otherwise agreed in writing by the Licensor or as may be
otherwise permied by applicable law, if You Reproduce, Distribute or
Publicly Perform the Work either by itself or as part of any Adaptations
or Collections, You must not distort, mutilate, modify or take other
derogatory action in relation to the Work whi would be prejudicial to
the Original Author’s honor or reputation. Licensor agrees that in those
jurisdictions (e.g. Japan), in whi any exercise of the right granted in
Section (b) of this License (the right to make Adaptations) would be
deemed to be a distortion, mutilation, modification or other derogatory
action prejudicial to the Original Author’s honor and reputation, the
Licensor will waive or not assert, as appropriate, this Section, to the
fullest extent permied by the applicable national law, to enable You to
reasonably exercise Your right under Section (b) of this License (right
to make Adaptations) but not otherwise.

. Representations, Warranties and Disclaimer
         ,
         
      , , ,
  , ,  , 
 , ,     , 
,        , ,
      ,    
.         
,        .

. Limitation on Liability.       
,             
  , , ,   
           ,  
         .

. Termination

(a) is License and the rights granted hereunder will terminate automati-
cally upon any brea by You of the terms of this License. Individuals or
entities who have received Adaptations or Collections from You under
this License, however, will not have their licenses terminated provided
su individuals or entities remain in full compliance with those li-
censes. Sections , , , , , and  will survive any termination of this
License.

(b) Subject to the above terms and conditions, the license granted here is
perpetual (for the duration of the applicable copyright in the Work).



 

Notwithstanding the above, Licensor reserves the right to release the
Work under different license terms or to stop distributing the Work at
any time; provided, however that any su election will not serve to
withdraw this License (or any other license that has been, or is required
to be, granted under the terms of this License), and this License will
continue in full force and effect unless terminated as stated above.

. Miscellaneous

(a) Ea time You Distribute or Publicly Perform the Work or a Collection,
the Licensor offers to the recipient a license to the Work on the same
terms and conditions as the license granted to You under this License.

(b) Ea time You Distribute or Publicly Perform an Adaptation, Licensor
offers to the recipient a license to the original Work on the same terms
and conditions as the license granted to You under this License.

(c) If any provision of this License is invalid or unenforceable under ap-
plicable law, it shall not affect the validity or enforceability of the re-
mainder of the terms of this License, and without further action by the
parties to this agreement, su provision shall be reformed to the mini-
mum extent necessary to make su provision valid and enforceable.

(d) No term or provision of this License shall be deemed waived and no
brea consented to unless su waiver or consent shall be in writing
and signed by the party to be arged with su waiver or consent.

(e) is License constitutes the entire agreement between the parties with
respect to the Work licensed here. ere are no understandings, agree-
ments or representations with respect to the Work not specified here.
Licensor shall not be bound by any additional provisions that may ap-
pear in any communication from You. is License may not be modified
without the mutual wrien agreement of the Licensor and You.

(f) e rights granted under, and the subject maer referenced, in this
License were draed utilizing the terminology of the Berne Conven-
tion for the Protection of Literary and Artistic Works (as amended on
September , ), the Rome Convention of , the WIPO Copyright
Treaty of , the WIPO Performances and Phonograms Treaty of 
and the Universal Copyright Convention (as revised on July , ).
ese rights and subject maer take effect in the relevant jurisdiction in
whi the License terms are sought to be enforced according to the cor-
responding provisions of the implementation of those treaty provisions
in the applicable national law. If the standard suite of rights granted
under applicable copyright law includes additional rights not granted
under this License, su additional rights are deemed to be included in
the License; this License is not intended to restrict the license of any
rights under applicable law.
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Creative Commons Notice

Creative Commons is not a party to this License, and makes no warranty
whatsoever in connection with the Work. Creative Commons will not be
liable to You or any party on any legal theory for any damages whatsoever,
including without limitation any general, special, incidental or consequential
damages arising in connection to this license. Notwithstanding the foregoing
two () sentences, if Creative Commons has expressly identified itself as the
Licensor hereunder, it shall have all rights and obligations of Licensor.

Except for the limited purpose of indicating to the public that the Work is
licensed under the CCPL, Creative Commons does not authorize the use by
either party of the trademark “Creative Commons” or any related trademark
or logo of Creative Commons without the prior wrien consent of Creative
Commons. Any permied use will be in compliance with Creative Commons’
then-current trademark usage guidelines, as may be published on its website
or otherwise made available upon request from time to time. For the avoid-
ance of doubt, this trademark restriction does not form part of the License.

Creative Commons may be contacted at http://creativecommons.org/.

http://creativecommons.org/


Glossary
applet An applet is a small program that runs in a panel. Applets provide

useful functions su as starting a program, viewing the time, or accessing
the main menu.

Canonical Canonical, the financial baer of Ubuntu, provides support for
the core Ubuntu system. It has over  paid staff members worldwide
who ensure that the foundation of the operating system is stable, as well as
eing all the work submied by volunteer contributors. To learn more
about Canonical, go to http://www.canonical.com.

cursor e blinking cursor that appears aer the prompt in the terminal is
used to show you where text will appear when you start typing. You can
move it around with arrow keys on your keyboard.

decrypted When you decrypt an encrypted file it becomes decrypted, and
viewable. Encrypted files on Ubuntu are not recognizable in any language,
they are just a string of random numbers and leers until they are de-
crypted using a password.

desktop environment A generic term to describe a  interface for humans
to interact with computers. ere are many desktop environments su as
, ,  and  just to name a few.

  stands for Dynamic Host Configuration Protocol, it is used by a
 server to assign computers on a network an  address automatically.

dialup connection A dialup connection is when your computer uses a modem
to connect to an  through your telephone line.

distribution A distribution is a collection of soware that is already compiled
and configured ready to be installed. Ubuntu is an example of a distribu-
tion.

dual-booting dual-booting is the process of being able to oose one of two
different operating systems currently installed on a computer from the
boot menu, once selected your computer will then boot into whiever
operating system you ose at the boot menu. Dual booting is a generic
term, and can refer to more than two operating systems.

Ethernet port An Ethernet port is what an Ethernet cable is plugged into
when you are using a wired connection.

  (whi once stood for  Network Object Model Environ-
ment) is the default desktop environment used in Ubuntu.

 e  (whi stands for Graphical User Interface) is a type of user

http://www.canonical.com
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interface that allows humans to interact with the computer using graphics
and images rather than just text.

  stands for Internet Service Provider, an  is a company that provides
you with your Internet connection.

kernel A kernel is the central portion of a Unix-based operating system,
responsible for running applications, processes, and providing security for
the core components.

maximize When you maximize an application in Ubuntu it will fill the whole
desktop, excluding the panels.

MeMenu e MeMenu in Ubuntu . allows you to manage your presence
on social networking services. It also allows you to publish status messages
to all of your accounts by entering updates into a text field.

minimize When you minimize an open application, the window will no
longer be shown. If you cli on a minimized application’s panel buon, it
will then be restored to its normal state and allow you to interact with it.

notification area e notification area is an applet on the panel that provides
you with all sorts of information su as volume control, the current song
playing in Rhythmbox, your Internet connection status and email status.

output e output of a command is any text it displays on the next line aer
typing a command and pressing enter, e.g., if you type pwd into a terminal
and press Enter, the directory name it displays on the next line is the
output.

paage Paages contain soware in a ready-to-install format. Most of
the time you can use the Soware Center instead of manually installing
paages. Paages have a .deb extension in Ubuntu.

panel A panel is a bar that sits on the edge of your screen. It contains applets
whi provide useful functions su as running programs, viewing the
time, or accessing the main menu.

parameter Parameters are special options that you can use with other com-
mands in the terminal to make that command behave differently, this can
make a lot of commands far more useful.

partition A partition is an area of allocated space on a hard drive where you
can put data.

partitioning partitioning is the process of creating a partition.
prompt e prompt displays some useful information about your computer,

it can be customized to display in different colors as well as being able to
display the time, date and current directory as well as almost anything else
you like.



 

proprietary Soware made by companies that don’t release their source code
under an open source license.

router A router is a specially designed computer that using its soware and
hardware, routes information from the Internet to a network. It is also
sometimes called a gateway.

server A server is a computer that runs a specialized operating system and
provides services to computers that connect to it and make a request.

shell e terminal gives access to the shell, when you type a command into
the terminal and press enter the shell takes that command and performs
the relevant action.

Soware Center e Soware Center is where you can easily manage so-
ware installation and removal as well as the ability to manage soware
installed via Personal Paage Arives.

terminal e terminal is Ubuntu’s text only interface, it is a method of con-
trolling some aspects of the operating system using only commands en-
tered via the keyboard.

wired connection A wired connection is when your computer is physically
connected to a router or Ethernet port with a cable, this is the most com-
mon connection for desktop computers.

wireless connection A wireless connection involves no cables of any sort and
instead uses a wireless signal to communicate with either a router, access
point or computer.
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